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1. Introduction  
1.1. What is GSGT? 

GSGT provides equivalent functionality to the existing HCS SIM system. GSGT generates radar, non-
radar, and combined radar/non-radar tapes for use by the National Airspace System (NAS) as a source 
of real time inputs and facilitates the testing and integration of NAS and related subsystems. It enables 
simulation (SIM) developers to perform their development activities in a fraction of the time that it 
would normally take utilizing NAS SIM alone. 

1.2. GSGT relationship to SGET 

SGET is one of the ERAM CSCIs. SGET is based on a set of core functions provided by the GSGT 
CAS product. GSGT has been augmented with a set of external functions to enable interfacing with 
other ERAM CSCIs. 

From the SGET SRS: The SGET CSCI provides the functions to create, store, retrieve, edit and preview 
Scenarios. SGET is used by Scenario Developers. SGET provides a set of tools that assist in the 
generation of Scenario inputs and Scenario debugging. In addition, SGET's preview function and output 
reports allow a user to see and analyze Scenarios in the off-line environment. This allows a high degree 
of Scenario checkout before execution in a lab or system environment. 

1.3. GSGT for ERAM Evaluation System 

GSGT includes a special build tailored to running with ERAM Evaluation System. This GSGT build 
includes most of the functionality found in normal version of GSGT, with exception of several features 
designed for better integration of the system. 
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2. Basics 
2.1. Configuration 

GSGT uses several environment variables for its configuration, such as to control location of scenarios 
and location of exported scenarios. 

Table 1. Environment Variables 

Variable Description 
ADAPTATION_PATH  Path to where adaptations are located. 

ATCOACH_GRID_PADDING  Variable is used to extend ATCoach weather grid and magvar grid size by 
a padding in all directions. 

DSSC_REL  Variable is set by "set_dssc" script on ERAM. It is used to limit adaptation 
display/selection based on national release on SCDP processors. 

exerciseStartTimeoutMin  ATCoach environment variable that is used to set ATCoach engine start 
timeout. Needed by GSGT to set the same timeout as ATCoach. 

EXPORT_OPS_PATH  Path where SIME OPS scenarios are exported. 
EXPORT_TTS_PATH  Path where SIME TTS scenarios are exported. 

GSGT_ENVIRONMENT  
Sets the GSGT working mode for sites. When value "SITE" is specified, 
creation and export of certain DataComm and SWIM messages is limited 
(see Section 4.9.1.6, “DataComm System Command Editor” and 
Section 4.9.1.4, “SWIM System Command Editor”) 

GSGT_PREVIEW_PATH  
Path to where temporary ATCoach preview files will be created when 
running with ATCoach engine. If the variable is not defined and ATCoach 
engine is used, the temporary files will be created in /tmp directory 

GSGT_SITE_DEFAULTS  Path to where shared site definitions (atcoach.xml) and shared control file 
are located. 

GSGT_TRACK_INTERVAL  

Time interval at which engine reports track positions during scenario 
preview and export. Default value is 5 (seconds). Value should be divisible 
into 60 (seconds) such as 1, 2, 3, 4, 5, 6, 10, 12, 15, 20 and 30. Increasing 
the interval reduces amount of operational memory GSGT uses during 
preview and export. 

GSGT_UTIL_PATH  Path to where log and temporary files are stored by guplex utility. 
GSGT_WORK_PATH  Path to where scenarios are located. 

REL_PATH  Path the where national adapations are located. When not set the default is 
/opt/release in GSGT and /dssc/rel in SGET 

SDRR_SCENARIO_PATH  Path where SDRR scenarios are exported in EES mode. 
WX_PATH  Path to where weather scenarios are located. 
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2.2. Starting GSGT software 

GSGT can be started from the command line. The exact location of the executable can vary depending 
on the installation and environment. 

Example 1. Start specific GSGT version 

To execute GSGT version 7.5.10.0 that has been installed to the default location, type: 

> /usr/local/gsgt.7.5.10.0/bin/gsgt 

If the location of installed gsgt was added to the PATH, gsgt can be simply started using: 

> gsgt 

 

 

Note 

Starting GSGT Editor from a command line while inside the scenario directory will automatically 
open that scenario. 

GSGT installed on the Linux systems can also be started form the program menu and icon located in the 
task bar. The menu lists a selection of all available GSGT version installed on the given system. 

GSGT (SGET) version installed on the SCDP processors is started using set_dssc script that upon 
determination of the national release launches appropriate SGET version for the selected release. 

2.2.1. Parameters 

GSGT can be started with various options which control its operation. The options are specified by 
typing a dash and then the desired letter(s) after gsgt on the command line. GSGT can also operate in 
several different modes (see Section 2.2.2, “GSGT Modes”) 
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Table 2. Program Parameters 

Parameter Description 

d# ATCoach debug level. The debug level for the ATCoach engine will be set to '#', 
which must be an integer between 0 and 112. The default is 0. 

-f, --nofullscreen Not Full screen mode. GSGT will be stared in a window roughly half the size of 
the screen. 

-v, --version Displays GSGT version 

-j, --jvn 

JVN Rhumb engine mode. GSGT will be run using the JVN 'internal'engine, 
instead of the ATCoach engine.  

 

Note 

On Linux systems, the JVN Rhumb engine is the default 
 

-r Same as "-j" option (kept for backwards compatibility).  

-S, --stereo JVN Stereo engine mode. GSGT will be run using the JVN 'internal'engine, 
instead of the ATCoach engine. 

-s, --sitedefMode Site Definition editor mode. (see Section 2.2.2, “GSGT Modes” and Section 6, 
“Site Definition Editor”) 

-T, --terminal Terminal mode. (see Section 2.2.2, “GSGT Modes”) 
-p, --
proxy=[server/port] Proxy server/port if needed to connect to Internet through proxy. (Linux version) 

-G, --training Training mode. (see Section 2.2.2, “GSGT Modes”) 
-w, --wx or --
wxMode 

Weather editor mode. (see Section 2.2.2, “GSGT Modes” and Section 5, 
“Weather Editor”) 

-n, --native 
Use native graphics display. Default when running application remotely, unless 
explicitly specified otherwise. When running application remotely this is 
recommended for performance. 

-R, --raster Use raster graphics display. Default when running application locally, unless 
explicitly specified otherwise. 

-g, --opengl Use OpenGL rendering. 

-a, --adsb=[version] 
Explicitly specifying the version will force that version regardless what is 
adapted. Omitting the option will set adapted ADSB version if present, otherwise 
defaults to version 3. (Linux version) 

-b Same as "-a". (AIX version) 
-h, --help Display application parameters 
 

Example 2. Start gsgt using JVN Rhumb engine and not in full screen mode 

> gsgt -fj 
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2.2.2. GSGT Modes 

GSGT operates in several modes that are tailored to specific functionality, such as Terminal facility, or 
editing a limited portion of scenario, such as weather. 

Table 3. GSGT Operation Modes 

Mode Description 

Normal Mode 
This mode is tailored to working with scenarios that simulate a Enroute (ERAM) 
system, the facility under test. The scenarios generate a set of non-radar messages per 
specification of ERAM system. 

Terminal Mode 
This mode is tailored to working with scenarios that simulate a Terminal (Arts) 
system, the facility under test. The scenarios generate a set of non-radar messages per 
specification of Arts system. 

Training Mode 

This mode in general works the same as Normal Mode with exception that when 
parsing adaptation GSGT will eliminate duplicate item names and the public names of 
the items will be used when exported SIME scenario. Additionally adapted aircraft 
characteristics are ignored and in their place specifically predefined list of aircraft 
characteristics is used with modified aircraft dynamics. 

Also instead of true north headings, a magnetic north heading with magnetic variation 
grid is used for heading specification. 

Weather Mode This mode is designed for editing weather scenarios. Weather scenarios are adaptation 
independent and can be included in any normal scenario for weather simulation. 

Site Definition 
Mode 

This mode is designed for editing shared ATCoach site definitions. It only allows to 
create and edit ATCoach site definition scenario file in the directory specified by the 
environment variable $GSGT_SITE_DEFAULTS. This file is then automatically included 
in the scenarios created in the Training Mode. 

EES Mode 
(ERAM 
Evaluation 
System) 

This mode is designed for running with ERAM Evaluation System (EES) and it's only 
available in a special build of GSGT.  
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2.3. Main Window 

 
Scenario  

Provides options to create a New scenario, Open an existing scenario, Reload current scenario, 
Edit the current scenario, Save the current scenario, Save As the current scenario with a different 
name, launch the Scenario Manager, Update Database with information about the current 
scenario, or Exit the GSGT application. (see Section 3, “GSGT Scenarios”) 

Preview  

Preview allows you to review scenarios. The options presented are Target preview and Full 
preview. The Target preview displays only the targets over the map during scenario playback. 
The Full preview displays targets and also creates a logs which allow review of messages as they 
occur during scenario playback. (see Section 7, “Preview”) 
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Import  

The 'Import' menu provides options to import from a Gsgt Scenario, NAS SIM files, DYSIM 
files, TGF, SAR data, and RTF SIM files. (see Section 8, “Import Functions”) 

Export  

The 'Export' menu provides options to export to SDRR (HCS version only), Write Sim Tape 
(HCS version only), SIME, FIRS (HCS version only), and TGF (HCS version only). (see 
Section 9, “Export Functions”) 

Reports  

The 'Reports' menu provides options to generate various reports based on currently open 
scenario. (see Section 10, “Reports and Tools” 

Help  

The Help menu provides options to select GSGT help (F1), About (F2) and Scenario Info (F3). 
The GSGT Help brings up the GSGT on-line help system, About displays the About Gsgt dialog, 
Scenario Info displays the Scenario Information dialog, and Supplemental Help launches a user-
customizable help function.  

2.3.1. Adaptation Window 

GSGT graphically displays various adaptation elements in the adaptation window, which is the main 
window for a GSGT session.  

 
View  

The pull-down menu is used to select map data for background display. The background 
functions may be displayed individually or in combinations. Possible background displays are:  

Maps  

US Map (BLUE), ARTCC Map (ORANGE), Canada (BLUE), Mexico (BLUE), Satellite Map or 
Street Map (both require Internet connection) 
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Note 

EADP adaptation includes most up to date ARTCC boundary data that is available form 
each center menu. ARTCC Map data is outdated and ramains available in case EADP 
adaptation is not used in scenario. 

Airspace  

contains a sub-menu with options to display data that applies to the entire airspace (every Center) 

Fixes - contains a sub-menu with the following 

VORs (White and PURPLE dots)  
VOR Labels (PURPLE letters)  
TACANs (OLIVE dots)  
TACANs Labels (OLIVE letters)  
NDBs (White and BLUE dots)  
NDB Labels (BLUE letters)  
Waypoint (TURQUOISE dots)  
Waypoint Labels (TURQUOISE letters)  
Fix Aliases (TURQUOISE dots)  
Fix Alias Labels (TURQUOISE letters)  

Airports - contains a sub-menu with the following 

Airports (GREEN triangles)  
Airport Labels (GREEN letters)  
Airport Aliases (GREEN triangles)  
Airport Alias Labels (GREEN letters)  

Airways - contains a sub-menu with the following 

High Airways (TAN lines and TURQUOISE points)  
Low Airways (TAN lines and TURQUOISE points)  
Other Airways (TAN lines and TURQUOISE points)  

Coded Routes (OLIVE lines with TURQUOISE points) 

DPs (TURQUOISE lines and points) 

STARs (TURQUOISE lines and points) 

ADRs (TEAL lines, GRAY points and TURQUOISE points) 
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AARs (TEAL lines, GRAY points and TURQUOISE points) 

ADARs (TEAL lines, GRAY points and TURQUOISE points) 

ALines (GREEN lines and GRAY points) 

DLines (GREEN lines and GRAY points) 

Alt Restrictions (GREEN lines and GRAY points) 

[Center name]  

Each center adaptation has its own sub-menu with options to display data that applies only to it. 
(see Section 3.1.2, “Adaptation Selection”) 

FAVs (FPAs) - Fixed Airspace Volumes/Fix Posting Area (GRAY: ARTCC controlled, 
ORANGE: Terminal controlled)  
Boundary (RED) - Area of responsibility (AOR) boundary.  
ARTCC Boundaries (dark RED) - Boundaries of all ARTCCs .  
FP AOI (GREEN) - FP area of interest boundary  
Service Volume AOI (BLUE) - Service Volume area of interest boundary  
Service Volume Grid (TEAL) - Service Volume ATCoach grid represented by the default 16 
nm cells  
Service Volume Cert Grid (TEAL) - Service Volume ATCoach grid for Cert represented by the 
default 16 nm cells  
Surv AOI (TEAL) - Surveillance area of interest boundary  
APD Boundary (YELLOW)  
Surv Sort Cells (GREEN grid) - When a radar is displayed along with the Surveillance Sort 
Cells, the cells that belong to the displayed radar will have cross-hatching of a matching color.  
TAVs (RED outline with YELLOW cross-hatching)  
SAAs (solid ORANGE lines, with dotted-line buffer area)  
AAVs (PURPLE)  
Clutter Zone Filters (GRAY)  
Geomaps (WHITE)  
Adapted and scenario sector plans (GREEN)  
Scenario Sector Plan (GREEN) - Center sector boundaries.  
Radars  

range displayed as a filled shaded circle 

ADS-B Service Volumes  

range displayed as a filled shaded circle 

Wx Grids  

ATCoach RUC Grid depicting individual wx cells and RUC Grid boundaries for each center 
used in scenario. 
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Wx  

Wind (WHITE arrows), Temperature (various colors), Pressure (BLUE and RED contours), 
Precip (various colors) 

ATCoach Data  

ATCoach Points, Airports and Macros (routes) defined in scenario Site Definitions. 

 

Note 

Each level of the menu has a dashed line at the first item. Selecting the dashed line will "tear 
off" the menu and continue to display the menu after a selection is made. 

Find  

Allows the user to enter any airspace item (such as a Fix or Airway) and will highlight the item 
and display a context box for it.  

Flight Level  

A selection for the Flight Level displayed in the GSGT Adaptation Window.  

Zoom  

Provides a zoom function for the GSGT Adaptation Window. The zoom function is controlled 
two ways. The slide bar on the top right area of the window can be moved to set the zoom level. 
Clicking on the slide bar and then pressing the Page Down and Page Up keys will zoom the view 
in and out, respectively.  

Range  

Provides range of the current view in nm. The measurment of the range is taken horizontally 
across the middle of the viewer. 

2.3.2. Toolbar 

The scenario toolbar includes icons for most common options under the Scenario menu. The toolbar can 
be displayed or hidden by right-clicking anywhere on the main menu bar and selecting Scenario 
Toolbar. 

By clicking and dragging the toolbar handle (which looks like a double separator), the toolbar can be 
docked to either the top, bottom, left, or right of the main GSGT window or it can be left to float above 
the adaptation window below. 
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2.3.3. Status Bar 

Status Bar, also referred to as Measurement Bar, located on the bottom of the main window is used to 
display measurement information from the map. The bar is automatically displayed and updated upon 
user action that triggers the measurement information. 

To display lat/lon and X/Y system coordinates at any specific point, hold down the SHIFT key while 
mouse clicking in any particular location on the map. Holding down the SHIFT key and left-click 
dragging the mouse will additionally display spherical distance in nmi, heading, both true and magnetic, 
and delta X/Y system coordinates. 

 

2.3.4. Context Boxes 

Right-clicking on any airspace item (such as a Fix, Airport, or FAV) will cause a context box to be 
displayed. A context box displays information about the airspace item. The contents of each context box 
depend on the type of item it refers to. For example, a context box for an Airport will display the 
Lat/Long (LL) and ICAO Code of the Airport. Context boxes also have a menu that is displayed by 
clicking on the buttons in the upper section of the box. The items listed in the menu depend on the item 
type. 

When an item is selected, the color of the displayed item and the context box will match. The color used 
will be chosen from a list of colors, so that if multiple items are selected, they will be displayed with 
different colors (up to the number of colors in the list). 

A context box can be closed by right-clicking again on the item, or by simply selecting x button on the 
window. 
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2.4. Display version and license information 

The About Gsgt dialog displays license information and the GSGT version. Additionally ADS-B version 
is also displayed if ADS-B is enabled. 

Select Help->About from the GSGT Main Window. 
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OK  

Closes the About Gsgt dialog.  

2.5. Editors 

GSGT uses specialized dialogs (Editors) to create and edit various messages and data included in the 
scenario. The dialogs are designed to hide complexity of messages or binary data and to limit user errors 
and provide easier representation of the data in the form of plain language. Most of the fields in the 
dialogs were configured in a way to limit data to a valid input via drop down selection boxes, format 
limitation or range limitation. Required fields are colored YELLOW until they are filled in with valid 
data. Until all required fields are not filled in, the dialog may not be saved to prevent invalid or 
incomplete data in simulation. 
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3. GSGT Scenarios 
3.1. Create new scenario 

Creating a new scenario, SGET generates a blank scenario with no targets, commands or any definitions. 
A New Scenario Wizard is used to guide the user through selection of a scenario name, adaptation and 
optional weather scenario to be used in the newly created scenario. 

To create a new scenario, select Scenario->New from the GSGT Main Window (see Section 2.3, “Main 
Window”) 

 

Note 

If a scenario is already open when the Scenario->New option is selected, the new scenario will be 
automatically configured to use the same adaptation(s) as the current scenario. If you wish to select 
the adaptation(s), exit and re-start GSGT without opening another scenario, then select Scenario-
>New. 

3.1.1. New Scenario Wizard Buttons 
Back  

Goes to the previous screen. 

Next  

Goes to the next screen. 

Cancel  

Quits the scenario wizard without creating a new scenario. 

3.1.2. Adaptation Selection 

Adaptations are grouped by charting cycle. The charting cycle is displayed in blue and the adaptation is 
displayed in green. Users select the desired adaptation by clicking or highlighting the file name and 
clicking on 'Finish'. The Loading window is displayed and the status line is updated as the adaptation 
and scenario are loaded and displayed (see Section 3.2.1, “Load Progression Display”). Once parsing of 
the adaptation data is complete the list of available adaptation is displayed. 

 

Note 

This step is skipped if another scenario was open before Scenario->New was selected. 

While loading adaptation list a dialog is displayed until all adaptation data information is collected. 
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Single adaptation.  The selected adaptation is parsed to create the airspace adaptation objects as well as 
parsed for their facility adaptation information.  

 

Multiple Adaptations.  Multiple adaptations may be selected. The first adaptation selected (marked 
with a diamond in front of its name) is parsed to create the airspace adaptation objects (which define the 
entire airspace), All selected adaptations are parsed for their facility adaptation information. To select 
additional adaptations hold down the CTRL key while clicking on individual adaptation files names, or 
hold SHIFT key while clicking on the additional adaptation to select a range (all adaptations will be 
selected between the first and last adaptation selection).  
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Depending on the GSGT mode, additional option is presented allowing to select type of aircraft 
characteristics to be used in the scenario. Each set of aircraft characteristics is tailored to its specific use. 
Available sets are describe in Table 4, “Aircraft Characteristic sets” 

Table 4. Aircraft Characteristic sets 

Mode Description 
Adapted Set of aircraft characteristics included the adaptation. 
Training A specific set of aircraft characteristics tailored for running with training scenarios. 
Minimal A set of aircraft characteristics with minimal values. 

Built-in A set that closely resembles adapted aircraft characteristic for use with adaptations that do not 
include aircraft characteristic. 
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3.1.3. Location and Name 

 
Location Selector  

Location of the scenarios, such as default local location or other media such as CD-ROM or flash 
drive. 

Scenario Name  

Scenario name can be an existing scenario name or a non-existing scenario name typed in by the 
user. The new scenario will be created in the selected directory. Selecting an existing scenario 
will populate the name for the new scenario, and if user proceeds with creation of new scenario 
the existing scenario will be overwritten (see Section 3.1.5, “Scenario Overwrite Warning”) 

 

Note 

Directories are displayed in blue and scenarios are displayed in green. Read-only directories and 
scenarios are colored black and grey respectively. Right-click on a directory allows the user to 
create a new directory or subdirectory under the selected directory. 
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3.1.4. Weather Selection 

Weather files may be selected by clicking or highlighting the desired weather directory. Selecting a 
weather file is optional. 

 
Finish  

Parses the adaptation data and loads the scenario. Not enabled until an adaptation is selected. 

Cancel  

Cancels creation of the new scenario. 
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3.1.5. Scenario Overwrite Warning 

The warning is displayed to alert the user that a scenario file exists with the same name. 

 
Yes  

Overwrites the existing scenario with the current scenario. 

No  

Cancels the save scenario operation. 

3.2. Open existing scenario 

To open a scenario select Scenario->Open from the GSGT Main Window (see Section 2.3, “Main 
Window”). 

 

Note 

Starting GSGT Editor from a command line while inside the scenario directory it will automatically 
open that scenario. 
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Back  

Disabled in this window. 

Finish  

The selected scenario is opened in the GSGT main window. Enabled after a scenario is selected.  

Cancel  

Closes the window and cancels scenario open action. 

 

Note 

Opening a scenario which uses different adaptation than the current scenario will close the current 
GSGT session and start a new one. It may take a few seconds for the new GSGT session to appear 
(depending on system performance). 
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3.2.1. Load Progression Display 

The above window will be displayed and the step currently being performed will be listed at the bottom 
of the window. 

When completed, an adaptation window will be displayed and the scenario can be reviewed or modified. 

 

3.2.2. Scenario File Loading Errors 

If there are errors encountered while loading the scenario, the Gsgt Session Log will be displayed listing 
all errors encountered during loading. 
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3.2.3. ATCoach Simulation Engine Window 

When a scenario is opened, GSGT also opens a session with ATCoach. The ATCoach simulation engine 
is used to preview flights, derive target messages, and run certain reports. The ATCEngine window, 
shown below, displays all commands sent to the ATCoach engine as well as all status messages and 
responses. 
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Note 

If the ATCoach engine should terminate, a red 'ATCoach exited unexpectedly!' message will be 
displayed in the ATCEngine window. 

3.3. Edit scenario 

The main scenario editor window displays a list of objects by type that can be edited. Clicking on an 
object type displays all of the instances of the object type contained in the scenario, if any. 

Select Scenario->Edit from the GSGT Main Window (see Section 2.3, “Main Window”). 

 

Clicking the Name button will toggle between sorting the object instances in ascending and descending 
order. The triangle in the Name button indicates which ordering will be used after the button is clicked. 
The same applies for the other buttons. 
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Scenario Editor also provides ability to view adapted equipment as defined by selected adaptation(s), 
such as Arts and FDIOs, to mention few, as well as Radars and ADS-B Service Volumes (see Section 4, 
“Scenario Editor”) 

3.3.1. Create a new object 

To create a new object, right-click on the object listing. A context menu with the option 'New' is 
displayed. Selecting 'New' from the menu opens a dialog window to define the new object. 

 

3.3.2. Delete an object 

To delete an object. right-click on an object instance name. A context menu with 'Delete' (and possibly 
other options) is displayed. Selecting 'Delete' from the menu opens a confirmation dialog, asking user to 
confirm deletion of the selected object(s). 

 

3.3.3. Edit an object 

To edit an object, double-click on an instance name and the editor window will be replaced with the 
editor dialog for specific type of object instance selected (see Section 4, “Scenario Editor”) 

3.3.4. Replicate object 

Replication provides the ability to produce copies of the selected objects such as System Commands or 
Targets. The replications can be dynamic (not frozen), so that single object manages all its replications 
and a change to that object is reflected across all replications of that object. Or replications can be 
frozen, which in essence create an exact copy of the original object, and therefore the new objects can be 
independently modified to specific needs. 

The Replication Editor dialog varies depending on whether a System Command or Target is being 
replicated. As shown in screen capture below, following options are available for Target replications. 
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System Command replication options only allow to specify number of replications and delta time 
between replications.. 

 
Replications  

The number of replicated objects 

Delta Acid  

Delta in Acid between replications. If the base target has the identifier UAL001, and '1' is 
specified for the Delta Acid, the following Acids are achieved in replications: UAL002, 
UAL003, UAL004... 

Delta Tail Num  

Delta in Tail Number between replications. If the base target has the Tail Number N12345, and 
'2' is specified for the Delta Tail Num, the following Tail Numbers are achieved in replications: 
N12347, N12349, N12351... 

Delta ICAO Address  

Delta in ICAO Address between replications. If the base target has an ICAO Address of 
AB00E9, and '3' is selected for the Delta ICAO Address, the following ICAO codes are achieved 
in replications: AB00EC, AB00EF, AB00F2.... 

Delta Beacon  

Delta in Beacon code between replications. If the base target has a beacon code of 1011, and '3' 
is selected for the Delta Beacon, the following beacon codes are achieved in replications: 1014, 
1017, 1022.... 
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Delta Time  

Delta in time between replications. The default time is 20 minutes. If the original object has a 
scenario time of 00:10:00 then the first replication will enter the scenario at 00:30:00. 

Freeze Replications  

When checked, produces a hard copy replications that are no longer tied to the original object. 
Frozen replications will appear separately in the GSGT Editor list view. Non-frozen replications 
remain associated with the original. 

OK  

Adds the specified number of replications to the scenario. 

Cancel  

Closes the 'Replicate' window without saving changes. 

Leaving the pointer over a non-frozen replicated System Command or Target will cause a balloon help 
to appear with the details of the replication. 

 

3.4. Save scenario 

To save current scenario select Scenario->Save from the GSGT Main Window (see Section 2.3, “Main 
Window”). 

To save a scenario under a different name select Scenario->Save As from the GSGT Main Window. 
This allows to specify the name and location of the scenario files. A directory with the name as the 
specified in Scenario Name is created in the selected location. 
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3.4.1. Scenario overwrite warning 

When a scenario name is specified in the Save Scenario dialog already exists, the user is prompted to 
overwrite the existing scenario. 

 
Yes  

The existing scenario file is overwritten. 
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No  

The save action is cancelled. 

3.4.2. Save scenario before exit 

When the user attempts to exit the GSGT application and unsaved changes have been made to the 
scenario, the following dialog is displayed. 

 
Yes  

The scenario file is saved and the application is exited. 

No  

The scenario file is NOT saved and the application is exited. 

No  

The scenario file is NOT saved and the application is exited. 

Cancel  

The scenario is not saved and the application exit is cancelled. 

save the GSGT Session Log?  

(see Section 3.4.3, “Save Gsgt Session Log”) 

3.4.3. Save Gsgt Session Log 

When the GSGT session is exited, a dialog prompting to save scenario before exit or dialog confirming 
program termination includes an option to save the Save Gsgt Session Log. Selecting this option will 
open a dialog (similar to the Save As dialog) which allows a name and location to be specified for 
saving the Gsgt Session Log. 
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Additionally when session is closed by opening another scenario, a dialog is presented to save the Save 
Gsgt Session Log. 

 

3.5. View information about a scenario 

The Scenario Information dialog displays a summary of the scenario. Included in the summary are the 
scenario Start time, Airspace Adaptation name and site, Facility Adaptation name(s) and site, Weather 
directory, and the number of Targets, RSIs, and AC characteristics defined. 

Select Help->Scenario Info from the GSGT Main Window (see Section 2.3, “Main Window”). 
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OK  

Closes the Scenario Information dialog. 

3.6. Open Scenario Manager 

Scenario Manager opens a default file manager, which may vary depending on the system and 
configuration, that enables to list the source directories and scenarios that can be copied, moved, or 
deleted. 

Select Scenario -> Scenario Manager from the GSGT Main Window (see Section 2.3, “Main 
Window”). 

3.7. Change weather scenario in GSGT scenario 

A GSGT scenario may include a weather scenario for more realistic simulation. The weather scenario 
may be added, changed or removed dynamically from within the currently open GSGT scenario session 
using menu options Add/Change Wx or Remove Wx. The Add/Change Wx function adds a weather 
scenario to currently open GSGT scenario. In a situation when a weather scenario is already loaded, it's 
replaced with the current selection. Single GSGT scenario support only one weather scenario. 

To load or replace currently associated weather scenario select Scenario->Add/Change Wx from the 
GSGT Main Window (see Section 2.3, “Main Window”). This opens a dialog to select weather scenario. 
The selected weather scenario becomes associated with the GSGT scenario. To remove currently 
associated weather scenario select Scenario->Remove Wx from the GSGT Main Window (see 
Section 2.3, “Main Window”). 
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Changing scenario may take few minutes to complete. Additionally when GSGT runs with ATCoach 
engine, the session must be restarted in order for ATCoach to load changed weather data. To restart 
session, save scenario and select Scenario->Reload current from the GSGT Main Window (see 
Section 2.3, “Main Window”). 
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4. Scenario Editor 
4.1. Preferences 

Preferences are used to specify timing and other attributes of the scenario. GSGT looks for a preferences 
configuration file called prefs.xml. First it looks in the scenario directory and then in the directory 
specified by the environment variable $GSGT_SITE_DEFAULTS. If prefs.xml cannot be found in either 
location, standard defaults are used. 

4.1.1. Edit preferences 

To edit Scenario Preferences click on the Preferences object label in the Scenario Editor Main Window. 

 
Scenario Parameters  

Start Time  

All scenario events are pegged to this value. Changing this value will change all event times in 
the scenario accordingly. 

Run Time  

The length of the scenario.  
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Radar Noise Random Number Seed (HCS version only)  

The random number seed to be used for generation of radar noise. A value of -1 means use a 
random seed. For the generated noise to be identical from run to run set this value to any 
arbitrary positive integer. 

Export Msg Timing Parameters  
System Setup Time  

No messages will be injected before this time, unless the message is marked as a system setup 
message. 

Tgt Minimum Inter Msg Time  

The minimum amount of time to be interjected between a target's associated messages. Ensures 
that messages associated with the same target will not be injected out of order. It is useful in 
large sims, when msg injection times tend to be delayed due to equipment injection delays.  

Msg Auto-Derive Parameters  
FP Lead Time  

For auto-generated messages, the amount of time preceding a target's start time that the FP will 
be scheduled. 

Track Start Offset  

For auto-generated messages, the time after a target's start time that the QT or TI will be 
scheduled. 

Intra-facility Lead Time  

For auto-generated messages, the time before an inter-sector boundary crossing when the 
handoff will be scheduled (QN messages). 

Inter-facility Lead Time  

For auto-generated messages, the time before an inter-facility boundary crossing when the 
handoff will be scheduled (TI messages). 

Handoff Accept Delta  

For auto-generated messages, the time between the handoff and the handoff accept. 

Min Sector Control Time (secs)  

For auto-generated messages, the minimum amount of time a target must spend in a sector before 
a handoff to that sector will be scheduled. 
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Source of derived SA messages  

SA messages derived based on pref-route (ADR, AAR and ADAR) selection in target route are 
generated with specified equipment source. 

Use ICAO 2012 Format for Flight Plan messages (IFFI = 1)  

Auto generated Flight Plans (FP/FPL) messages are generated using ICAO 2012 format (NEW) 
instead of the legacy format (PRESENT). When this option is selected ICAO Flight plan Format 
Indicator (IFFI) must be set to 1 (NEW) 

Use FPLs for domestic proposed flights with NADIN source  

By default domestic proposed flights are auto-generated with FP messages. With this option 
selected, all domestic proposed flights are generated using FPL messages injected from the 
specified NADIN source. Additionally in some situations AM messages are auto-derived with 
delta time as specified. 

Use undirected handoffs from ARTS  

Auto-generated flight plan messages use undirected handoffs from Arts facilities. 

Use Altitude Restrictions  

Auto-generated hand-off messages are derived according to qualifying altitude restrictions for 
the given flight. 

Use relative coordination time format  

For auto-generated messages, use relative time format for field 7 in the auto-generated FP. 

Use internal start track mode  

For auto-generated messages, start all tracks internally to the local adaptation. That is, don't use 
any incoming TI handoffs. 

Adjust target speed while in hold  

Adjust target maximum speed while target is executing a holding pattern. 

Apply  

Save and apply the changes made and close the Preferences editor dialog. 
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4.2. Adaptation Equipment and DS 

GSGT creates Equipment devices based on the equipment defined in the adaptation. Since the 
equipment is adapted most of their attributes cannot be modified. However there are few exceptions 
where some of the attributes can be modified. 

Equipment attributes can be viewed using various Equipment Editors. To open the editor click on the 
Adaptation object label in the Scenario Editor then double-clicking on the desired Equipment in the list 
tree. To unroll subtree contained in particular type of equipment click on the + icon to the left of the 
item.  

4.2.1. Equipment Editors 

There are several types of equipment for each adaptation. Each equipment type has its own 
characteristics and unique fields, however there are some characteristics that are common for many 
equipment types. Each type of equipment has a specific editor for that type and the values are displayed 
as read-only for attributes that can't be modified. 
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4.2.1.1. ARTS Equipment Editor 

ARTS equipment has no attributes that can be modified. 

4.2.1.2. ATM Equipment Editor 

ATM equipment has no attributes that can be modified. 

4.2.1.3. CFAF Equipment Editor 

CFAF equipment has no attributes that can be modified. It is present in HCS version only 

4.2.1.4. FDIO Equipment Editor 
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FDIO equipment has no attributes that can be modified. 

4.2.1.5. NADIN Equipment Editor 

NADIN equipment is generated based on the adaptation but may also be user defined. Adapted 
equipment appears LIGHT BLUE in list and cannot be deleted. Non-adapted equipment appears 
GREEN and may be modified and deleted. 

Name  

The equipment name. The name is auto formated based on the Facility ID and NADIN Address. 

Facility ID  

The facility name. 

NADIN Address  

Address of the NADIN device. 

4.2.1.6. NAS Equipment Editor 

NAS equipment has no attributes that can be modified. 

4.2.1.7. NOTAM Equipment Editor 

A single NOTAM device is auto-generated by GSGT and it has no attributes that can be modified. 

4.2.1.8. IOT Equipment Editor 

IOT equipment has no attributes that can be modified. It is present in HCS version only 

4.2.1.9. KVDT Equipment Editor 

KVDT equipment has no attributes that can be modified. It is present in HCS version only 

4.2.1.10. READER Equipment Editor 

READER equipment has no attributes that can be modified. It is present in HCS version only 

4.2.1.11. SWIM Equipment Editor 

A single SWIM device is auto-generated by GSGT and it has no attributes that can be modified. 

4.2.1.12. WMSCR Equipment Editor 

A single WMSCR device is auto-generated by GSGT and it has no attributes that can be modified. 
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4.2.2. DS Equipment Editors 

Some systems refer to 'DS' as 'DSR'. There are two types of DS objects in GSGT - DS Sector Position 
and DS Equipment. Most of the attributes are adapted and can't be modified with exception of sector 
pilot position options. 

4.2.2.1. DS Sector Position Editor 

The sector number (or ID) is set by the adaptation used in the scenario. Only certain DS Sector Position 
information can be edited. To edit Sector Position double click on sector position name in the list of 
objects. 
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Controlled Live  

Sets the sector as 'live'. A live sector is intended to have a real person controlling the traffic and 
creating appropriate messages, so GSGT will not auto-derive messages for this sector. 

Frequency  

The sector position frequency. 

Pilot Position  

The pilot position assigned to the sector. This is set by the pilot positions editor (see 
Section 4.11.2, “Pilot Position Editor”). 

4.2.2.2. DS Equipment Editor 

DS Equipment Editor is used for viewing M&C, AT Specialist and Sector equipment. All of the 
attributes of this type of equipment are adapted and my not be modified or deleted. 

4.3. AChars - Aircraft Characteristics 

GSGT defines AChars based on the aircraft characteristics read from a site adaptation or specific aircraft 
characteristics sets referenced by scenario. The Turn Rate profile is generated from GSGT defaults. 
Adapted AChars are shown in GRAY and their attributes and profiles can't be modified. User defined 
AChars may be added for non-adapted aircraft with custom attributes values. Non-adapted (user 
defined) AChars are shown in BLUE and all of their attributes and profiles are editable. 

4.3.1. Create and Edit AChar 

To create an AChar, click on the AChar object label in the Scenario Editor Main Window and right-
click the object list. Select New from the context menu. To edit or view AChar attributes double click on 
the desired AChar in the list. 
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4.3.1.1. AChar Attributes 

 
Model  

Model name of the AChar. 

Max Alt  

The Maximum Altitude of the aircraft, in feet. 

Acceleration  

The rate of Acceleration, in knots per minute. 

Deceleration  

The rate of Deceleration, in knots per minute. 

Max Climb Factor  

The Maximum Climb Factor, in feet per minute. 

Max Descent Factor  

The Maximum Descent Factor, in feet per minute. 
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Max Turn Factor  

The Maximum Turn Factor (no units). 

AC Criteria  

Aircraft Criteria 

Performance Group  

Aircraft Performance Group 

Adapted  

Indicates whether the AChar is an adapted Aircraft Type. 
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4.3.1.2. AChar Climb Profiles 

 
New  

Opens the Climb Profile dialog to create a new record. 

Edit  

Opens the Climb Profile dialog to edit the selected record. 

Delete  

Deletes the selected record(s). 
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4.3.1.2.1. Climb Profile Dialog 

The Climb Profile Dialog is displayed when 'New' or 'Edit' selected from the Climb Profile list or if a 
record is double-clicked. 

 
Temperature  

The temperature delta in degrees Celsius. 

Rate  

The climb rate in feet per minute. 

Pressure Alt.  

The altitude in feet. 

TAS  

True Air Speed in knots. 

Min TAS  

Minimum True Air Speed in knots. 

Max TAS  

Maximum True Air Speed in knots. 
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4.3.1.3. AChar Descent Profiles 

 
New  

Opens the Descent Profile dialog to create a new record. 

Edit  

Opens the Descent Profile dialog to edit the selected record. 

Delete  

Deletes the selected record(s). 
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4.3.1.3.1. Descent Profile Dialog 

The Descent Profile Dialog is displayed when 'New' or 'Edit' selected from the Descent Profile list or if a 
record is double-clicked. 

 
Temperature  

The temperature delta in degrees Celsius. 

Rate  

The descent rate in feet per minute. 

Pressure Alt.  

The altitude in feet. 

TAS  

True Air Speed in knots. 

Min TAS  

Minimum True Air Speed in knots. 

Max TAS  

Maximum True Air Speed in knots. 
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4.3.1.4. AChar Turn Rate Profiles 

 
New  

Opens the Turn Rate Profile dialog to create a new record. 

Edit  

Opens the Turn Rate Profile dialog to edit the selected record. 

Delete  

Deletes the selected record(s). 
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4.3.1.4.1. Turn Rate Profile Dialog 

The Turn Rate Profile Dialog is displayed when 'New' or 'Edit' selected from the Turn Rate Profile list or 
if a record is double-clicked. 

 
Speed  

True air speed in knots. 

Rate  

The turn rate in degrees per second. 
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4.3.1.5. AChar Max Speed Profiles 

 
New  

Opens the Max Speed Profile dialog to create a new record. 

Edit  

Opens the Max Speed Profile dialog to edit the selected record. 

Delete  

Deletes the selected record(s). 
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4.3.1.5.1. Max Speed Profile Dialog 

The Max Speed Profile Dialog is displayed when 'New' or 'Edit' selected from the Max Speed Profile list 
or if a record is double-clicked. 

 
Speed  

The maximum speed in knots. 

Pressure Alt.  

The altitude in feet. 
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4.3.1.6. AChar Min Speed Profiles 

 
New  

Opens the Min Speed Profile dialog to create a new record. 

Edit  

Opens the Min Speed Profile dialog to edit the selected record. 

Delete  

Deletes the selected record(s). 
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4.3.1.6.1. Min Speed Profile Dialog 

The Min Speed Profile Dialog is displayed when 'New' or 'Edit' selected from the Min Speed Profile list 
or if a record is double-clicked. 

 
Speed  

The maximum speed in knots. 

Pressure Alt.  

The altitude in feet. 

4.4. RSIs 

Record Selection Indicators, abbreviated RSI, can be used to identify various messages, which can then 
be selected or filtered during runtime. 

4.4.1. Create and Edit RSI 

To create a new RSI, click on the RSIs object label in the Scenario Editor Main Window and right-click 
the object list. Select New from the context menu. 
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Value  

Integer value between 1 and 99999. 

 

Note 

Each integer value can only be used for one RSI. The following warning is displayed, when 
there is an error adding a RSI. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 61   

 
Description  

Text description of the RSI. 

OK  

Save and apply the changes made and close the RSI editor dialog. 

Cancel  

Cancel the changes made and close the RSI editor dialog. 

4.4.2. Edit objects associated with specific RSI 

From the Scenario Editor, right-click on the desired RSI to display the RSI context menu and select New 
Editor. 

 

This opens RSI-specific scenario editor. These editors only display scenario items that are associated 
with the given RSI, but otherwise function exactly like the general Scenario Editor. 

4.5. Radars 

GSGT creates Radars based on the radar definitions in the adaptation. Adapted Radars are shown in 
BLUE and their attributes can't be modified. Static messages are also automatically generated based on 
the adapted values but they can be changed dynamically using overrides and events. Additionally non-
radar areas may be defined to inhibit target detection in certain geographic areas. 
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4.5.1. Editing Radars 

To edit or view Radar attributes double click on the desired Radar in the list. Radar attributes can't be 
modified directly, however some attributes can be changed using the Events.  

 
Name  

Name of the radar. 

Type  

Radar type.  

The available types are: ANFPS117, ARSR1, ARSR2, ARSR3, ARSR4, ASR7, ASR8, ASR9, 
ASR11, ASR11-DOD, ASR11ER, ATCBI6, MODE-S, and LRR. 
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Scan Time  

Number of seconds to complete a full scan. 

Start Azimuth  

Starting azimuth. 

Max Altitude  

Maximum altitude of coverage. 

Range  
Primary and Secondary Min (HCS version only)  

The start of the radar's detection range (in nmi). 

Primary and Secondary Max  

The end of the radar's detection range (in nmi). 

Beacon Equipment  

Check boxes to select if radar contains Mode-S (HCS version only), Mode-2 (HCS version only), 
and/or Mode-3a equipment. 

Location  
Position  

The latitude and longitude of the radar. 

Elevation  

Elevation of the radar, in feet. 

Channels (HCS version only)  
LDNs  

Up to 5 three-digit LDNs (logical device numbers) can be entered (separated by commas). Each 
LDN corresponds to a radar channel. For example, specifying three LDNs declares the radar to 
have three channels. 

 

Note 

Entering a value for the LDN disables the Chans, since the number of channels corresponds 
to the number of LDNs. The value displayed in the disabled Chans is ignored. 
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Chans  

The number of channels of the radar. Chans is only enabled when LDNs is empty. 

Magnetic Deviation  

The deviation (in degrees) between the radar's north and magnetic north. 

4.5.2. Static Radar Messages 

Static Radar Messages can be viewed/edited by selecting the Static Messages tab from the Radar Editor. 

A static Radar Message is a message sent from a radar that repeats once every scan such as Parrots and 
Permanent Echoes. GSGT automatically generates set of static messages based on the adapted values. 
The list includes all static messages contained in the radar. 

 

Adapted Static Messages are shown in LIGHT BLUE. They can't be deleted but their contents may be 
modified using overrides, which are defined as time intervals. For any specific time interval the message 
data can be modified or disabled using inhibit. 

4.5.2.1. Static Radar Message Dialog 

The Static Radar Message Editor dialog is used for editing static message overrides. To edit existing 
message double-clicked on particular message in Static Radar Messages list. 
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Msg Type  

Displays the message type in a non-editable format. The message type is set by the value of the 
hex digits in Word 0. Changing the value of Word 0 automatically changes the message type. 

Inhibited Time Intervals  

List of time intervals during which the override message is active. Inhibit intervals may not 
overlap and only the final interval can have a Stop time of 'None', which mean infinite. 

Right mouse click context menu options 

New Inhibit  

Opens the Inhibit Time Interval dialog to create a new interval. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 66   

New ModifyCD2  

Opens the Modify CD2 Time Interval dialog to create a new interval. (depends on radar type) 

New ModifyAsterix  

Opens the ModifyAsterix Time Interval dialog to create a new interval. (depends on radar type) 

Edit  

Opens the Time Interval dialog to edit the selected interval. 

Delete  

Deletes the selected time interval(s). 

Description  

description of the message. 

Word0 - Word6  

Boxes in which the values of each word of the message are represented. A value is 3 hex digits. 
When Parity Error is checked, the parity error bit for the word will be set when the message is 
generated. 

4.5.2.2. Inhibit Time Interval Dialog 

The Inhibit Time Interval Dialog is used to create and edit time intervals when static radar messages are 
disabled. This dialog is open when New Inhibit is selected from the right mouse click context menu on 
the Static Radar Message Inhibit Time Interval list. 

 
Start Time  

Sets the start time of the interval. 
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Stop Time  

Sets the stop time of the interval. If None is selected, the message will repeat for as long as the 
scenario is running. 

4.5.2.3. ModifyCD2 Time Interval Dialog 

The ModifyCD2 Time Interval Dialog is used to create and edit time intervals to change static radar 
messages. This dialog is open when New ModifyCD2 is selected from the right mouse click context 
menu on the Static Radar Message Active Time Interval list. 

 
Start Time  

Sets the start time of the interval. 

Stop Time  

Sets the stop time of the interval. If None is selected, the message will repeat for as long as the 
scenario is running. 

Modification Data  

Hex data for the modified message. 

4.5.2.4. ModifyASTERIX Time Interval Dialog 

The ModifyASTERIX Time Interval Dialog is used to create and edit time intervals to change static 
radar messages. This dialog is open when New ModifyASTERIX is selected from the right mouse click 
context menu on the Static Radar Message Active Time Interval list. 
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Start Time  

Sets the start time of the interval. 

Stop Time  

Sets the stop time of the interval. If None is selected, the message will repeat for as long as the 
scenario is running. 

Modification Data  

Hex data for the modified message, specifying FRN, Mask and Data to be replaced. 

4.5.3. Radar Events 

Radar Events are similar to Target Events and Service Volume Events. They are associated with a 
particular radar and affect its output and behavior by changing various characteristics of the generated 
data. 

The Radar Events list is opened by selecting the Events tab in the Radar Editor. 
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Event List  

List of radar events. 

Right mouse click context menu options: 

New  

Opens the Radar Event dialog to create a new event. 

Edit  

Opens the Radar Event dialog to edit the selected event. 
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Delete  

Deletes the selected radar event(s). 

4.5.3.1. Radar Events Editor 

Radar Events are created and edited using Radar Event Editor. This allows to define a wide range of 
events that can be applied to a radar to change its characteristics and behavior. Reference table below 
describing all available events. 

 
Event Type  

A drop-down box selection of the Event Type (see Table 5, “Radar Event Types”) 

Time  

Sets the time the event will be generated. 

RSI  

List of RSIs for this target. Clicking 'Select' will open a scroll down menu allowing you to select 
the desired RSIs. Holding CTRL or SHIFT while clicking enables more than one RSI to be 
selected. 

Value settings and radar antenna selection  
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Options and value settings for the event. The available options and values vary based on the 
Event Type. 

Table 5. Radar Event Types 

Event Description 
Sensor Active Sets primary or secondary antenna sensor up or down 
Change Range Bias Sets range bias for primary or secondary antenna 
Change Range Noise Sigma Sets range noise sigma for primary or secondary antenna 
Change Azimuth Bias Sets azimuth bias for primary or secondary antenna 
Change Azimuth Noise Sigma Sets azimuth noise sigma for primary or secondary antenna 
Change BlipScan Sets blip scan for primary or secondary antenna 
Change Run Length Sets the run length 
Generate Strobe Generates a strobe with a call sign for defined number of scans 
Change Ghost Percentage Sets ghost percentage (HCS version only) 
Change Ghost Delta Range Sets ghost delta range (HCS version only) 
Change Ghost Delta Azimuth Sets ghost delta azimuth (HCS version only) 
Change Merge Range Diff Sets merge range difference (HCS version only) 
Change Merge Range Azimuth Sets merge azimuth difference (HCS version only) 
Change Chans Sets number of channels (HCS version only) 
Change Noise Level Sets the noise level (HCS version only) 
 

4.5.4. Non-Radar Areas 

The Non-Radar Areas define areas in the radar coverage where radar data in not generated. The areas are 
defined by azimuth, range and altitude. 

The Non-Radar Areas list is opened by selecting the Non-Radar Areas tab from the Radar Editor. 
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Cone of Silence (ERAM version only)  

One half of the angle (in degrees) directly above the radar which it cannot generate target 
returns. 

Non-Radar Area Editor  

Add new or modify existing area definition by providing Azimuth, Range and Altitude. (see 
Section 4.5.4.1, “Non-Radar Areas Editor”) 

Non-Radar Areas List  

List of non-radar areas defined in the radar. Select a specific non-radar area in the list to populate 
its values into the editor and be able to change any value. 

Right mouse click context menu options: 

Delete  

Deletes the selected area(s). 
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4.5.4.1. Non-Radar Areas Editor 

The non-radar area is a 3-dimensional shape (pie shaped) defined by start and end azimuth, start and end 
range and base and ceiling altitude. The area can be defined for both primary and secondary radar 
sensors. 

 
Azimuth  

The Start and End azimuth (angle) of the Non-Radar Area, in degrees. 

Range  

The Start and End range of the Non-Radar Area, in Nmi. 

Altitude  

The Base and Ceiling altitudes of the Non-Radar Area, in hundreds of feet. 

Radar Type Excluded  

The radar type that is excluded for the Non-Radar Area. Values are Both, Primary, Secondary. 

Add  

When new Non-Radar Area is defined Add button created the non-radar area using the provided 
values and updates the list of areas.  

Update  

When existing Non-Radar Area is changed Update button modifies the selected non-radar area 
using the provided values and updates the list. 

When radar editor is open, radar coverage and all of it's defined non-radar areas are displayed on the 
map viewer. Also when a non-radar area is created/edited, it is highlighted on the map vewer and 
updated as its values are changed in the editor. 
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The non-radar areas also can be defined by point and click on the map viewer using Shift + mouse click 
and drag. The coordinates of the starting and ending points are translated into start and end 
Azimuth/Ranage and populated into the editor as the mouse is moved on the map viewer. If Altitude is 
not provided, it's prepopulated based on the current viewer altitude, such that Base becomes current 
viewer altitude and ceiling is set 5000 ft higher than Base altitude. 

4.6. Restrictions 

GSGT extracts adapted altitude restrictions and presents them in a tree list grouped by facility and then 
by activation type (Always_On, Scheduled and Always_Off). Each restriction item lists its attributes 
which can't be modified. The only restriction value that can be modified is the enable/disable status. 

Restrictions that are adapted as Always_On are automatically enabled, all others are disabled by default. 
Also restrictions that are adapted in facilities that current scenario does not include are disabled and can't 
be enabled. To enable or diable any particular restriction so that it's used when target trajectory is 
checked for qualifying restrictions, simply check or uncheck the checkbox for particular restriction. 
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4.7. Service Volumes - ADS-B 

GSGT creates ADS-B Service Volumes based on the service volumes defined in the adaptation. Since 
all service volumes are adapted, their attributes cannot be modified. However events can be defined that 
will change some of the parameters dynamically. Static messages are generated automatically based on 
the adapted values but they can be changed dynamically using overrides and events. Additionally 
Coverage Areas may be used to define inclusion or exclusion areas to activate or deactivate target 
detection in certain geographic areas.  

Service Volume tree allows to view attributes and edit static messages and events. To view the Service 
Volume attributes, select + symbol next to Service Volume object. 
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The image above shows the Service Volume Editor attribute tree where general attributes of an adapted 
Service Volume and its contained Radio Stations and Radio Receivers can be viewed. It also displays its 
static messages, events and coverage areas. 

The Radio Stations sub tree lists Radio Stations that are adapted for the selected Service Volume. The 
list includes attributes, Radio Receivers contained in the station and their specific static messages. The 
Radio Receivers sub tree similarly lists its attributes and their corresponding static messages. 

4.7.1. Service Volume Boundary 

When Service Volume Boundary (AOI) is adapted, the detection of ADSB targets is limited to within 
the boundary regardless of radio station coverage that is outside of the boundary. This however never 
affects the detection of the test targets. When the boundary is not adapted, the detection occurs anywhere 
within the radio stations coverage. The target detection can be overridden by defining inclusion and 
exclusion Coverage Areas see Section 4.7.5, “Service Volume Coverage Areas”. If boundary is adapted, 
it can be previewed on the map by enabling it from the View menu. 

In certification scenarios, the Service Volume Boundary is ignored entirely and target detection occurs 
only within the certification radio stations, normally named RSXX<SITE> and RSYY<SITE>. All other 
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radio stations are ignored entirely and there is no detection and status messages generated. In all other 
scenarios, it's reversed, where certification radio stations are ignored entirely.  

4.7.2. Service Volume Grids 

Service Volume Grid is an ATCoach definition that is used internally by ATCoach for its target 
detection. This definition is used only when GSGT is using ATCoach engine. Both normal and 
certification grids are dynamically calculated based on the Service Volume Boundary, if adapted, or by 
radio station coverage. The normal grid is calculated based on the boundary coverage, and if not adapted 
then it's based on all radio stations coverage, excluding certification radio stations. The certification grid 
only includes area defined by certification radio stations. 

Service Volume Grids can be previewed on the map by enabling them from the View menu. They are 
provided as a guide to illustrate the Service Volume grid cells for normal and certification scenarios. 

4.7.3. Static Service Volume Messages 

Static Service Volume Messages (ASTERIX) can be viewed/edited by selecting the Static Messages sub 
tree from the Service Volume tree view. 

A static Service Volume Message is a message sent from an ADSB Sensor (i.e. Radio Station/Receiver) 
that repeats in predetermined interval such as the status messages. GSGT automatically generates set of 
static messages based on the adapted values. 

Messages that are generated based on adaptation are LIGHT BLUE. The Static Messages list displays all 
of the static messages that have been adapted/auto-generated pertaining to the Service Volume, Radio 
Station or specific Radio Receiver. Note that adapted messages can't be deleted. Static messages can be 
modified or inhibited using overrides in similar fashion as radar static messages. 

Right mouse click context menu options: 

Edit  

Opens the Static ASTERIX Message Editor dialog to edit the selected message. 

4.7.3.1. Static ASTERIX Message Editor 

The Static ASTERIX Message Editor is used for new or editing of existing static message list. 
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Period  

Indicates the interval, in seconds, at which the message should be repeated. 

Overrides  

List of time intervals during which the override message is active. Inhibit intervals may not 
overlap and only the final interval can have a Stop time of 'None', which mean indefinite. 

Right mouse click context menu options 

New Inhibit  

Opens the Inhibit Time Interval dialog to create a new interval. 

New ModifyAsterix  

Opens the ModifyAsterix Time Interval dialog to create a new interval. 
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Edit  

Opens the Time Interval dialog to edit the selected interval. 

Delete  

Deletes the selected time interval(s). 

Description  

For adapted/auto-generated static messages, it's a general description of the purpose of the static 
message. For user-entered messages the description may contain any text and will have no effect 
on the message. 

Data  

Hex representation of values in each FRN of the ASTERIX message. Byte values are specified in 
2 hex digits. 

4.7.3.2. Inhibit Time Interval Dialog 

The Inhibit Time Interval Dialog is used to create and edit time intervals for disabling static Service 
Volume messages. This dialog is open when New Inhibit is selected from the right mouse click context 
menu on the Static ASTERIX Message Overrides list. 

 
Start Time  

Sets the start time of the interval. 

Stop Time  

Sets the stop time of the interval. If None is selected, the message will repeat for as long as the 
scenario is running. 
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4.7.3.3. ModifyASTERIX Time Interval Dialog 

The ModifyASTERIX Time Interval Dialog is used to create and edit time intervals to change static 
Service Volume messages. This dialog is open when New ModifyASTERIX is selected from the right 
mouse click context menu on the Static ASTERIX Message Overrides list. 

 
Start Time  

Sets the start time of the interval. 

Stop Time  

Sets the stop time of the interval. If None is selected, the message will repeat for as long as the 
scenario is running. 

Modification Data  

Hex data for the modified message, specifying FRN, Mask and Data to be replaced. The Mask 
determines which bits are to be changed in FRN. The Data is the value that is applied to FRN 
only for corresponding bits that are set in the Mask. 

4.7.4. Service Volume Events 

Service Volume Events are similar to Target Events and Radar Event. They are associated with a 
particular ADSB service volume and affect its output and behavior by changing various characteristics 
of the generated data. 

The Service Volume Events list is part of the Service Volume Editor tree. Each item in the event list 
represents a single Service Volume Event. Event list operations can be invoked by right mouse click 
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context menu on Events tree parent and children. The operations include ability to add new event, or edit 
or delete existing events. 

Right mouse click Context menu options: 

New  

Opens the Service Volume Event Editor to create a new event. 

Edit  

Opens the Service Volume Event Editor to edit the selected event.  

Delete  

Deletes the selected Service Volume event (user is prompted before item is actually deleted). 

4.7.4.1. Service Volume Event Editor 

Service Volume Events are created and edited using Service Volume Event Editor. This allows to define 
a wide range of events that can be applied to a service volume to change its characteristics and behavior. 
Reference table below describing all available events. 
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Type  

Type of the event. 

Time  

Sets the time at which the event will be generated. 

RSI  

Associated RSI for this event. 

Event  

Individual options/values that can be adjusted for each type of Service Volume Event. The 
contents of the Event Frame will differ based on selected event type. 
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Table 6. Service Volume Event Types 

Event Description 
Service Volume Status Sets Service Volume status to enabled or disabled 
Service Volume Data Link 
Identifier Sets Service Volume data link identifier value (ERAM version only) 

Radio Station Status Sets the status to enabled or disabled of a selected Radio Station (ERAM 
version only) 

Radio Station Detection 
Probability 

Sets detection probability as a percentage value of a selected Radio 
Station (ERAM version only) 

Radio Station Time of 
Applicability offset 

Sets time of applicability (TOA) offset value of a selected Radio Station 
(ERAM version only) 

ASTERIX Message Filter Changes arbitrary value using a filter in the ADSB test target report 
messages (ERAM version only) 

Test Target Reporting Sets the test target reporting rate, as well and enables and enabled 
reporting of selected test target (ERAM version only) 

Test Target Integrity and 
Accuracy Changes ADSB Integrity and Accuracy for selected test target 

Squit Parameters Set squit parameters for UAT or 1090 reports. (HCS version only) 
 

4.7.5. Service Volume Coverage Areas 

Service Volume Coverage Areas are similar to non-Radar areas. They are associated with a particular 
ADSB service volume and define areas in that service volume coverage where ADSB targets are not 
detected or are forced to be detected. The Coverage Areas (inclusion and exclusion) are provided so that 
adapted coverage area can be overridden simulate specific needs. By default service volume detection 
area is defined by radio station coverage, and when service volume Boundary (AOI) is adapted, the 
detection area is limited to within that boundary.  

The user defined inclusion Coverage Area is used to specify area that is outside of service volume 
boundary, but within radio station coverage to explicitly force target detection and generate appropriate 
data during simulation. Inclusion area specified outside of radio station coverage or within service 
volume boundary has no effect on service volume detection.  

 

Note 

When service volume boundary is not adapted, specifying inclusion Coverage Area in any location 
has no effect. 

The user defined exclusion Coverage Area is used to specify area that is within detection area, radio 
station coverage and within service volume AOI boundary, when adapted. The exclusion Coverage 
Areas inhibit target detection and generation of data during simulation for that particular location. Area 
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specified outside of radio station coverage have no affect on detection. Also area specified outside of 
service volume boundary, when adapted, has no affect.  

 

Note 

The exclusion Coverage Area takes precedence over inclusion Coverage Area that is overlapping 
same area. 

The Service Volume Coverage Area list is part of the Service Volume Editor tree. Each item in the list 
represents a single Service Volume Coverage Area, inclusion or exclusion. Operations can be invoked 
by right mouse click context menu on Coverage Areas tree parent and children. They include ability to 
add new inclusion or exclusion areas, or edit or delete existing areas. 

Right mouse click Context menu options: 

New Inclusion Area  

Opens the Service Volume Coverage Area Editor to create a new inclusion area. 

New Exclusion Area  

Opens the Service Volume Coverage Area Editor to create a new exclusion area. 

Edit  

Opens the Service Volume Coverage Area Editor to edit the selected area.  

Delete  

Deletes the selected Service Volume Coverage Area (user is prompted before item is actually 
deleted). 

4.7.5.1. Service Volume Coverage Area Editor 

Service Volume Coverage Areas are created and edited using Service Volume Coverage Area Editor. 
The areas are defined as series of lat/lon points. Points are added using point and scroll mouse button 
click on any location on the map. individual points can be deleted and additional points can be added 
after current selection. 
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The Coverage Areas are previewed on the map while being edited. To aid with determining the location 
of the area, other tools can be displayed on the map, such as Service Volume AOI or Grid, as well as 
Service Volume Radio Stations (see Section 2.3.1, “Adaptation Window”) 

4.8. DataComms 

GSGT supports DataComm facilities using three interfaces, PGW, DCNS and TDLS. PGW and DCNS 
support is only available with adaptations that include NAPP processor, which indicates that there is 
appropriate hardware support for simulation. Additionally PGW support is limited for sites with 
environment variable (see Table 1, “Environment Variables”). TDLS support is available regardless of 
PGW or DCNS availability. 

4.8.1. DataComm Events 

DataComm Events are similar to Target Events and Radar Events. They are associated with a particular 
DataComm site and affect its behavior by changing various characteristics of the generated data. The 
events are used to change some of the DataComm behavior dynamically, such as status, response values, 
heatbeat rates and timeouts. 

The DataComm Events list is part of each DataComm facility Editor tree. Each item in the event list 
represents a single DataComm Event. Event list operations can be invoked by right mouse click context 
menu on Events tree parent and children. The operations include ability to add new event, edit or delete 
existing events. 

Right mouse click Context menu options: 

New  

Opens the DataComm Event Editor to create a new event. 
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Edit  

Opens the DataComm Event Editor to edit the selected event.  

Delete  

Deletes the selected DataComm Event (user is prompted before item is actually deleted). 

4.8.1.1. DataComm Event Editor 

TDLS, PGW and DCNS Events are created and edited using DataComm Event Editor. The editor allows 
to define several events that can be applied to a DataComm facility to change its characteristics and 
behavior. Reference table below describing all available events. 

 
Type  

Type of the event. 
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Time  

Sets the time at which the event will be generated. 

Initial  

Indicates that this event sets initial value/state for simulation. 

RSI  

Associated RSI for this event. 

Event  

Individual options/values that can be adjusted for each type of DataComm Event. The contents 
of the Event Frame will differ based on selected event type. 

Table 7. Event Types 

Event Description 
TDLS Close Connection Closes specified connection to a facility 
TDLS Heartbeat Enables/Disables heartbeat for specified connection to a facility 
TDLS Heartbeat Rate Sets heartbeat rate for specified connection to a facility 
TDLS Heartbeat Timeout Sets heartbeat timeout for specified connection to a facility 
TDLS Version Sets supported versions for a facility  
TDLS Version Message Enables/Disables Version Message for a facility 
TDLS Response Sets the response value for specified connection to a facility 
TDLS Response Timeout Sets response timeout for a facility 
TDLS Response On 
Connection Sets response on connection to a facility 

TDLS Response Delay Sets response delay for a facility 
TDLS Swap Active Swaps active connections to a facility 
TDLS Swap Standby Swaps standby connections to a facility 
TDLS Sequence Number Sets a delta for sequence numbers for a facility 
TDLS Auto Recon 
Request Enables/Disables auto reconstitution request for facility 

TDLS Send Recon 
Request Sends reconstitution request for facility 

TDLS Connect to Version 
Timeout 

Sets timeout between connection establishment and generation of Version 
Message for a facility 

TDLS Version and 
Heartbeat Timeout 

Sets timeout between generation of Version Message and Heartbeat 
Message 
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Event Description 
PGW Auto Message 
Assurance Sets values for automatically generated Message Assurnace 

DCNS DT TEI Sets DT TEI data values used in generated DataComm messages 

DCNS CPDLC Response Sets type of response and delays for auto generated Downlink CPDLC 
message upon receipt of Uplink CPDLC message. 

 

4.9. System Commands 

Messages defined in system commands are not associated with any Target. They can be injected from 
any supported device. There are several editors that are designed to edit and validate specific types of 
messages, however general editor supports freehand text editing of messages that allows to create any 
valid or invalid message format. 

4.9.1. Create and Edit System Command 

To create a new System Command, right-click on the System Commands object label in the object list 
of the Scenario Editor Main Window. This opens context menu to select the type for new system 
command message. There are several types of system commands that can be created. Depending on the 
selection of type an appropriate dialog is used. 

Certain system commands require or may be formatted with special characters or values that are 
represented as tokens. These tokens can be entered into the text of a System Command to be substituted 
to corresponding hex code or values during the export. The primary reason for these tokens is to provide 
a ASCII character representation for non-printable character values or for values that are unknown until 
the export or run time. 

Table 8. Special Character Tokens 

Token Description 
\d downward-pointing arrow aka arrival arrow 
\u upward-pointing arrow aka departure arrow 
\c or | clear weather symbol 
\o or ' overcast weather symbol 
\xHH arbitrary value, where HH is a two digit hex value 
\p interfacility messages parity error 
\e EOM token 
\l LRC error 

@@@ 

ATCoach "%ECID%" token.  

 

Note 

Message must be associated with a target in order for the proper aircraft id substitution to 
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Token Description 
take place. 

 

### ATCoach "%SCID%" token. 

*** 
ATCoach "%MSGSER%" token is used for the first occurance in the messgage. ATCoach 
"%SAVEDMSGSER%" token is used for the second occurance in the messgage. This primarily 
applies to EST message. 

$$$$ ATCoach "%MSGSEQ%" token 

 

 

Note 

Not all tokens may be appropriate in some message types. 

 

Note 

Tokens are not case sensitive, so for instance ether \c or \C can be used. 

 

Note 

In the non-Literal mode interfacility messages, a beginning LRC and ending LRC and EOM will be 
automatically generated. 

 

Note 

Entering an extra slash before a character will 'escape' it and not generate a special character. For 
example, the string "\\c" will be exported as "\c" and not as a clear weather symbol. 

4.9.1.1. Generic Message Editor 

The generic System Command can essentially be any message type. Messages that are properly 
formatted upon a subsequent editing are open in a default system command editor, such as Flight Plan, 
CMS, SWIM or SIGMET editors. 

To create a generic System Command, right-click on the System Commands object label and select 
New from the context menu. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 90   

 
Time  

Scroll menu allowing you to enter the time the message is to be entered into the scenario. Time is 
ignored for messages input from NOTAM equipment. 

Source  

Drop down menu allowing selection of the message injection source. 

RSI  

List of RSI descriptions for this message. Clicking 'Select' will open a scroll down menu 
allowing you to select the desired RSI. 

Live mode  

Messages tagged as Live will not be exported, but they will appear in message listings/reports. 
Live messages are primarily used as a placeholder. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 91   

Literal Mode  

Suppresses the generation of message headers and trailers, which are normally generated by 
GSGT. Generally only used to test Interfacility or NADIN messages. 

System setup msg  

Allows messages to be injected before the System Setup Time. 

Needs confirm  

A confirmation message will be injected immediately after this message, before any other 
message on the same input Device. 

Text  

Message text. 
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Channel (ERAM version only)  

ERAM channel(s) (network paths) on which the system message will be sent. 

Comments  

Any comments associated with the message. Comments are not displayed during scenario 
playback. 

Expected Results  

Text entry for the EXPECT card of the message. 
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Note 

Selecting the Device type NOTAM will cause a NOTAM message to be generated. Each NOTAM 
message is inserted in the exported NOTAM XML file. Gsgt will generate the xml format tag and 
the beginning <notams> and ending </notams> tags. The rest of the NOTAM message must be 
formatted by hand as XML. NOTAM messages cannot have a RSI selected. Because of this, 
NOTAM messages are exported to a single ATCoach file that has the same name as the scenario, 
with ".notam" appended to it. 

4.9.1.2. Flight Plan Editor 

The Flight Plan Editor is the default message editor for FP messages. It allows user to change all 
attributes of a FP message. 

To create a Flight Plan System Command, right-click on the System Commands object label and select 
New FP from the context menu. It is also used when New FP is selected in the Messages tab the Target 
Editor. 
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When GSGT is running in Terminal Mode, also there is a Terminal FP message available that is tailored 
for terminal systems. To create a Terminal Flight Plan System Command, right-click on the System 
Commands object label and select New Terminal FP from the context menu. It is also used when New 
Terminal FP is selected in the Messages tab the Target Editor. 
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4.9.1.3. CMS System Command Editor 

A CMS system command is a CMS (Common Message Set)-formatted message that is not associated 
with a Target. 

To create a CMS System Command, right-click on the System Commands object label and select New 
CMS Msg from the context menu. 
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A CMS system command has the same fields for Time, Source and RSI as a Generic system command, 
except the Text field is replaced with CMS fields definitions. 

ATCoach TIME token substitution is performed for fields 86B, 92A and the time portion of field 0E. 
For the sequence number portion of field 0E, entering "$$$$" will generate the MSGSEQ token. 

To create the SSPID token, enter "$$" in field 167A. 

Message Type  

The 2-letter message type. 
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Literal Mode  

Suppresses the generation of all header and trailer data, as well as token substitution. 

Field List  

List of the fields in the message. 

Right click on the field opens a context menu with following options: 

New  

Opens the CMS Field dialog to create a new CMS field. 

Edit  

Opens the CMS Field dialog to edit the selected field. 

Delete  

Deletes the selected field(s). 

 

Note 

Fields will be listed in the order that they are created. 

4.9.1.3.1. CMS Field Dialog 

CMS Fields dialog is defines individual CMS fields and assigned values. 

 
Field  

The CMS Field ID, consisting of a 1-3 digit field number and a one letter or digit field format. 
The period between field number and field format is not needed. For example, to specify field 
13.3, enter "133". 
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Value  

Text content of the field. 

4.9.1.4. SWIM System Command Editor 

SWIM system command editor is formulated for editing SWIM messages, in particular flight create, 
modify and update message types. The fields contained in each of the SWIM message types are adapted 
in accordance with the WSDL specifications. Most of the fields in the dialog are limited to a valid range 
of values by drop down selection or by value limitations in the text fields, however, per design, the 
dialog allows to save the message with missing required fields, and values out of range. 

 

When messages are created in the target messages, fields are pre-populated using available target's data 
and existing FP/FPL messages for user's convenience. However when message is created in scenario 
System Commands, target data is unavailable therefore fields can't be pre-populated. 
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4.9.1.5. SIGMET System Command Editor 

SIGMET system command editor is formulated for editing SIGMET WMSCR messages. Other 
WMSCR messages are open using the Generic system command editor. 

 

Most of the fields in the dialog are limited to a valid range of values by drop down selection or by value 
limitations in the text fields.  

The Geographic Area field can be manually typed in or selected from the map similarly as route of the 
target by clicking on points on the map. The points in the filed will be separated by "ETC TO" element. 

 

Note 

The first and last element of the Geographic Area must be the same to complete the area selection.. 
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4.9.1.6. DataComm System Command Editor 

DataComm system command editor is formulated only for editing DataComm messages. The messages 
are created and edited using appropriate editor dialogs depending on type and source of injection. Some 
of their availability is dependent on system emulation and adapted hardware.  

 

GSGT supports some of the PGW, DCNS, TIMS and TDLS messages, which due to complexity of 
native messages can't be edited using Generic Message editor. They are stored in proprietary format in 
GSGT and exported into xml equivalent messages that are processed by SIME using APIs and converted 
into native DataComm messages during injection. 

Table 9. DataComm Messages 

Type Description 

PGW 

PGW messages are supported when NAPP processor is present in adaptation and GSGT is not 
configured for site (see Table 1, “Environment Variables”). The messages included in the 
scenario are injected only when PGW Emulation is set to ON (see Section 9.4.1.3, “Facilities”) 

Supported messages: 
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Type Description 

AFN_CON (logon) 
PGW Notification 

 

DCNS 

DCNS messages are supported when NAPP processor is present in adaptation. The messages 
included in the scenario are injected only when PGW Emulation is set to OFF (see 
Section 9.4.1.3, “Facilities”) 

Supported messages: 

AFN_CON (logon) 
CPDLC downlink 
Message Assurance (MAS) 
Media Advisory (MED) 
Communication Service (SVC) 
Communication Service Assurance (SVC MA) 
Undelivered Uplink (REJ) 

 

TIMS 

TIMS messages are supported when NAPP processor is present in adaptation. The messages 
included in the scenario are injected only when PGW Emulation is set to OFF (see 
Section 9.4.1.3, “Facilities”) 

Supported messages: 

CPDLC uplink 
 

TDLS 

TDLS messages are supported regardless of presence of NAPP processor or PGW Emulation. 

Supported messages: 

Reconstitution Request (RR) 
Update Light (UF) - Logon Request (LR) 
Update Light (UF) - Clearance Delivered (CD) 
Update Light (UF) - Session Update (SU) 

 

 

The editor allows to create only xml schema valid messages. Some data fields allow invalid values that 
are still schema valid, and can be saved for testing purposes. Also certain values and responses can be 
changed using DataComm events (see Section 4.8.1, “DataComm Events”) 

When messages are created in the target messages, fields are pre-populated using available target's data 
and existing FP/FPL messages for user's convenience. However when message is created in scenario 
System Commands, target data is unavailable therefore fields can't be pre-populated. 
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4.9.1.6.1. DCNS and TIMS Filters 

The message content is limited to what schema allows. In order to create certain error conditions, create 
data filters to modify messages before injections. Filters only allow to change contents of ARINC 620 
and 622 parts of the message. The filters are message specific and can be added from Filters tab of 
message dialog. 

 
4.9.1.6.2. TDLS Filters 

The message content is limited to what schema allows. In order to create certain error conditions, create 
data filters to modify messages before injections. Filters only allow to change contents of MHP Header 
part of the message. The filters are message specific and can be added from Filters tab of message 
dialog. 

 
4.9.1.7. ATSpecialist Command Editor 

ATSpecialist command editor is formulated for editing ATSpecialit Command List of messages. 
Selected command list (Macro) is expanded into all consiting messages and injected with quater of a 
second intervals. 
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4.9.2. System Command Context Menus 

To access additional options for system commands, Right-click on a System Command item in the 
editor main window. This will display one of the following context menus depending on the message 
type. 

Double clicking on the System Command item will edit the message using the default editor associated 
with the message type. The default dialog for commands from ATM Devices is the CMS System 
Command dialog, for FP messages is the FP dialog and so forth. Messages types without default editor 
will open in generic System Command dialog. 

 
Edit  

Open system command in the default for the given message type System Command dialog 
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Edit with Generic dialog  

Opens the system command in the 'regular' System Command dialog. Note that CMS commands 
(from an ATM device) will include the separator character used by GSGT. 

Delete  

Deletes the selected System Command(s). 

Replicate  

Opens the Replicate dialog. The number of Replications and Delta time will always be applied. 
Replication will attempt to apply the Delta AID and Delta beacon values to the System 
Command. 

Clear Replications  

Clears all replications, leaving only the original System Command. 

4.10. Targets 

A Target is a representation of a flight with certain characteristics such as aircraft dynamics, equipment, 
route of flight, and events that control almost every aspect of its identity. The targets also include a set 
of messages, identical in structure to System Commands, but are associated with that particular target. 
The messages can be automatically derived based on the characteristics of the target, manually entered 
or be a combination of both. 

4.10.1. Create and Edit Target 

To create a Target, right-click on the Targets object label in the object list of the Scenario Editor Main 
Window. Select New from the context menu. 

4.10.1.1. Target Attributes 

The general target's attributes are located on the Main tab of the Target editor. The attributes describe 
the target's characteristics such as aircraft dynamics, on-board navigation equipment and transponder 
types. 
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Name  

2 - 7 alphanumeric characters designating the identity of the flight. The first character must be 
alphabetic, and may be followed by any combination of 1-6 alphanumeric characters. The 
minimum length is two (one letter and one digit). The minimum length for a letter-only name is 
three. 

Starttime  

The time at which the target becomes active. The time is specified in days, hours, minutes, 
seconds, and hundredths of seconds. 

Show Flight Path  

Displays the target's route in the adaptation viewer with a target dynamics information box (see 
Section 7.3, “Show Flight Path”). 

Dynamics  
AChar  

Drop-down menu allowing the user to select the aircraft characteristics of the target. 

Speed  



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 106   

1-4 numeric characters specifying the aircraft speed in knots or M followed by 3 numeric 
characters specifying the aircraft speed in Mach. Valid value range is 1-4095 Knots. 

Flevel  

Flight Level. 1-3 numeric characters designating the flight altitude in hundreds of feet. 

Registration  
Tail Number  

2 - 7 alphanumeric characters designating the aircraft's tail number. The first character must be 
alphabetic, and may be followed by any combination of 1-6 alphanumeric characters. The 
minimum length is two (one letter and one digit) 

Equipment  
Transponder  

• ATCRBS 

Mode 3A and Mode C 
Mode 3A only 

• Mode S (Mode3A and ModeC) 
• UAT (ADSB only) 
• 1090ES (Mode3A, ModeC, and ADSB) 

Beacon code  

1-4 octal digits designating the beacon code for the aircraft. Values less than 4 digits will be left-
padded with zeroes to reach a length of 4. Supplying a beacon code is optional, GSGT will 
generate beacon codes for aircraft as needed. 

ICAO Address  

6 hex digits designating the ICAO address for the aircraft. Supplying a ICAO address is optional, 
GSGT will generate ICAO address for aircraft as needed. 

NAS Equipment  

The single-letter equipment id. It is appended to aircraft type in the FP message. 

RSI  

List of RSI descriptions for this target. Clicking 'Select' will open a scroll down menu allowing 
you to select the desired RSI. 
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Comments  

Any comments associated with the target. Comments are not displayed during scenario playback. 

ICAO Data  

ICAO Data elements used while generating FP/FPL messages. Values for some of the elements 
are auto populated based on provided target attributes. Any element value can be edited by right 
mouse click -> Edit or simply double click the value. 

4.10.1.2. Target Route 

The Route tab of the Target Editor defines the path the target is flying in an airspace. A target's aircraft 
trajectory can be specified as a route with defined points, such as fixes and airports. Or it can be 
specified as an initial condition using position with heading or position with a join fix on a route. 

When first and/or last element on the route is an airport, GSGT can model appropriate departure or 
arrival from/to an airport, including modeling of particular runways on the airport. The runways must be 
predefined using Runways site definition in order to be available for selection (see Section 4.11.6.4, 
“Runway (RW) Site Definitions Editor”) 

Based on the target's route definition, GSGT generates radar and derives appropriate messages such as 
flight plans and handoffs (see Section 7.3, “Show Flight Path” and Section 4.10.1.3, “Target Messages”) 
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Route  

Text defining the planned flight route of the target. 

Text label indicating warnings and errors detected in the route of the target. 

Perform Departure Procedure  

When the first element of the route is recognized as an airport, GSGT enables option to simulate 
departure procedure and preselects it on every route validation. When Perform Departure 
Procedure is selected, the target will start with a speed appropriate for the aircraft type and the 
Flevel of the airport elevation. The target will then climb to reach assigned altitude as specified 
in the Dynamics section of the target dialog. The climb trajectory is calculated using aircraft 
characteristic profiles in conjunction with atmospheric conditions such as pressure and winds, 
when present in scenario. 

When runways are defined for departure airport, they will be listed in the Runway combo box. 
And when specific runway is selected, the target trajectory will be modeled as taking off from 
the specified runway. 

Qualified departure altitude restrictions ale listed in the Alt Restrictions combo box. 
Enforcement of restrictions can be enabled/disabled for this target using selection in the combo 
box. The restrictions that are enabled in this combo box will be enforced during derivation of 
handoffs messages for this target. 

Perform Arrival Procedure  

When the last element of the route is recognized as an airport, GSGT enables option to simulate 
arrival procedure and preselects it on every route validation. When Perform Arrival Procedure 
is selected, the target will start a descend adjusting speed as appropriate for the aircraft type to 
reach altitude of the airport elevation. The descend trajectory is calculated using aircraft 
characteristic profiles in conjunction with atmospheric conditions such as pressure and winds, 
when present in scenario. 

When runways are defined for arrival airport, they will be listed in the Runway combo box. And 
when specific runway is selected, the target trajectory will be modeled as landing on the 
specified runway. 

Qualified arrival altitude restrictions ale listed in the Alt Restrictions combo box. Enforcement 
of restrictions can be enabled/disabled for this target using selection in the combo box. The 
restrictions that are enabled in this combo box will be enforced during derivation of handoffs 
messages for this target. 

A label provides information for the arrival manoeuvres, such as the start of descend at a 
predetermined time, which is referred as top of descend (TOD). If the manoeuvres need to be 
altered, deselecting Auto-apply TOD provides option to save TOD as a target event that can be 
manually changed. 
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ADARs, ADRs and AARs pref routes  

The pref-routes are qualified based on number of criteria such as fixes, altitude ranges, and 
aircraft classes. Target route may qualify for one or more pref-routes and all of the pref-routes 
that are available are listed in corresponding selection box. Only a single pref route from each 
box may be selected. However ether ADAR or a combination of ADR and/or AAR can be 
selected.  

Initial condition  

If any of the initial value are provided, target will start with specified initial condition. 

Position  

The initial Latitude/Longitude of the Target. The initial/default value is the Latitude/Longitude 
of the Center's point of tangency. 

Initial Altitude  

The initial Flevel of the Target. 

Initial Speed  

The initial Speed of the Target. 

Initial Heading  

The initial Heading of the Target, in degrees. The valid range for the Heading is 0-359, with up 
to an optional 10 decimal places. It is only enabled when the Route text is empty. 

Join Fix  

When selected, indicates where the target will join the specified route. 

The flight route can be entered in two ways, using the point and click feature of GSGT or by manually 
typing the flight route text in the dialog box. To use the point and click function, place the cursor over 
the desired element such as a fix or an airport and left-click the mouse. The element is added to the 
flight plan and displayed in the flight plan dialog box. As elements are added to the flight plan, fixes and 
airports are highlighted in BLUE, the flight route is outlined in RED between fixes, and segments along 
airways are outlined in GREEN).  

Point and click adds new elements to the end of the flight plan. To add or remove an element in the 
middle of the route, manually modify the fix text in the flight plan dialog box or place the cursor after 
the element (before "." or "..") that you want to insert additional elements. 
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Note 

GSGT does not allow delay times to be typed directly in the route text. In order to create a delay, 
create a new target Delay Event (see Section 4.10.1.4, “Target Events”) 

 
4.10.1.3. Target Messages 

The Messages tab of the Target Dialog lists all non-radar messages associated with the target. The 
messages can be auto-generated (auto-derived) based on the route of the target or manually created. 
Messages are auto-derived only when Auto-generate msgs is selected. 

When target is set to auto-generate message, GSGT will generate all appropriate non-radar messages 
such as flight plan, start tracking, and handoff control of the flight between controllers and/or facilities 
as needed. 

Additionally parameters controlling the creation of auto-generated messages can be set in the scenario 
Preferences or Target Preferences (see Section 4.1, “Preferences” and Section 4.10.1.3.2, “Target 
Preferences”). 
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Table 10. Non-radar message color coding 

Color Description 
GREEN auto-generated messages, or auto-generated Terminal to Enroute (incoming) messages 
LIGHT GREEN auto-generated Enroute to Terminal (outgoing) messages (Terminal mode) 
ORANGE auto-generated Terminal to Terminal messages 
BLUE frozen messages, or frozen Terminal to Enroute (incoming) messages 
LIGHT BLUE frozen Enroute to Terminal (outgoing) messages (Terminal mode) 
PURPLE frozen Terminal to Terminal messages 
 

 

Note 

Frozen messages are always associated with the target and are not automatically updated as target 
characteristics are changed, except for when replicating and changing name and timing of the target. 
Auto-generated messages on the other hand, are automatically regenerated on every change to the 
target.  

 

Note 

Once a target enters a 'live' sector, derived messages are no longer generated. 
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Auto-generate msgs  

Enables auto generation of messages for the target. 

Edit Prefs  

Set target specific preferences for auto generated messages (see Section 4.10.1.3.2, “Target 
Preferences”). 

Edit FP Overrides  

Sets override values for auto generated FP messages (see Section 4.10.1.3.3, “FP Overrides”). 

Edit Time Intervals  

Sets the time interval during which the messages should be generated 

Msgs  

List of non-radar messages associated with the target. Clicking on the 'Time' header will sort the 
messages in time order. Clicking on 'Dest', 'Src', or 'Text' will sort appropriate column in 
alphanumeric order. Clicking on any of these headers twice will reverse the order of the sort. 

Derive Msgs  

When running with ATCoach engine, messages are not auto-generated automatically until user 
specifically initiates the action. This is due to potentially a lengthy process when ATCoach 
computes the target positions, as it may take several minutes, during which time all user input is 
disabled. 

Right mouse click context menu options: 

New  

Opens a generic message dialog to create a new message. 

New FP  

Opens the flight plan message dialog to create a new message. 

New Terminal FP  

Opens the terminal flight plan message dialog to create a new message. (Terminal mode) 

New CMS msg  

Opens the CMS message dialog to create a new message. (disabled in Terminal mode) 
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New SWIM msg  

Opens the SWIM message dialog to create a new message. 

Edit with generic dialog  

Opens the generic dialog message template. 

Edit  

Opens the default dialog message template for particular message type. 

Delete  

Removes selected message(s) from the list. 

Freeze  

Freezes selected message(s) in the list. 

4.10.1.3.1. Auto Deriving Target Messages 

When the Auto-generate msgs box is checked, GSGT calculates target positions along its entire route 
and derives appropriate non-radar messages, and then populates the messages list. In order to 
accomplish this, GSGT runs the simulation engine, which is almost instantaneous when running with 
Rhumb or Stereo engines. However when GSGT uses ATCoach engine this process can be lengthy. 

When GSGT is using ATCoach engine, GSGT exports target information to the ATCoach engine so that 
it can calculate target positions, which then it turn passes the target positions back to GSGT, based on 
which the derived messages are generated. This may take several minutes, during which time all user 
input is disabled. 

When the ATCoach simulation is complete and all messages have been derived, the derived messages 
will appear in GREEN in the messages list and normal program usage resumes. 

When the Auto-generate msgs box is unchecked while there are any derived messages in the list, a 
dialog box is displayed to confirm whether the derived messages should be saved as frozen messages or 
removed. 

 
4.10.1.3.2. Target Preferences 
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Target Preferences override the scenario preferences per target basis. To enable override of any 
particular preference, select and check that preference. When a parameter is checked, its value will be 
applied to this target only. When unchecked, the general scenario Preference value will apply. 
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Parameters in the Target Preferences behave exactly the same as in the scenario Preferences with an 
exception that target preferences are applied only per target basis (see Section 4.1.1, “Edit preferences”).  

Target Preferences also allow applying MISM in Handoffs to generate specific conditions. 

Apply MISM in Handoffs 

Position Offset Hdg  

Offset direction used in conjunction with Position Offset Dist for position offset to be applied in 
handoffs. 

Position Offset Dist  

Offset direction used in conjunction with Position Offset Hdg for position offset to be applied in 
handoffs. (balloon help displays adapted tolerance) 

Heading Offset  

Heading offset to be applied in handoffs. (balloon help displays adapted tolerance) 

Speed Offset  

Speed offset to be applied in handoffs. (balloon help displays adapted tolerance) 

Altitude Offset  

Altitude offset to be applied in handoffs. (balloon help displays adapted tolerance) 

The section for deriving flight plans for domestic proposed flights is used to override the scenario 
preferences to force generation of FP or FPL. 

Use Default  

Uses default setting to generate FP or FPL according to scenario preference. 

Use FP  

Forces generation of FP regardless of scenario preference 

Use FPL with NADIN source  

Forces generation of FPL from specified NADIN device regardless of scenario preference. 
Additionally in some situations AM messages are auto-derived from source device and with 
delta time as specified. 

The option for Source of derived SA messages is set by default to use setting from scenario preferences. 
The value can be overriten to use another equipment source for this particular target. 
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The options for Use internal start track mode, Use undirected handoffs from ARTS and Use altitude 
restrictions are set by default to use setting from scenario preferences. The values can be overriten to 
force Enable or Disable setting for this particular target. 

When any of the parameters in the Target Preferences Editor are changed from the default, Edit Prefs 
button will show an icon indication that values are changed, as illustrated below. 

 
4.10.1.3.3. FP Overrides 

The parameters in the FP Overrides Editor dialog override values in derived FP messages for this target 
only. When value is cleared, the default value in derived FP message is restored. 
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When any of the parameters in the FP Overrides Editor are set to be overwritten, Edit FP Overrides 
button will show an icon indication that values are overridden, as illustrated below. 

 
4.10.1.3.4. Editing Messages 

The editing of non-radar messages works identical as is System Commands with exception that 
messages are associated with the Target instead of being independent. The same set of message editors 
is used to edit the messages, which are automatically determined for appropriate type of message (see 
Section 4.9.1, “Create and Edit System Command”). 

Messages that are auto-derived and then are edited and changed, automatically become frozen messages. 
If the Auto-generate msgs is not disabled, the message that becomes frozen by editing will be 
automatically rederived and in essence making a duplicate message.  

 

Note 

Changes made in the Flight Plan Editor do NOT affect the target attributes set in the Target 
Attributes Editor.  

4.10.1.4. Target Events 

The Events tab of the Target Editor lists events that affect various aspects of the target. 
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Target Events  

List of events that are applied to the target. The list specifies the condition when event is applied 
and shortly describes the event. 

Right mouse click context menu options: 

New  

Opens the Target Event Editor dialog for an new event. 

Edit  

Opens an existing target event in Target Event Editor dialog. 

Delete  

Deletes the currently selected target event(s). 

Target Events allow to define a wide range of events that can be applied to a target to perform various 
tasks or change target's characteristics. Reference table below describing all available events. 
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Event Type List  

List of available event types that can be defined for the target (see Table 11, “Target Event 
Types”). 

Trigger  

Allows to choose the condition on which the Target Event is performed. Most event types only 
allow a time condition. Events such as Altitude Change and Speed Change allow either a Time 
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or Position to be used as a trigger. The available positions are taken from the Target Route, 
excluding the first and last fixes. If the target route contains airways, not filed (not explicitly in 
the route) fixes along the airway will also be available in the list. 

Event  

The value(s) that will take effect when the Event is processed. The Drop Target Event does not 
have a Command value. 

Generate Msg  

If selected, a message reflecting the changed value will be generated. Only valid for certain 
events such as Acid, Altitude, Beacon, and Speed Change Events. 

OK  

Closes the dialog and creates the specified Event. 

Cancel  

Closes the dialog and returns to the Target editor. 

Table 11. Target Event Types 

Event Description 
Change Acid Changes target's ID 

Change Altitude 
Changes target's altitude with option to specify rate and slope as well as set 
altitude as interim. See Section 4.10.1.4.1, “Event Processing” section for more 
explanation how interim altitude events are processed. 

Change Speed Changes target's speed with option to specify rate 
Speed Restriction 
(ATCoach only) Sets speed restriction as active or inactive. 

Max Hold Speed 
(ATCoach only) Sets maximum hold speed as active or inactive. 

Change Beacon Changes target's beacon code with option to change Mode 3A, ADSB or both 
Change Heading Changes target's heading with options to specify direction and rate 
Change Ident Bit Sets ident bit to enabled or disabled 
Change Mode C Sets Mode C to enabled or disabled 
Change Mode 3a Sets Mode 3A to enabled or disabled 
Change Run Length Changes target's run length to a specific value 
Change Track 
Eligibility Changes target's track eligibility to a specific value 

Change Search Changes target's search target quality to a specific value 
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Event Description 
Target Quality 
Change Search 
Target Confidence Changes target's search target confidence to a specific value 

Change Time In 
Storage Changes target's time in storage to a specific value 

Change PSR Blip 
Scan 

Changes target's primary search return (PSR) to a specific percentage value. When 
using ATCoach engine, PSR Blip Scan will only apply if its value is set to either 0 
or 100. 

Change SSR Blip 
Scan 

Changes target's secondary search return (SSR) to a specific percentage value. 
When using ATCoach engine, SSR Blip Scan will only apply if its value is set to 
either 0 or 100. 

Change Ghost 
Percentage 

Changes target's ghost percentage to a specific percentage value (HCS version 
only) 

Change Correlation Changes target's correlation 

Hold Defines a hold for a target with specific conditions such as length, turn direction, 
holding patters, etc 

Delay 
Defines a delay for a target with specific duration. When the messages are derived 
for the target, a "/Dxx+xx" will be inserted into the field 10 (route) of the FP 
message. 

Drop Target Drops the target before the end of its the route 
Message Injects a specific message from R, D or A position 
Response Mode 
Override Overrides NAS responses such as DR or DX, or NAM responses such as LRM 

Change CheckIn 
Required Sets CheckIn Required to enabled or disabled 

ADSB Reporting Enables or Disabled ADSB transponder reporting 
ADSB ICAO 
Address (FRN 5) Changes ADSB ICAO address 

ADSB Aircraft ID 
(FRN 12) Changes ADSB aircraft ID 

ADSB Integrity and 
Accuracy (FRN 6) Changes ADSB Integrity and Accuracy 

ADSB Emitter 
Category (FRN 13) Changes ADSB Emitter Category 

ADSB Reporting 
Rate Sets ADSB target reporting rate 

ADSB TCAS RA 
Messages (FRN 17) Changes ADSB TCAS RA Messages 

ADSB Target State 
(FRN 20) Changes ADSB Target State 
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Event Description 
ADSB Data Quality 
(FRN 21) Changes ADSB Data Quality 

ASTERIX Message 
Filter (ATCoach) 

Changes arbitrary value using a filter in the ADSB target report messages when 
using ATCoach engine 

ASTERIX Message 
Filter (JVN) 

Changes arbitrary value using a filter in the ADSB target report messages when 
using JVN engine 

Change DCNS DT 
TEI Sets DT TEI data values used in generated DataComm messages 

Change DCNS 
CPDLC Response 

Sets type of response and delays for auto generated Downlink CPDLC message 
upon receipt of Uplink CPDLC message. 

 
4.10.1.4.1. Event Processing 

Most of the target events are self explanatory as they simply change a single value at a certain trigger, 
such as specific time or location. However, some events perform more sophisticated processing and are 
explained below. 

4.10.1.4.1.1. Change Altitude 

The Change Altitude event provides the ability to adjust target's altitude. This simulates the climb or 
descend as appropriate. Optionally vertical rate or glide slope can be specified if other than default 
aircraft characteristic is needed. 

The event also allows to set interim and local interim altitudes. The current state of interim and local 
interim altitude is maintained such that when either is removed, the target's altitude is automatically 
adjusted to the altitude that was previously in effect. For example, when local interim altitude is 
currently set, upon it being removed the target's altitude adjust to interim altitude if it was previously set, 
otherwise altitude adjusts back to assigned altitude. 

4.10.1.5. Target ATCoach/Dysim Definitions 

The ATCoach/Dysim tab of the Target editor provides ability to change engine specific options and 
define Pre-Programmed Events and Pilot Prompts. This tab is labeled ATCoach, when running with 
ATCoach engine, and Dysim when running with JVN simulation engine.  
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Independent Release  

Engine will not generate the target at the start time. It needs to be released form pilot position. 

Symbol  

The Controller Symbol. The letter assigned to each aircraft (A-Z) (ERAM version only). 

Pilot  

Pseudo Pilot assigned to the target (optional) (ERAM version only). 

PPEs  

ATCoach Pre-Programmed Events (PPEs) that are associated with the target. 

 

Note 

The Target Pre-Programmed Events Editor is identical to the ATCoach Preprogrammed 
Events editor. (see Section 4.11.4, “Preprogrammed Event (PPE) Editor”) 
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Right mouse click context menu options: 

New  

Opens the Pre-Programmed Event dialog to create a new Pre-Programmed Event. 

Edit  

Opens the Pre-Programmed Event dialog to edit an existing target event. 

Delete  

Deletes the currently selected Pre-Programmed event(s). 

Prompts  

ATCoach Prompts that are associated with the target. 

 

Note 

The Target Prompt Editor is identical to the ATCoach Prompt editor. (see Section 4.11.3, 
“Pilot Prompt Editor”) 

Right click menu options: 

New  

Opens the 'Prompt' dialog to create a new Prompt. 

Edit  

Opens the 'Prompt' dialog to edit an existing prompt. 

Delete  

Deletes the currently selected Prompt(s). 

4.10.1.6. Target TGF Definitions 

The TGF tab of the Target editor provides ability to set/override any or all fields GSGT outputs in and 
exported TGF sim using TGF specific XML tags. Definitions contained in this tab are only exported in 
the TGF scenario (see Section 9.3, “TGF Export”) This tab is not available in SGET version. 

4.10.2. Target Context Menu 

Right-clicking on selected target(s) in the object tree of the Scenario Editor Main Window opens a 
context menu with certain actions such as Preview and Replication. 
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Delete  

Deletes the selected target(s). 

Show Flight Path  

Displays the target's route in the adaptation viewer with a target dynamics information box for 
selected Targets (see Section 7.3, “Show Flight Path”). 

Preview  

Invokes the Target Preview for selected targets (see Section 7.2, “Target Preview”). 

Replicate  

Opens the Replication dialog, which provides the ability to produce copies of the selected target. 
(see Section 3.3.4, “Replicate object”) 

Clear Replication(s)  

Clears all non-frozen replications, leaving only the original Target. 

4.10.3. Target Conflict Message 

Any modification to the target's beacon code that results in the conflict is reported and must be 
confirmed by the user. 

 
Continue  

Saves the target with a duplicate beacon code. 
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Cancel  

Closes the dialog and returns to the Target editor without applying the changes. 

4.11. ATCoach 

ATCoach section allows to maintain several types of ATCoach specific definitions, such as 
ATSpecialist Commands, Pilot Positions, Pilot Prompts, Pre-programmed Events (PPE), Scripted Radar 
Messages and Site Definitions. Each of these categories is contained under a separate list. Using these 
definitions, ATCoach can be better fined tuned and configured for specific needs in simulation. 

4.11.1. ATSpecialist Commands 

This section only allows to view ATSpecialist Command list that are available. The available list are 
extracted from adaptation and if present, from default site definition file, which can only be edited using 
Site Definitions Editor (see Section 6, “Site Definition Editor”). 

4.11.2. Pilot Position Editor 

Pilot Position Editor simply allows to assign a Pilot Position to a specific sector, which is controlled by a 
live person at Pseudo Pilot position during an exercise. Pilot Position can't be created or deleted. There 
are 20 available pilot positions that can be assigned to any available sector position. 

To edit a Pilot Position, click on the + sign next to the Pilot Prompts category object label in the object 
tree of the Scenario Editor Main Window to unroll pilot position list. Double-click on the desired pilot 
position to edit its assignment. 
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Position  

Pilot position. 

Sector  

Sector to be associated to a pilot position. 

4.11.3. Pilot Prompt Editor 

Pilot Prompt Editor allows to define Pilot Prompts, which can consist of any ATCoach command that 
can be manually triggered at the Pseudo Pilot position during an exercise. 

To create a Pilot Prompt, right-click on the Pilot Prompts category object label in the object tree of the 
Scenario Editor Main Window. Select New from the context menu. 
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Time  

Time the prompt is scheduled to appear. 

Address  

Address of the prompt. 
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RSI  

List of RSI descriptions for this message. Clicking 'Select' will open a scroll down menu 
allowing you to select the desired RSI. 

Text  

Prompt text. 

Command  

Any valid ATCoach runtime command (optional). 

 

Note 

Gsgt does not validate the content of any of the fields of the prompt. 

4.11.4. Preprogrammed Event (PPE) Editor 

Preprogrammed Event (PPE) Editor allows to define any ATCoach command that will be triggered 
automatically at a specific time during an exercise. 

To create a Preprogrammed Event, right-click on the Preprogrammed Events category object label in 
the object tree of the Scenario Editor Main Window. Select New from the context menu. 
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Time  

Time of the Preprogrammed Event (optional). 

RSI  

List of RSI descriptions for this preprogrammed event. Clicking 'Select' will open a scroll down 
menu allowing you to select the desired RSI. 
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Text  

ATCoach command. 

 

Note 

Gsgt does not validate the content of the text field of the PPE. 

4.11.5. Scripted Radar Messages 

The editor allows to create and edit ATCoach RM (Radar Messages) that will be injected in addition to 
automatically generated messages. The messages defined here are exported into a separate scenario file 
and in special way to allow preservation of ECG bits in the messages. 

4.11.6. Site Definitions Editor 

The Site Definitions Editor allows to define site definitions that will be copied directly into the 
ATCoach Site file. There are several types of site definitions that can be created. Depending on the type 
an appropriate dialog is used to edit the site definition. Some of the site definitions also aid in building 
the target trajectory such as Points, Macro Routes and Runways. 

To create a Site Definition, right-click on the Site Definitions category object label in the object tree of 
the Scenario Editor Main Window. Select from the options depicted below on the context menu. 

 
4.11.6.1. Generic Site Definitions Editor 

The generic Site Definition can essentially be of any type. Definitions that are properly formatted upon a 
subsequent editing are open in a default site definition editor, such as Runway, Arrival Procedure or 
Published Holding Pattern editors, to name a few. The generic Site Definition Editor is simply an open 
text command editor that allows the user to define any site definition. GSGT does not provide any 
format guidance or does not validate the content of the site definition. 

To create a generic Site Definition, right-click on the Site Definitions object label and select New from 
the context menu. 
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4.11.6.2. Point (PT) Site Definition Editor 

Point site definition editor defines a point in space that is any point within the viewing area to which an 
aircraft can navigate such as RNAV waypoints, runway thresholds, track drop points, handoff points, 
and points related to a traffic pattern. The editor allows the user to easily create a properly formated 
definition by validating content fields and providing a visual guidance on the GSGT map. A point is 
defined by three to nine character identifier and a lat/lon position.  

To create a Point site definition, right-click on the Site Definitions object label and select New Point 
(PT) from the context menu. 

4.11.6.3. Macro Route (RT) Site Definition Editor 

Marco Route site definition editor defines a route of navigable flight path. They are identified by route 
segments such as navaids that include procedures (speed/altitude) and fixes. The editor allows the user 
to easily create a properly formated definition by validating content fields and providing a visual 
guidance on the GSGT map. The fixes can be manually typed in as text or selected by point and click 
form the GSGT map in a similar matter as in the route of the target (see Section 4.10.1.2, “Target 
Route”). 

To create a Macro Route site definition, right-click on the Site Definitions object label and select New 
Macro Route (RT) from the context menu. 

4.11.6.4. Runway (RW) Site Definitions Editor 

Runway site definition editor defines a runway that can be used for instrument approaches and 
departures. The editor allows the user to easily create a properly formated definition by validating 
content fields and providing a visual guidance on the GSGT map.  

To create a Runway site definition, right-click on the Site Definitions object label and select New 
Runway (RW) from the context menu. 
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Airport  

ICAO identifier of the airport that the runway serves. 

Runway  

Standard identifier of runway created from runway direction and side. 

Threshold  

Runway threshold location in latitude and longitude. 

Threshold alt (feet)  

Runway threshold altitude or minimum decision height. 
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Inbound hdg  

Inbound heading to the runway in degrees. 

Length (feet)  

Runway length in feet. 

Approach fix position  

Final approach fix location. 

Approach fix altitude (ft)  

Final approach fix altitude. 

Gate altitude (ft)  

Altitude to be used at the approach gate. 

Glideslope (degrees)  

The angle of the glideslope in degrees. 

Display Center Line  

The option to display the runway extended centerline. 

Start (nmi)  

This parameter is optional. The distance from the runway threshold where the extended 
centerline begins. The default is 1 NM. 

End (nmi)  

This parameter is optional. The distance from the runway threshold where the extended 
centerline ends. The default is 22 NM. 

4.11.6.5. Departure Profile (DP) Site Definitions Editor 

Departure Profile site definition editor defines a set of maneuvers the target will perform before turning 
to the first fix on its route. The editor allows the user to easily create a properly formated definition by 
validating content fields. 

To create a Departure Profile site definition, right-click on the Site Definitions object label and select 
New Departure Profile (DP) from the context menu. 
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Airport  

The airport used for this profile. 

Runway  

The runway used for this profile. 

Alt (hundreds of ft)  

Initial altitude propeller/jet aircraft will climb to. 

Hdg (degrees)  

Initial or forced heading for propeller/jet aircraft on departure. 
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Speed (k)  

Indicated speed to which propeller/jet aircraft will accelerate. 

4.11.6.6. Non-ILS Arrival Procedure (AI) Site Definitions Editor 

Non-ILS Arrival Procedure site definition editor defines a non-ILS approach that is in the format of an 
Instrument Approach Clearance-stockpile. The editor allows the user to easily create a properly 
formated definition by validating content fields and providing a visual guidance on the GSGT map. The 
fixes can be manually typed in as text or selected by point and click form the GSGT map in a similar 
matter as in the route of the target (see Section 4.10.1.2, “Target Route”). When a fix is selected a Value 
Editor is open for user to specify optional Altitude and Speed at the current fix. However, other 
conditions need to be manually typed in. 

To create a Non-ILS Arrival Procedure site definition, right-click on the Site Definitions object label 
and select New Non-ILS Arrival Procedure (AI) from the context menu. 
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Approach Type  

The type of approach to be modeled. 

Airport  

The airport to which the approach will be flown. 

Runway  

The runway for which the approach is modeled. 
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Route  

The route includes the procedures to be followed. Within the route, any Navaids, intersections, 
points in space, etc. may be used as long as they are listed in the site file. The fix symbol format 
and heading fix functionality may also be used. 

4.11.6.7. Missed Approach Procedure (AM) Site Definitions Editor 

Missed Approach Procedure site definition editor defines a missed approach procedure for either all 
approach types or a specific approach type (e.g., GPS, VOR). The editor allows the user to easily create 
a properly formated definition by validating content fields and providing a visual guidance on the GSGT 
map. The fixes can be manually typed in as text or selected by point and click form the GSGT map in a 
similar matter as in the route of the target (see Section 4.10.1.2, “Target Route”). When a fix is selected 
a Value Editor is open for user to specify optional Altitude and Speed at the current fix. However, other 
conditions need to be manually typed in. 

To create a Missed Approach Procedure site definition, right-click on the Site Definitions object label 
and select New Missed Approach Procedure (AM) from the context menu. 
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Approach Type  

The type of approach to be modeled. 

Airport  

The airport to which the approach will be flown. 

Runway  

The runway for which the approach is modeled. 
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Route  

The route that includes the missed approach path to be followed. Within the route, any Navaids, 
intersections, points in space, etc. may be used as long as they are listed in the site file. The fix 
symbol format and heading fix functionality may also be used. 

Holding Pattern  

Holding pattern to be flown after execution of the route portion. 

4.11.6.8. Published Holding Pattern (HP) Site Definition Editor 

Published Holding Pattern site definition editor defines procedure that keeps an aircraft within specified 
airspace awaiting further clearance from Air Traffic Control. The editor allows the user to easily create a 
properly formated definition by validating its content fields. 

To create a Published Holding Pattern site definition, right-click on the Site Definitions object label and 
select New Published Holding Pattern (AI) from the context menu. 
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Holding Pattern Name  

The name identifier of the holding pattern. 

Holding Location  

The location of the hold as a fix or lat/lon location. 

Leg Length  

The leg length specified in minutes or miles. 

Radial  

The inbound radial toward or into the holding pattern specified in degrees. 
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Direction of Turns  

The direction of turns on the holding pattern. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 144   

5. Weather Editor 
The weather scenarios can be included in GSGT scenarios to provide more realistic simulation. They are 
created using GSGT Weather Editor, which is a part of GSGT distribution. The Weather Editor closely 
resembles the Scenario Editor, however it is only designed to create and edit weather scenarios. Weather 
scenarios and regular scenarios are saved in different paths, so they may have exactly the same names. 
However it is recommended to use different names to be able to distinguish them easily. 

The GSGT Weather Editor is executed using the same executable as GSGT but with option "-w". The 
exact location of the executable can vary depending on the installation and environment. 

 

Example 3. Start GSGT in Weather Editor Mode 

To execute GSGT version 7.5.10.0 that has been installed to the default location, type: 

> /usr/local/gsgt.7.5.10.0/bin/gsgt -w 
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Note 

Starting GSGT Weather Editor from a command line while inside the scenario directory will 
automatically open that scenario. 

GSGT in weather editor mode, by default, does not display any adaptation information because it's not 
adaptation specific, meaning it does not require an adaptation for creating or editing weather patterns. 
However, it allows to load adaptation so the user has a better visual reference but the adaptation is not 
saved with scenario.  

To load adaptation select File->Load Adaptation from the Weather Editor Main Window. 

The adaptation selection is performed in same matter as when selecting adaptation for regular scenario 
(see Section 3.1.2, “Adaptation Selection”). Multiple adaptations can be selected to better aid creation of 
weather patterns. Once the adaptation is loaded it may not be changed to a different adaptation during 
the same session. To change adaptation, close the editor and restart to select a different adaptation. 

 

Note 

The weather scenario are defined on a national grid, in other words weather patterns are defined on 
a national scope. A single weather scenario can be used by many site specific scenarios that in turn 
will use only a specific sub grid of the national weather. 

Since weather scenarios can be included into multiple GSGT scenarios they are included as read-only 
and can't be modified from within a regular scenario. Also since they are shared, any change in the 
weather scenario will affect all scenarios that use that particular weather scenario. 

5.1. Basics 

5.1.1. Weather Time Slice Windows 

Weather scenario can consists of multiple time slices. Time slices can only be defined during initial 
creation of weather scenario. The beginning time of the time slice is displayed in the title bar of the 
window or in the main title bar if the window is maximized. 

Every time slice in the weather scenario is contained in it's own editor window and each of these 
windows can be separately adjusted to view maps and different types of weather. Additionally changing 
the stratum allows to view the different wind and temperature values for a particular level. Stratum can 
be specified in pressure altitude (millibars or mb) or in flight level (FL). Changing stratum does not 
effect the preview of pressure or precipitation. Only wind and temperature may have different values at 
different stratum levels.  
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Table 12. Weather Types 

Event Description 

Wind It's depicted by WHITE vectors indicating heading, and length indicating speed. Default 
speed and heading is 0  

Temperature  
It's depicted by gamma colors (blue being cold, red being hot) outlined every 10 degrees. 
Default temperatures vary by stratum. For example default temperature at 1000mb is 57.7 
F and at 100mb it is -69.70 F. 

Pressure  It's depicted by red and blue intensity colors, where red is high and blue is low pressure. 
The default pressure is 1013.25mb.  

Precip  It's depicted by intensity in colors (blue, green, yellow, red, purple and white) ranging 
from light to most severe precipitation.  

 

To preview weather, from the Wx window menu select View->Wx->”time slot”. This opens a list of 
weather views (Wind, Temperature, Pressure, and Precip). Select desired weather types to be viewed by 
repeating this step as necessary. To remove wx data from the display select View->Wx->None.  

 
View  

The pull-down menu is used to select weather data and map data for background display. The 
background functions may be displayed individually or in combination. 

Maps  
US Map (BLUE) 
ARTCC Map (ORANGE) 
Canada (BLUE) 
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Mexico (BLUE) 
Wx  
None - toggles off all weather 
Time Slice with weather types as sub menu. 
[Center Name]  
This menu is available after loading adaptation and allows to display adaptation data (see 
Section 2.3.1, “Adaptation Window”) 

Altitude  
Flight Level mode - Altitude in hundreds of feet 
Pressure Altitude mode - Altitude in millibars of pressure. Each pressure level corresponds 
directly to one of 37 RUC layers. (1000 mb is sea level, lower values indicate higher elevations) 

Tools Toolbar  

Contains tools for selecting and editing weather values 

Pick Tool  

Tool used for activities such as repositioning/centering map display, rubber band zoom, weather 
cell info 

moving map - Use left mouse button click and drag to move the map display 
centering map - Use left mouse button click while holding Ctrl key. This will reposition display 
so that the point on the map where mouse click occurred will be positioned in the center of 
display. 
rubber band zoom - Use left mouse button click and drag while holding Ctrl and Shift keys. 
This will draw a rectangular area representing the zoom detail after the mouse button is released. 
weather cell info - Use right mouse click to display weather pattern information, such as 
temperature, pressure and winds in and particular point on the weather grid. The information is 
displayed in the status bar on the bottom of the display view. 
adaptation info - If the adaptation is loaded in the view, use right mouse click to display 
adaptation specific information such as FAV. This works in same fashion as in general GSGT 
Editor. 
Measurement tool  

Tool used for displaying distance between two points on the map, heading and lat/lon location. 
The information is displayed in the status bar on the bottom of the display view. Use left mouse 
button click and drag to display measurement between two points. 

Edit RUC  

Opens RUC Editor toolbar, where temperature, pressure and/or winds values can be applied to 
selected cells. 
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Flood Fill Temperature  

When a single cell is selected, the flood fill sets all continuous cells of the same value to the new 
value specified in the temperature field in RUC editor toolbar. 

Flood Fill Pressure  

When a single cell is selected, the flood fill sets all continuous cells of the same value to the new 
value specified in the pressure field in RUC editor toolbar. 

Edit Precip  

Opens Precip Editor toolbar, where precipitation values can be applied to selected cells. 

5.1.2. Weather Information 

Information for the existing RUC weather (Temperature, Pressure and Wind) is displayed in the status 
bar using a right mouse click on any specific point on the map. The information for each cell includes 
temperature, pressure, and wind speed and direction. 

5.1.3. Viewer Configuration 

Weather scenarios are created with predetermined size of the viewer that covers continental US. To 
adjust zoom (Scale), location (Reference) and size (Width and Height) of the viewer select File->Edit 
Viewer Config from the Weather Editor Main Window. 

 

Note 

The change is applied to all time slices and viewer is restarted. Make sure to save scenario changes 
before editing viewer configuration. 

Width  

Width of the working size of the viewer in nautical miles centered at Reference point. 

Height  

Height of the working size of the viewer in nautical miles centered at Reference point. 

Scale  

Scale determines the maximum zoom-out of the display viewer. Working size of the viewer 
(Width/Height) is not affected. Increasing the Scale, zooms-in and decreasing Scale zooms-out 
the maximum view. 

Reference  

Reference point is the center of display viewer  
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5.2. Create new weather scenario 

A New Weather Scenario Wizard allows selection of scenario name and weather time slices to be 
defined in the new scenario. Newly created weather scenario includes standard temperature and 
pressure, zero wind and no precipitation. 

To create a new scenario, select Scenario->New from the Weather Editor Main Window. 

The wizard allows a back and forth navigation through pages of the wizard allowing the user to return to 
previous screen to modify any options before pressing Finish button. 

Back  

Goes to the previous screen. 

Next  

Goes to the next screen. 

Finish  

Completes scenario wizard and creates a new scenario according to selected options.. 

Cancel  

Quits the scenario wizard without creating a new scenario.  

5.2.1. Location and Name 

The selection of a name and location for new a weather scenario is identical as in the new GSGT 
scenario (see Section 3.1.3, “Location and Name”) with the difference that weather scenario are saved in 
a different location. The location of weather scenarios is controlled by $WX_PATH environment variable. 
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5.2.2. Weather Time Slices 

To add a time slice to a weather scenario, use the up/down arrows to select time slice hour, then click 
Add Time. Weather scenario may include multiple time slices. Add desired number of time slices for 
every hour before pressing Finish button. Time slices can't be easily added after weather scenario is 
created. 
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Precip Cell Size  

Size (in square miles) of precipitation cells. Range is 1-8. 

Precip Cell Size is referring to the size of the cells displayed on the MDM in square miles. The 
selectable value range is 1-8 square miles but while using 1 gives a more realistic view on the 
MDM, it also creates a huge precip0.txt file containing hundreds if not thousands of messages 
which are included in the main GSGT scenario. ATCoach will only process 600 weather cells 
and discard the remainder to manage processor utilization. Using larger weather cells allow 
larger geographical areas to be covered. Selecting 8 creates a smaller file, but the display shows 
weather "blocks" – 8 sq. mile boxes depicting precipitation areas.  

Times  

List of hourly time slices to include in the scenario. 

Add Time  

Adds desired time slice (as selected in Hour filed) at which weather should be injected into the 
scenario by setting time using up/down arrows. The only allowable time slices are in 1 hour 
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increments. Defined time slices are displayed in the list. To delete unwanted time slice, right 
click on that particular time in the list and select Delete. 

Repeat this as many times as needed to create all time slices at which the weather should be 
injected, selecting a single time slice or multiple time slices for injection. Rethink how long 
weather scenario needs to be and include a time slice for each hour. Once the weather scenario is 
created, the additional time slice is difficult to add as it requires a manual edit of the scenario 
files.  

5.3. Open existing weather scenario 

Weather scenarios are opened in similar matter as regular scenarios (see Section 3.2, “Open existing 
scenario”), however depending on the GSGT mode, a different scenario path location is used to list 
existing scenarios. Scenarios must be open in appropriate GSGT mode, therefore a Weather Editor needs 
to be used to open a weather scenario, otherwise scenario will not open correctly. 

5.4. Edit weather scenario 

To edit a weather attributes, preview desired weather type from the View menu to aid selection and view 
changes. Also select desired Flight Level (or pressure altitude) from the menu bar, as temperature and 
wind may be different at different altitudes. 

To make changes to any of the weather patterns, open the appropriate editor. Temperature, pressure and 
wind are modified using RUC editor, while precipitation is modified using Precipitation Editor. 

5.4.1. RUC Editor  

To start editing RUC (Temperature, Pressure and Wind) select Edit RUC icon from the Tools toolbar. 
The editor opens docked on the right side of the screen and may be repositioned on the screen if needed 
by grabbing its selection bar. Also while the editor is open, Pick Tool and Measurement Tool can be 
enabled for additional aid without closing the editor. To exit edit mode, use Close button on the editor 
dialog. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 153   

 
Auto populate  

While auto populate is turned on, the editor dialog will be populated with the weather values 
from the cells being selected. When multiple cells are selected, the values from the first selected 
cell are used to populate the dialog. 

Layer  

The Strata layers that the new Temperature and Wind values will be applied to. 

Temperature and Wind have separate values for each RUC layer. The list displays 37 layers with 
corresponding range of altitudes. A single or multiple layers can be selected at once to apply a 
specific value.  
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Weather Types  

The values for each of the weather types can be applied individually or in combination by 
enabling or disabling individual weather types. 

While in RUC edit mode, use left mouse click and drag to draw a loop around the desired area to edit the 
weather values. Additional cells may be selected by holding Ctrl button and selecting additional area 
using left mouse click and drag or by right mouse click on desired cell. A right mouse click on a cell 
clears previous selection and selects a single cell. Also a left mouse click clears current selection. 

 

One of the tools in RUC editor is ability to flood fill a contiguous area of the weather with the same 
value based on a single cell selection. To apply flood fill, select a single cell and fill in desired value for 
temperature or pressure, and press appropriate icon on the Tools toolbar, for ether temperature or 
pressure. To aid selection and preview, enable appropriate weather type in the view. 

5.4.1.1. Temperature 

Temperature values can be specified in several temperature scales, such as Fahrenheit, Celsius or 
Kelvin. The default is Fahrenheit, to specify Celsius append C or for Kelvin append K after temperature 
value. Also different temperature values can be specified at a different stratum layers. 
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5.4.1.2. Pressure 

Pressure values are specified in millibars (mb) units of pressure. The "standard" sea level pressure is 
1013.25 mb. The range of pressure is 100 mb - 1100 mb. Only a single pressure value can be specified 
for all stratum levels. 
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5.4.1.3. Wind  

Wind values can be specified in several ways, such as speed and heading, U and V components, or X 
and Y components depending on type of the input format selected. Also different wind values can be 
specified at a different stratum levels. 

The Speed and Heading input format defines wind speed in knots and heading in degrees. Depending on 
selected option Use X/Y coords, the wind values are aligned to true north (when turned on) or to RUC 
grid (when turned off) 

The Vector component input format defines wind using X/Y or U/V vectors in meters/sec. Depending 
on selected option Use X/Y coords, the wind values are aligned to true north (when turned on) or to 
RUC grid (when turned off). The X/Y vectors are aligned to the true north, where X is E/W component 
and Y is N/S component. The U/V components are aligned to RUC grid, where U corresponds x axis of 
the grid plane and V corresponds the y axis of the grid plane.  

 

Note 
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When option Use X/Y coords is not set, the relative orientation of the axis does not correspond to 
true north orientation (North-South / East/West) due to the fact that RUC #236 grid is represented 
using lambert conformal projection with offset focal point. That is the projection focal point is not 
on an axis passing through the two geographic poles and grid plane axes do not follow constant 
latitude and longitude lines. 

When option Use X/Y coords is set, the orientation values are converted from True North to RUC 
grid orientation specific to location on the grid. RUC #236 grid data is always represented using 
lambert conformal projection regardless of input orientation. 

 

Vector lines on the map represent wind direction and speed: longer lines representing higher wind 
speeds, shorter lines representing lower wind speeds. 

Wind affects precipitation areas, causing them to drift and morph much as real weather is affected by 
winds aloft. Precipitation is only affected when winds are defined at the 1000mb layer. Adding wind 
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values to specific layers also affect aircraft performance for targets at a particular level causing them to 
slow down in a head wind and speed up with a tail wind. 

5.4.2. Precipitation Editor 

To start editing precipitation select Edit Precip icon from the Tools toolbar. The editor opens docked on 
the right side of the screen and may be repositioned on the screen if needed by grabbing its selection bar. 
Also while the editor is open, Pick Tool and Measurement Tool can be enabled for additional aid 
without closing the editor. To exit edit mode, use Close button on the editor dialog. 

 
Auto populate  

While auto populate is turned on, the editor dialog will be populated with the precipitation values 
from the cells being selected. When multiple cells are selected, the values from the first selected 
cell are used to populate the dialog. 

Strata  

The Strata levels in 500 ft increments that the new precipitation values can be applied to. When 
no starta is selected the precipitation values are not tied to specific strata. 
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dbZ  

The value of intensity of precipitation. 

velocity  

The speed and direction of moving precipitation. The values can be input in several formats as 
well relative to true north or precip grid. The orientation precip direction is based on the same 
projection as winds (see Section 5.4.1.3, “Wind ” ). The values applied here take precidence over 
RUC wind values for defining moving precipitation. 

update existing precip only  

When this option is selected the new precipitation values will only be applied to existing 
precipitation definitions. 

While in Precip edit mode, use left mouse click and drag to draw a loop around the desired area to edit 
the weather values. Additional cells may be selected by holding Ctrl button and selecting additional area 
using left mouse click and drag or by right mouse click on desired cell. A right mouse click on a cell 
clears previous selection and selects a single cell. Also a left mouse click clears current selection. 

5.4.2.1. Precipitation  

Precipitation value is specified in decibels (dbZ) units of precipitation and range from 0-99. This 
determines the intensity of the precipitation cell that was selected. The "default" precipitation in new 
scenario is 0 - no precipitation. Additionally precipitation can be specified with a velocity using the 
same input format as Wind in RUC editor (see Section 5.4.1.3, “Wind ” ). 
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Precipitation level can also be specified by one of the preset levels Low - High (L, LM, M, MH, H). For 
additional reference below tables can be used to specify precipitation intensity for specific radar type. 

Table 13. ASR Precipitation Levels 

Level Description 
9 – 29 level 1  
30 – 40 level 2  
41 - 45 level 3  
46 - 49 level 4 
50 - 56 level 5 
57 + level 6 
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Table 14. ARSR Precipitation Levels 

Level Description 
10 – 29 light-mod precipitation  
30 – 49 mod-heavy precipitation  
50 +  extreme precipitation  
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6. Site Definition Editor 
The Site Definitions Editor mode closely resembles the Scenario Editor, however it is designed only to 
create and edit ATCoach site definitions that can be shared by all training scenarios. Although the editor 
allows to create and edit multiple site definition files, only the default site definition file (atcoach.xml) 
can be shared. The location where shared site definition files are stored is controlled by environment 
variable $GSGT_SITE_DEFAULTS. 

The shared site definitions file is automatically loaded by all training scenarios when GSGT is started in 
Training Mode (see Section 2.2.2, “GSGT Modes”). The site definitions loaded from shared file are 
included in the scenario as read-only and can't be modified or deleted.  

The GSGT Site Definitions Editor is executed using the same executable as GSGT but with option "-s". 
The exact location of the executable can vary depending on the installation and environment. 

Example 4. Start GSGT in Site Definition Editor Mode 

To execute GSGT version 7.5.10.0 that has been installed to the default location, type: 

> /usr/local/gsgt.7.5.10.0/bin/gsgt -s 

 

The main window of the Site Definitions Editor is very similar to the main window GSGT running in 
normal mode. It also allows to load an adaptation while editing site definition files to guide the user 
when creating site definitions. On AIX distribution, it requires to load adaptation before editing the site 
definitions. 
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6.1. Load adaptation 

Site Definitions Mode has an option to load adaptation to provide guide for the user to construct valid 
definitions. The selected adaptation is not saved with site definitions file so every time the editor is 
started in this mode the user needs to select a desired adaptation. 

To load adaptation select File->Load Adaptation from the Site Definition Editor Main Window. 

The adaptation selection is performed in same matter as when selecting adaptation for regular scenario 
(see Section 3.1.2, “Adaptation Selection”). Multiple adaptations can be selected to better aid creation of 
site definitions. Once the adaptation is loaded it may not be changed to a different adaptation during the 
same session. To change adaptation, close the editor and restart it to select a different adaptation. 

6.2. Create new site definition file 

The editor allows to create multiple site definitions files, however only the default, atcoach.xml, file is 
used for sharing site definitions among all training scenarios. The default file is automatically loaded by 
all training scenarios, and it's contents appears as read-only. The contents of this file can be modified 
only by the Site Definitions editor. 
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To create a new site definitions file, select File->New Site Definitions from the Site Definition Editor 
Main Window. 

6.3. Open existing site definition file 

The editor allows to edit multiple site definition files, but only one file can be open at a time. Note that 
only the default site definitions file, atcoach.xml, is used for sharing site definitions among all training 
scenarios.  

To open a site definitions file, select File->Open Site Definitions from the Site Definition Editor Main 
Window. 

 

6.4. Edit site definitions 

The editing of individual ATCoach Pilot Positions, Pilot Prompts, Pre-Programmed Events and Site 
Definitions objects is identical to editing of the ATCoach site definition while running in Normal Mode 
(see Section 4.11, “ATCoach”).  

To open Scenario editor to edit site definitions, select File->Edit Site Definitions or Edit toolbar button 
from the Site Definition Editor Main Window. 
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6.5. Save site definition file 

After making changes in the site definitions, the file needs to be saved. The editor allows to save the site 
definitions under a new file or overwrite the existing file. Every time the definitions are saved user needs 
to select a file where they should be saved. Note that GSGT will always use the default file 
atcoach.xml in the save dialog. 

To save current changes, select File->Save Site Definitions or Save toolbar icon from the Site 
Definition Editor Main Window. 
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7. Preview 
The Preview function provides a dry-run simulation capability in GSGT, where user can visually 
examine targets defined in the scenario in a time based environment. There are several types of preview 
functions in GSGT tailored for specific needs. Full Preview, which simulates the entire scenario, Target 
preview, which simulates any selected number of targets, and Show Flight Path, that allows to preview 
targets for fine tuning its parameters while in edit mode. 

When Full Preview or Target Preview is invoked, a dialog is presented to select options for the preview, 
such as the time to at which to start the preview. This is helpful particularly when scenario is several 
hours long but user wants to preview the last hour of the scenario. Instead of running through the entire 
scenario from the start, preview can start at any specific time between the start and end of the scenario. 

 
Start Time  

Select the time to start the Preview. 

Display Datablocks  

When selected targets in preview will have datablocks with their callsign, heading, speed and 
altitude. 

Movable Datablock  

When selected, and Display Datablocks is selected, the datablock can be moved on the display 
using left mouse click and drag. 

Display Noise Targets  

When selected the noise targets will also be displayed in the preview. 
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OK  

Begins Preview Mode, starting at the specified Start Time. 

Cancel  

Cancels Preview Mode. 

When GSGT is using ATCoach engine and preview is initiated, GSGT will export all scenario 
information to the ATCoach engine so that it can generate all the target information and derive messages 
for the scenario. This may take several minutes, during which time all program input is disabled until 
ATCoach returns the position data. 

7.1. Full Preview 

Full Preview, also known as Scenario Preview, invokes preview that simulates entire scenario, with all 
targets displayed at their appropriate time in simulation. Preview also allows to display messages that 
are included with the targets that appear along it's route corresponding to the time at which they would 
be injected by simulation. The target data blocks and displayed messages can be moved using left mouse 
click and drag to unclutter any particular feature on the display. 

To open a Full Preview, select Preview->Full Preview from the GSGT Main Window. 
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When Full Preview or Target Preview is invoked, the standard toolbar is replaced with preview toolbar 
for controlling the preview. The controls include the ability to start, pause and step through the preview. 
Additionally the preview can be run at a variable speed from 1 (real time) to 60 (1 minute of the sim = 1 
second wall clock). 

Done  

Stops the preview and returns to normal edit mode. 

Run/Pause  

Starts/pauses the preview. After the preview begins, the Run button changes to Pause. Clicking 
on Pause after the preview begins will pause the preview without closing the window. The 
button will then change back to Run and subsequent selection of the Run button resumes the 
preview from where it was paused. 

Step  

Steps through the preview at time intervals of Speed value. 
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Speed  

Specifies the preview rate relative to time in seconds. Valid range is 1-20 (1-60 in the HCS 
version) scenario seconds per real time second. 

Time  

The elapsed time of the preview - current scenario time. 

Targets can be highlighted using right mouse click on a target, which toggles the display of route of the 
selected target depicted using BLUE fixes connected by RED lines between fixes and GREEN lines 
between segments along the airways. In addition a context box is displayed with target's details such as 
its current position, speed, heading and altitude. Optionally all non-radar messages associated with the 
target can be previewed on it's route, which are placed at position corresponding to the time when the 
messages are injected. 

To preview messages associated with the target, select Links button from the target context box and 
select Show Messages. Messages can be moved on the display using left mouse click and drag to 
unclutter any part of the display. 

7.2. Target Preview 

The Target Preview is essentially the same as Full Preview with exception that Target Preview is 
invoked only for selected targets out of the entire scenario. This is helpful if the scenario includes large 
number of targets and executing a Full Preview is inefficient. Target preview can be invoked on any 
number of targets ranging from single target to all targets in the scenario. 

To start preview for any particular set of targets, from the Scenario Editor window, select single target 
or group of targets using SHIFT or CTRL keys and left mouse click. Then right mouse click on the 
selected targets to open a context menu and select Preview. 

7.3. Show Flight Path 

The Show Flight Path function enables to preview targets while editing the scenario. Every target in this 
mode is previewed independently of other targets and can be moved back and forth along it's preview. 
There are no controls to start or pause the preview. The preview is simply done by mouse dragging the 
airplane along its route. 
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While target is displayed in Show Flight Path preview, its route is displayed in the same fashion as when 
target is highlighted in Full or Target preview, using BLUE fixes connected by RED lines between fixes 
and GREEN lines between segments along the airways. Additionally the targets actual route, which 
corresponds to radar positions, is displayed using GREEN plus symbols. Target's actual route will 
reflect target events such as holds or heading changes. Also a context box is displayed with target's 
details such as its current position, speed, heading and altitude and it's constantly updated when target is 
dragged along its route. This provides target's details at a particular point in space and time in preview. 
When the dialog is closed or user right mouse clicks on the target, the target exist the Show Flight Path 
preview. 

To start a Show Flight Path preview for any set of targets, from the Scenario Editor window, select 
single target or group of targets using SHIFT or CTRL keys and left mouse click. Then right mouse 
click on the selected targets to open a context menu and select Show Flight Path. 

7.4. Dynamic Simulation (DYSIM) 

The Dynamic Simulation is similar to Full Preview with exception that it's simulated at a real time speed 
and that simulates targets on the fly and send simulation data directly to SDRR for simulation. The 
targets in the dynamic simulation can be controlled by issuing events to control various aspects of their 
attributes and flight trajectory.  

To open a Dynamic Simulation, select Preview->DYSIM from the GSGT Main Window. 
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Start Time  

Select the time to start the dynamic simulation. 

Receiver  

The machine that should receive the simulation data, the SDRR. 

Auto TA Mode  

Option to automatically accept transfer requests. 

Live Facilities  

List of facilities that can be set as live. 

OK  

Enters simulation mode, but simulation does not start. 

Cancel  

Cancels simulation. 

When Dynamic Simulation is invoked, the standard toolbar is replaced with simulation toolbar for 
controlling the simulation. The controls include the ability to start and pause the simulation. The 
simulation can only be running at a real time speed. 
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Done  

Stops the simulation and returns to normal edit mode. 

Run/Pause  

Starts/pauses the simulation. After the simulation begins, the Run button changes to Pause. 
Clicking on Pause after the simulation begins will pause the simulation without closing the 
window. The button will then change back to Run and subsequent selection of the Run button 
resumes the simulation from where it was paused. 

Time  

The elapsed time of the simulation - current scenario time. 

Targets can be highlighted using right mouse click on a target, which toggles the display of route of the 
selected target depicted using BLUE fixes connected by RED lines between fixes and GREEN lines 
between segments along the airways. In addition a Dynamic Simulation Dialog window is displayed 
with target's commands and messages contained in the tabs. Also details such as its current position, 
speed, heading and altitude are displayed on the bottom of the window. Target can be dynamically 
controlled by sending commands to change its attributes and target's trajectory. The interfacility 
messages can also be dynamically manipulated by changing its contents or timing to be sent at user's 
discretion. 
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8. Import Functions 
GSGT includes functionality to import data from several different sources such as GSGT scenarios, 
NAS SIM, DYSIM, Host and ERAM SAR, RTF, and TGF.  

Import can be performed into a currently open scenario. Before starting Import process, user must create 
a new scenario or open an existing scenario. 

8.1. Import GSGT Scenario 

The GSGT Scenario import functionality enables the user to import an already existing GSGT scenario 
into the current scenario, in whole or in part. 

To start import process select Import->Gsgt Scenario from the GSGT Main Window. 

Select the gsgt scenario to import into current scenario.  
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Back  

Disabled in this window. 

Finish  

Opens the selected scenario. 

Cancel  

Closes the window and cancels the import scenario action. 

After selecting a scenario, the following dialog is presented which allows the user to select the elements 
from the scenario to import. The first page allows the selection of Equipment, Radars, Service Volumes, 
DataComms, and AChars. 

 

The second page allows the selection of RSIs, Targets and System Commands. 
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Back  

Returns to previous page of the import dialog. 

Next  

Advances to the next page of the import dialog. 

Cancel  

Closes the scenario import dialog. 

The third page allows the selection of ATCoach Prompts, Preprogrammed Events, Pilot Positions, 
Scripted Radar Msgs and Site Definitions. 
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Back  

Returns to previous page of the import dialog. 

Next  

Advances to the next page of the import dialog. 

Cancel  

Closes the scenario import dialog. 

The fourth page allows the selection of user defined maps. 
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Back  

Returns to previous page of the import dialog. 

Finish  

Imports the selected items into the current scenario. 

Cancel  

Closes the scenario import dialog. 

After import is complete a message box is presented to review status of import and errors during parsing 
or opening of the selected scenario. 

8.2. Import NAS Simulation 

The NAS SIM import functionality provides ability to import NAS simulation into GSGT. 

To start import process select Import->NAS Sim from the GSGT Main Window. Then using the dialog, 
select a file containing the NAS SIM that you wish to import. The import allows to specify only a single 
file, so in order to import entire simulation, append all the NAS SIM source files into a single file. The 
reason for this is that import of NAS simulations requires all the CARDS that are required by NAS SIM. 
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Status and completion messages are shown in GREEN. Warnings are shown in YELLOW. Errors are 
shown in RED. When the import has completed, the total number of messages and targets added will be 
listed. 

 

Equipment will initially be based on the devices imported from ACES. Any device definition provided 
in NAS simulation input (EQUIP) overrides a device of the same name previously defined by GSGT; 
devices in addition to those previously defined will be added. Any radar site information 
(RSITE/CSITE) is included in the equipment definitions and therefore follows the same rules. Any 
modify (MODFY) cards that are encountered will have the effect of modifying the previously defined 
device. Change equipment cards (CHEQP) will be included in the equipment file as equipment entries, 
containing the new values; they will become effective at the original time of entry.  

When a MULTI card in encountered the specified data expansion will be preformed, the resulting card 
images will be represented as actual messages and/or flights. Comment and Expect cards are associated 
with the flight preceding them. Comments before the first flight will be associated with the simulation 
itself. Control cards (CONTL) will be imported and reflected as GSGT RSIs (Record Select Indicator) 
values. 
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8.3. Import DYSIM 

The DYSIM import functionality enables the user to import DYSIM simulation into GSGT. The user 
needs to append all the DYSIM source files into a single file and then secure copy (scp) or FTP the 
appended file onto the GSGT machine. 

To start import process select Import->DYSIM from the GSGT Main Window. Then using the dialog, 
select a file containing the DYSIM scenario that you want to import. 

Status and completion messages are shown in GREEN. Warnings are shown in YELLOW. Errors are 
shown in RED. When the import has completed, the total number of messages and targets added will be 
listed. 

 

8.4. Import NAS SAR 

The SAR import functionality enables the user to import scenario related information (i.e., targets, 
messages, adaptation items, events, etc.) from SAR data into a GSGT scenario. Upon selecting the 
import SAR data function, the user is presented with a dialog to provide the location of the binary SAR 
data file. 
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Note 

NAS SAR Import function is available in HCS version only. 

To start import process select Import->SAR Data from the GSGT Main Window. Then using the 
dialog, select the NAS SAR data file that you want to import. The files are usually named with aws 
extension. 

When the import is complete, a report listing the details of the import is displayed. Status and 
completion messages are shown in GREEN. Warnings are shown in YELLOW. Errors are shown in 
RED. 
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8.5. Import ERAM SAR 

The SAR import functionality enables the user to import scenario related information (i.e., targets, 
messages, adaptation items, events, etc.) from SAR data into a GSGT scenario. Upon selecting the 
import SAR data function, the user is presented with a dialog to provide the location of the binary SAR 
data file. 

 

Note 

ERAM SAR Import function is available in ERAM version only. 

To start import process select Import->SAR Data from the GSGT Main Window. Then using the 
dialog, select the ERAM SAR file that you want to import. And using the second dialog, select the 
FDSWAC adaptation file which contains SAR Gate information. 

When the import is complete, all imported targets will be listed. The total number of targets added to the 
scenario will be shown at the end of the report. 
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8.6. Import RTF Scenario 

The RTF scenario import functionality enables the user to import RTF scenario into GSGT. Upon 
selecting the import function, the user is presented with a dialog to provide the location of the scenario 
data file. 

 

Note 

Import RTF function is available in HCS version only. 

To start import process select Import->RTF from the GSGT Main Window. Then using the dialog, 
select the RTF file that you want to import. The files are usually named with c2k extension. 

When the import is complete, the total number of messages and targets added will be listed. 
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8.7. Import TGF Scenario 

The TGF scenario import functionality enables the user to import TGF scenario into GSGT. Upon 
selecting the import function, the user is presented with a dialog to provide the location of the scenario 
data file. 

 

Note 

Import TGF function is available in HCS version only. 

To start import process select Import->TGF from the GSGT Main Window. Then using the dialog, 
select the TGF file that you want to import. The files are in xml format and are named with xml 
extension 

When the import is complete, the total number of targets added will be listed. 
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9. Export Functions 
GSGT scenario can be exported, or converted, into several types of simulation scenarios. Currently the 
export functions support the following formats: SDRR (HCS version only), NAS SIM (HCS version 
only), and SIME. 

GSGT can export several formats of radar data including CD2-ARSR, ASR, ASR11, and ASTERIX-
MLAT, ADSB and ASR11-ASTERIX. It also export several forms of Interfacility data including, 
Enroute and Terminal message formats. This data can be played directly into Enroute/Terminal systems 
or can be used to build a Non-Radar-Tape (Merge Tape). 

While the export is running, the dialog is displayed to indicate that the export is in progress. Once the 
export is complete the dialog is closed automatically. 

 

 

Note 

To abort the export processing, either press the ESC key, click on Cancel button or attempt to close 
the dialog. 

9.1. SDRR Export 

The SDRR Export generates a scenario for simulation using SDRR. The SDRR scenario includes radar 
data and non-radar messages contained in a predefined directory structure. Once the SDRR scenario is 
generated, it needs to be transferred to SDRR for simulation. 

 

Note 

SDRR Export function is available in HCS version only. 

To start export, select Export->SDRR from the GSGT Main Window. 

Export dialog allows various options to be specified for creating a SDRR scenario. 
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Sim Name  

Name of the SDDR Sim to be created. 

Output Path  

Directory location for exported SDRR files. 

Start Time  

Scenario Start Time, as set in Scenario Preferences. Not editable in this dialog. 

Run Time  

Scenario Run Time, as set in Scenario Preferences. Not editable in this dialog. 

Generate Non-Radar Tape  

Writes a Non-Radar tape in HOST format. 
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SDRR Inject DSR messages via LIU  

SDRR will inject DSR messages using LIU Device.  

Generate Parrots/RTQCs  

Generates Radar Parrot and RTQC messages. 

Generate Radar Wx Messages  

Generates Radar Weather messages. 

Ignore radar horizon test  

Ignores the radar horizon test. 

Terminal Mode  

Terminal mode enabled live facilities. The list shows all available facilities, which can be 
selected as "live". Selected facility means that it is loaded on the STARS/CARTS/M/EARTS 
system where this scenario will be played back to. The other terminals in the list that are not 
selected will be simulated during playback. multiple terminals can be selected by holding down 
the Ctrl or Shift key and selecting additional terminals using left mouse click. 

OK  

Exports the scenario into SDRR format. 

Cancel  

Closes the dialog and cancels the SDRR export. 

When the export has completed, a default web browser is open displaying a report generated during the 
export indicating statistics and status. The messages are shown in GREEN and error messages are shown 
in RED. 
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Note 

If you wish to abort the export processing, you can either press the ESC key or attempt to close the 
dialog. The Done button will then become enabled and colored RED. 

9.2. NAS SIM Export 

The NAS SIM export functionality enables the user to create NAS Radar, Non-Radar or Merge 
(combined Radar and Non-Radar) tapes. 

 

Note 

NAS SIM Export function is available in HCS version only. 

To start export, select Export->NASSIM Tape from the GSGT Main Window. 

Export dialog allows various options to be specified for creating a NAS SIM tape. 

 
Start Time  

Scenario Start Time, as set in Scenario Preferences. Not editable in this dialog. 
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Run Time  

Scenario Run Time, as set in Scenario Preferences. Not editable in this dialog. 

Tape Type  

Type of tape to be created: Non-Radar, Radar, or Merge. 

Filters  

Types of messages to write: IF, FDIO and DSR (SIM00 or KEY00). 

Options  

Drop Radar Over Tape Block Size - will drop any excess radar messages that cannot be 
processed by Host in a given second. Otherwise, the excess messages are processed in the next 
second. 

DSR Version 1 - will use format compatible with Version 1 of NAS Sim tape. 

OK  

Exports the scenario into the selected NAS format. 

Cancel  

Closes the dialog and cancels the NAS SIM export. 

When the export has completed, a default web browser is open displaying a report generated during the 
export indicating statistics and status. The messages are shown in GREEN and error messages are shown 
in RED. 

 

9.3. TGF Export 

The TGF Export function generates a TGF scenario that consists of TGF flights and events files as well 
as optional adaptation files in TGF format. These files are exported to a user-specified file system 
location. An optional supplemental SDRR scenario can also be exported to provide a configuration file 
and non-radar data to support TGF scenario injection. 
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The output of the TGF Export is initiated by the export dialog which controls various aspects of the 
exported scenario. Some of the options include the ability to create TGF adaptation files as well as a 
supplemental SDRR scenario with configuration file and non-radar messages. 

 
Sim Name  

Name of exported scenario. 

Output Path  

Location where exported scenario will be saved. 

Output Files  

Scenario files and optional adaptation files in TGF format. 
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Supplemental SDRR Scenario  

An optional supplemental SDRR scenario to provide a configuration file and non-radar data to 
support TGF scenario injection. 

9.4. SIME Export 

The SIME Export function generates an ATCoach scenario used by SIME that consists of site and map 
files, aircraft models, scenario and weather scenario files, and control files. Also, files used by ECG are 
copied directly from EADP adaptation during the export. All of these files are contained in a predefined 
directory structure and based on the export type, OPS or TTS, placed in corresponding export directory, 
and controlled by environment variables (see Table 1, “Environment Variables”). 

The output of the SIME Export is initiated by the export dialog which controls various aspects of the 
exported scenario. Some of the options include ability to define sector assignments, change scenario 
modes and types, and allow to overwrite certain ADS-B values. Once the values are accepted and before 
the export begins, another dialog is opened to select a file name for the log file that's generated during 
the export process. 

To start export, select Export->SIME from the GSGT Main Window. 

9.4.1. Export Dialog 

The SIME Export dialog uses a configuration file called control.txt to populate fields of the dialog. 
First it looks in the scenario directory and then in the directory specified by the environment variable 
$GSGT_SITE_DEFAULTS. If control.txt cannot be found in either location, standard defaults are used. 
Optionally, dialog values can be populated by a specific control file, such as file that was renamed to 
something other than default control.txt, or file located in a different directory. This can be 
performed using Load Control File button located on the bottom of main tab. 

The base directory for the export output files is set by two environment variables. Depending on export 
mode, Operational (OPS) or Training (TTS), appropriate environment variable is used, 
$EXPORT_OPS_PATH or $EXPORT_TTS_PATH (see Table 1, “Environment Variables”). 

9.4.1.1. Main 

The Main tab of export dialog provides options to adjust scenario start time, name and other general 
scenario parameters.  
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Exercise  

The Exercise Number. 
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Start  

A static scenario start time and date is optional, however it's useful for test scenarios to have the 
same and repeatable time from run to run. If the Start is unselected, the system will use current 
date and time for simulation. 

 

Note 

Regardless of the start date/time selected or unselected to use system time, scenario 
simulation will always start from the beginning of the scenario. The time and date indicated 
in the dialog simply set the system time as the start of the scenario. 

Format  

The scenario start time and date format, such as date and time or time only. When time only is 
selected the system uses current date. 

RSI  

A selection of RSIs to be included in the export. 

 

Note 

All of the RSIs are always exported, only the selected RSIs are added to the control file, that 
controls which ones are used in simulation. 

Scenario Name  

Specifies exported scenario name. A directory, containing the scenario files, will be created in 
the appropriate directory determined by environment variables (see Table 1, “Environment 
Variables”) based on selection of operational or training mode. 

Site File  

Specifies site file name. The site file is exported to Site directory in scenario directory. It 
includes ATCoach site definitions. 

Aircraft Model Dir  

The name of the directory where the Aircraft Model files will be placed during the export. The 
directory is created in scenario directory. 

Simulation Driver  

Sets the processor name where the Simulation Driver is running. 
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Map Range  

Sets the range (in miles), where adaptation items within only that range will be included in the 
map file. This is needed for ATCoach performance reasons. 

Font Size  

Specifies the size of the font for the map items. 

Magvar Spacing  

Specifies spacing between magnetic variation sampling on the grid. The spacing is specified in 
miles between the samples on the grid. Smaller values provide more accurate sampling but create 
a larger magvar grid file. The default is 20 miles between sample points on the grid. This is 
needed for ATCoach performance reasons. 

SV Grid Cell Size  

Size of the cell in the Service Volume Grid. The allowed range is 1-16 nm, with default of 16 
nm. Smaller values affect ATCoach performance. 

Control File Subdirectory  

Specifies subdirectory where control files are exported. This option is only available in Training 
Mode. 

Include Pilot Position (ESUB Only)  

Sets option in exported scenario that adds Ghost Pilot capability when running with ESUB. 

Use Lab Resource File  

Sets option in exported scenario that use lab resource file. This option is only available in 
Training Mode. 

Load Control File  

Loads settings from a specific control file and populates the dialog with its values. 

Export Directory  

Shows directory path where scenario will be exported using current export mode. 

9.4.1.2. Assignments 

The Assignments tab allows each physical console to be assigned one or more sector positions, MC 
equipment, or AT Specialist positions. 
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Each sector in the ARTCC is listed. Clicking on the plus sign next to a sector number displays a list of 
that sector's positions. A sector position is assigned to a physical console by dragging the position icon 
from the right side to the console on the left side. 

To clear an assignment, drag the position icon from the left side to either the proper Sector heading 
("Sector 1(EKN)") or the ARTCC heading ("ZDC"). 
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MC position and AT Specialist positions are assigned and cleared in a similar fashion by dragging 
positions between the views. Position assignments are restricted to specific physical consoles and if 
inappropriate assignment is attempted the cursor will indicate this with an icon and assignment will not 
be possible. 

Configuration ID  

The Channel Configuration ID used to select the physical consoles. Selecting a configuration ID 
will cause all console assignments to be cleared. 
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9.4.1.3. Facilities 

 
Export Mode  

Specifies export mode, TTS, OPS or EIB, 
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Scenario Type  

Selection of the scenario type for OPS mode. The choices are Test, Cert and Script. 

Live Inputs  

When set, live input indicates that specified interface not being simulated. 

ECGIP_TCP LIVE 
ECG_IP_Multicast LIVE 
ATM IPOP LIVE 
NADIN LIVE 
NEXRAD LIVE 
NOTAM LIVE 
SWIM LIVE 
ADSB LIVE 
DCNS LIVE 
TIMS LIVE 
TDLS LIVE 
WMSCR LIVE 

ECG Emulation  

Enables ECG emulation. 

SWIM Emulation  

Enables SWIM emulation. 

PGW Emulation  

Sets PGW emulation to ON, OFF or NONE. When set to ON, PGW messages are injected. 
When set to OFF, DCNS messages are injected. Setting emulation to NONE, neither PGW nor 
DCNS messages are injected during simulation. 

TCID Format and Max TCID Value  

The format for TCID as HHH (3 hex digits) or DDD (3 decimal digits). Based on the format, the 
max value is appropriately adjusted to match a hex or decimal format. The max value provided 
represents the maximum value that can be assigned to TCID. 

ADS-B Send Time Delay  

The delay in sending the message, represented in seconds, that will be applied to all ADS-B 
generated messages. The default is half a second. 
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Facilities  

The table listing facilities and their Opsim, Channel, and Mode for each ERAM ARTCC. 

To edit values for the facilities, double mouse clicking on a facility entry. OPSIM Editor dialog 
is used to edit the values. 

 
Name  

The ARTCC name (read-only). 

Opsim  

The Opsim Id (always 0 when Ops Mode is checked, otherwise 1-12). 

Channel  

The Channel identifier (A, B, or AB). 

Mode  

The facility mode (DYNAMIC, SEMI-DYNAMIC, STATIC, or disabled). 

9.4.1.4. Overwrite ADS-B Values 

The Overwrite ADS-B Values tab allows to override ADS-B specific adapted values for the export. The 
values are overridden for a single export and are not saved for the subsequent exports. Selected items are 
used to override the values. To edit values double click the desired item. 
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9.4.1.5. Overwrite Options 

 
Overwrite  

Select parts of the scenario to overwrite. 
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10. Reports and Tools 
GSGT includes ability to generate various reports such as Conflict and Traversal reports. All reports (as 
well as import and export logs) are written to files that can be viewed by a any HTML browser outside 
of the GSGT application. 

After selection of the report and it's options (if applicable) a dialog is displayed to choose a file name 
where the report will be saved. If the file name already exists, a prompt will be displayed to confirm that 
the old file will be overwritten. While the report is being created, a window is displayed indicating that 
the report is being generated. Once the report is complete, a dialog is displayed asking to preview report. 
The report is always saved to a specified file, and it may be viewed at a later time by any HTML 
browser. 

Table 15. List of Reports 

Report Name 
GSGT Session Log 
Sorted Scenario Listing 
Message Injection Report 
Conflict Report 
EMSAW/TAV Conflict Report 
Paired Target Display 
Simulated Target Position 
Dynamic Message Report 
FAV Traversal Report 
EMSAW/TAV Traversal Report 
Active/Inactive Report 
Track Load Duration 
Simulated Radar Target Count 
Equipment Message Count 
Facility Track Count 
Sector Track Count 
Scenario Track Count 
Ghost Pilot Script Report 
 

10.1. Gsgt Session Log 

The Gsgt Session Log displays messages that were generated during the current session while 
performing certain task. Messages are logged for start and end of GSGT session, loading of a scenario, 
and import and export functions. Additionally when ATCoach engine is used, all requests and feedback 
logged in the ATCoach Status window is also logged in this report. 
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To generate the report, select Reports->Gsgt Session Log from the GSGT Main Window. 

The task that generated the message is shown in GRAY. Status and completion messages are shown in 
GREEN. Warnings are shown in YELLOW and error messages are shown in RED. 

10.2. Sorted Scenario Listing 

The Sorted Scenario Listing displays the injected messages and optionally the ATCoach messages for 
each target. The targets can be sorted by name and RSI. 

To generate the report, select Reports->Sorted Scenario Listing from the GSGT Main Window. 

 
Sort by RSI  

Group and sort the output by RSI. 

Display ATCoach commands  

Display ATCoach commands along with injected commands. 

Sort Targets by Name  

Sorts Targets by Name. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 
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10.3. Message Injection Report 

The Message Injection Report lists all scenario messages in chronological order based on injection time. 

To generate the report, select Reports->Message Injection Report from the GSGT Main Window. 

10.4. Conflict Report 

The Conflict Report displays a listing of the lateral and vertical separation between two targets, in 
addition to their current positions. It also displays a graph showing the altitudes of the targets and a 
previews routes of the two targets. 

To generate the report, select Reports->Conflict Report from the GSGT Main Window. 
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Report Interval  

The time interval used in the report. 

Lateral Separation  

Lateral (horizontal) distance for conflict, in Nmi. 

Vertical Separation  

Vertical distance for conflict, in feet. 

Immediate Lateral Separation  

Lateral (horizontal) distance for Immediate conflict, in Nmi. 

Immediate Vertical Separation  

Vertical distance for Immediate conflict, in feet. 
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Predicted Lookahead  

Time interval for Predicted conflict, in seconds. 

Imminent Lookahead  

Time interval for Imminent conflict, in seconds. 

Track Age Min  

Specifies the minimum time the targets must be active before being eligible for conflict, in 
seconds. 

Targets  

The targets used in the report. Exactly two targets must be selected. Hold down CTRL to select 
multiple targets. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

The Conflict report lists the time, position of each target (Lat/Long/Altitude), lateral/vertical separation, 
time until predicted lateral/vertical conflict, and conflict status (none, Predicted, Imminent, or Current). 
Values that are currently in violation are shown in RED. 
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CLS  

Current Lateral Separation in Nmi. 

CVS  

Current Vertical Separation in feet. 

TOLV  

Time Of Lateral Violation in seconds - for Predicted alerts. 

TOVV  

Time Of Vertical Violation in seconds - for Predicted alerts. 

The Altitude Profile is a graph of the altitude of the two targets. When the targets have a Current 
Vertical Violation, the graph will be shown in RED. 
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The routes of the two selected targets are displayed, much like the Show Flight Path preview. The 
displayed routes begin at the point in time when the later of the two targets becomes active. The two 
targets are linked, so dragging one will drag the other as well. The context box and limited data block 
will change color when the targets are in conflict. The colors are GREEN for no conflict, YELLOW for 
Predicted, ORANGE for Imminent, and RED for Current. 
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10.5. EMSAW/TAV Conflict Report 

The GSGT EMSAW/TAV Conflict Report displays a list of target positions and alert status relative to 
the selected EMSAW/TAV. 

To generate the report, select Reports->EMSAW/TAV Conflict Report from the GSGT Main Window. 

 
Adaptation  

The adaptation site to use for the report. 

Interval  

The time interval used in the report. 

Lookahead  

The time interval for predicted conflicts. 

Targets  

The target used in the report. Only one target may be selected. 

EMSAW/TAVs  
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The EMSAW/TAV used in the report. Only one EMSAW/TAV may be selected. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

 

The EMSAW/TAV report lists the Time, Target Position (Lat/Long/Altitude), Time To Violation, and 
color-coded conflict status (none, Predicted, Current). TTV (Time To Violation, in seconds) values that 
are currently in violation are shown in RED. Predicted conflicts is shown in YELLOW. 

10.6. Paired Target Display 

The Paired Target Display shows the routes of two targets as well as a graph showing the altitudes of the 
targets. The two targets are linked, so sliding one along its route will affect the other target as well. This 
behavior is similar to the route display from the Conflict Report. 
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To generate the report, select Reports->Paired Target Display from the GSGT Main Window. 

 
Targets  

The targets used in the report. Exactly two targets must be selected. Hold down CTRL to select 
multiple targets. 

OK  

Generates the report for the selected targets. 

Cancel  

Closes the dialog and cancels the report. 

The Altitude Profile and Route Display are identical to those in the Conflict Report. except that there are 
no color changes for conflicts. 

10.7. Simulated Target Position 

The GSGT Simulated Target Position report provides information on selected target positions at a 
specified time interval. 

To generate the report, select Reports->Simulated Target Position from the GSGT Main Window. 
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Start Time  

Start time of the report. 

Length  

The length of time the report will cover. 

Interval  

The time interval of each target report. 

Targets  

The targets listed in the report. Hold down CTRL to select multiple targets. Clicking on Target 
ID or Starttime will sort the targets appropriately. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 
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The first file displayed is a summary contains links to the report for each selected target. Clicking on a 
link will display the individual target report. 
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10.8. Dynamic Message Report 

The GSGT Dynamic Message Report generates listing of selected targets from the scenario providing 
basic information such as start time and route. 

To generate the report, select Reports->Dynamic Message Report from the GSGT Main Window. 

The dialog with report options is the same as in Paired Target Display report (see Section 10.6, “Paired 
Target Display”) 

10.9. FAV Traversal Report 

The FAV Traversal Report displays the FAV crossing times for the selected targets. 

To generate the report, select Reports->FAV Traversal Report from the GSGT Main Window. 

The dialog with report options is the same as in Simulated Target Position report (see Section 10.7, 
“Simulated Target Position”) 

The FAV Listing displays each aircraft ID and the time it enters each FAV. 
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10.10. EMSAW/TAV Traversal Report 

The GSGT EMSAW/TAV Traversal Report displays a list of active targets and the EMSAW/TAV they 
are currently in for a specified time interval. 

To generate the report, select Reports->EMSAW/TAV Traversal Report from the GSGT Main Window. 
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Facility  

The adaptation site to be used for the report. 

Start Time  

The start time of the report. 

Length  

The run time of the report. 

Interval  

The time interval used in the report. 

Targets  

The targets used in the report. Hold down CTRL to select multiple targets. 

RSIs  

RSIs to include in the report. 
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OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

The EMSAW/TAV Traversal report lists the Target Name, Target Altitude, EMSAW/TAV Name, and 
EMSAW/TAV Altitude in separate columns per specified time interval. 

 

10.11. Active/Inactive Report 

The GSGT Active/Inactive Report displays a list and a graph of active and inactive targets for a 
specified time interval. 

To generate the report, select Reports->Active/Inactive Report from the GSGT Main Window. 
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Facility  

The adaptation site to be used for the report. 

Start Time  

The start time of the report. 

Length  

The run time of the report. 

Interval  

The time interval used in the report. 

Targets  

The targets listed in the report. Hold down CTRL to select multiple targets. 

OK  

Generates the report using the specified criteria. 

Cancel  
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Closes the dialog and cancels the report. 

The Track Active/Inactive report lists the number of Active and Inactive tracks in separate columns per 
specified time interval. 

 

The Track Active/Inactive chart is a bar chart showing the number of active flights in GREEN and the 
number of inactive flights in RED. 
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10.12. Track Load Duration 

The Track Load Duration report displays a graph of the number of aircraft tracks during a selected time 
interval. It can also list the time interval(s) a specified load was achieved and maintained. 

To generate the report, select Reports->Track Load Duration from the GSGT Main Window. 

 
Load  

The aircraft load to report. 

Interval  

The time interval used in the report. 
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Process Inactive  

Include inactive aircraft in the report. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

The Track Load Duration report displays the target load at the selected time intervals. The Details 
section shows the time durations that meet the selected Load value. 
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The Track Load Duration chart is a line chart showing the number of targets in GREEN and the selected 
load in RED. 

 

10.13. Simulated Radar Target Count 

The GSGT Simulated Radar Target Count. 

To generate the report, select Reports->Simulated Radar Target Count from the GSGT Main Window. 

 
Load  

The aircraft load to report. 
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Interval  

The time interval used in the report. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

10.14. Equipment Message Count 

The Equipment Message Count report displays the number of messages generated by selected 
equipment during a selected time interval. 

To generate the report, select Reports->Equipment Message Count from the GSGT Main Window. 

 
Start Time  

The start time of the report. 

Length  
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The run time of the report. 

Interval  

The time interval used in the report. 

Equipment  

The equipment listed in the report. Hold down CTRL to select multiple equipment names. 

List by Equipment  

Report will be grouped and sorted by Equipment. The default is to sort by Time. 

List Messages  

Displays the generated messages by each Equipment item. The messages will be colored GRAY. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 
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10.15. Facility Track Count 

The GSGT Facility Track Count report displays a list of the number of tracks located in various areas 
(Local ARTCC, ARTS, Adjacent ARTCCs, Uncontrolled) for a given time interval. 

To generate the report, select Reports->Facility Track Counts from the GSGT Main Window. 

The dialog with report options is the same as in Active/Inactive Report report (see Section 10.11, 
“Active/Inactive Report”) 
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The Track Count report has columns labeled for the selected local ARTCC adaptation, the local ARTS, 
each adjacent ARTCC, and UNCONTROLLED. Each time interval displayed has rows for each 
Geographic Area, described below. 

AOR - Targets located in the Area Of Responsibility. 
SrvAOI - Targets located in the Surveillance Area Of Interest. 
FPAOI - Targets located in the Flight Plan Area Of Interest. 
No radar - Targets not covered by any radar. 

 

Note 

The Geographic Areas are exclusive. A target in an ARTCC's AOR will not be counted in the 
SrvAOI, although the area of the SrvAOI overlaps the AOR.  

10.16. Sector Track Count 

The GSGT Sector Track Count report lists the number of Controlled and Uncontrolled Target in each 
sector for the selected time interval. 
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To generate the report, select Reports->Sector Track Count from the GSGT Main Window. 

The dialog with report options is the same as in Active/Inactive Report report (see Section 10.11, 
“Active/Inactive Report”) 

 

10.17. Scenario Track Count 

The GSGT Scenario Track Count report displays a list of the number of tracks located in various areas 
of the local ARTCC for a given time interval. 

To generate the report, select Reports->Scenario Track Count from the GSGT Main Window. 

The dialog with report options is the same as in Active/Inactive Report report (see Section 10.11, 
“Active/Inactive Report”) 
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The Track Counts report has columns labeled for the selected local ARTCC adaptation, the local ARTS, 
and UNCONTROLLED. Each time interval displayed has rows for each Geographic Area, described 
below. 

AOR - Targets located in the Area Of Responsibility. 
SrvAOI - Targets located in the Surveillance Area Of Interest. 
FPAOI - Targets located in the Flight Plan Area Of Interest. 
No radar - Targets not covered by any radar. 

 

Note 

The Geographic Areas are exclusive. A target in an ARTCC's AOR will not be counted in the 
SrvAOI, although the area of the SrvAOI overlaps the AOR.  
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10.18. Ghost Pilot Script Report 

The Ghost Pilot Script Report displays the ghost pilot prompts for the selected positions. 

To generate the report, select Reports->Ghost Pilot Script Report from the GSGT Main Window. 

 
Pilot Positions  

The pilot positions to include in the report. 

OK  

Generates the report using the specified criteria. 

Cancel  

Closes the dialog and cancels the report. 

The format of the report is Time, Address, Text, Command. Each field is separated by '**'. 
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11. Utilities 
11.1. exportatcoach utility 

The exportatcoach utility will open one or more scenario(s) and create the exported ATCoach/SIME 
files. It performs the same as the SIME Control File dialog without starting the GSGT GUI. 

To run the exportatcoach utility type exportatcoach from a command line. 

 

The following options can be specified for exportatcoach utility: 

Usage: exportatcoach [-giIfrtSTBepvjn] [-O facility[,facility ...]] [-c controlFile] [-
N exportedScenName] [-z size] [-R range]  
                                     [-s Test|Cert|Script] [-F file] [-d dir] [-L min,max -L min,max ....] [-
l release name] 
    -g  gen radar hex 
    -r  disable atcoach sensors 
    -t  disable atcoach target dynamics (for non-radar file only) 
    -i  disable IFDT message generation. 
    -f  disable GPIO message generation. 
    -T  TTS mode (defaults to ops mode) 
    -B  EIB mode (defaults to ops mode) 
    -s  ops mode scen type (Test,Cert,Script). default is Test. 
    -S  SDRR Mode.  Equivalent to -r -t -i -f. 
    -e  turn off ecg emulation (defaults to on). 
    -W  turn off swim emulation (defaults to on). 
    -p  preview mode (for atcoach testing) 
    -z  font size (for map) 
    -R  range (for map) 
    -G  training mode 
    -F  file containing a list of scenarios, each on a separate line 
    -d  directory containing input scenarios 
    -D  Omit Datacomm/PGW files and directives 
    -M  Omit SWIM files and directives 
    -L  export messages within list of min and max times 
    -n  do not overwrite existing files 
    -E  do not overwrite existing files except scenario 
    -O  specify ops facility, or when tts mode, list of facilities to sim (comma separated) 
    -l  specify release name 
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    -I  Use RSI list from local control file in exported control file. 
    -b  [version] - ADSB version 
    -m  gen time tokens in adsb hex file 
    -q  ADSB messages delay in millisecons 
    -w  use stationary precipitation 
    -v  verbose 

11.2. gsgtmanager utility 

The gsgtmanager utility opens the GSGT Scenario Manager without starting the GSGT GUI. This will 
launch the GSGT Scenario Manager. It operates the same as the one launched from within the GSGT 
GUI. 

To run the gsgtmanager utility type gsgtmanager from a command line. 

11.3. uplevel utility 

The uplevel utility will open one or more scenario(s) using the specified adaptation(s), list any errors, 
and (optionally) save the scenario(s). 

To run the uplevel utility type uplevel from a command line. 

 

The following options can be specified for uplevel utility: 

Usage: uplevel [-s] -a adapt[,adapt] [-q] [-C changes_file] [-o] ((-f file) || (-d dir) || (scen[,scen])) 
 
    -s    save scenario(s) after upleveling (optional) default is not to save 
 
    -a    adaptation(s) to convert scenarios to (relative to $ADAPTATION_PATH 
          env variable) multiple adaptations are specified using a comma-delimited list 
 
    -q    quick file uplevel - this option will not open scenarios, it simply replaces 
          adaptation name(s) in scenario source file(s) - no errors/warnings are displayed 
 
    -C changes_file 
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          Perform text replacements specified in changes_file on scenario source files prior 
          to opening to scenario.  If the -s option has not been specified, text replacements 
          are made in a temporary copy of scenario. 
 
          Syntax for changes_file: 
             <Changes> 
               <replace old_text="text1" new_text="text2" element="ELEMENT" > 
             </Changes> 
          Where ELEMENT must be one of: 
             TARGET_ROUTES, TARGET_MESSAGES, AIRCRAFT_TYPES, EQUIP_QUALIFIERS, E
VENT_POSITIONS, or MESSAGE_DEVICES 
 
    -o outfile 
          optional file to which all output is written (output written to both the screen and outfile) 
 
    -f    file containing a list of scenarios, each on a separate line ('#' character used for comments) 
 
    -d    directory containing scenarios as subdirectories 
 
    scen  scenarios name(s) to be converted (relative to $GSGT_WORK_PATH env variable) multiple 
          scenarios are specified using a comma-delimited list (ignored if -f option is used) 

11.4. guplex utility 

The GUI Uplevel/ExportATCoach (guplex) utility provides a GUI for users to perform uplevel and 
exportatcoach functions. The GUI presents all the options available in the command-line versions of the 
uplevel and exportatcoach utilities, but also provides a convenient method of selecting scenarios, 
directories, adaptations, options, etc, to construct uplevel and exportatcoach commands, as well as 
providing a method of viewing/managing the output of uplevel and export operations. 

Tu run guplex utility type guplex from a command line. 

11.4.1. Utility Startup Environment and Directories 

When the GUI UpLevel/ExportATCoach (guplex) utility is launched, it will: 

- examine $GSGT_UTIL_PATH and if set but $GSGT_UTIL_PATH directory does not exist, attempt 
to create it 
- if $GSGT_UTIL_PATH directory does not exist, cannot be created, or GSGT_UTIL_PATH is not set, 
attempt to create: $HOME/.gsgtutil and use that as the value of GSGT_UTIL_PATH 

Also at startup, and after the above actions, guplex will look for (and attempt to create if not found) the 
following directories: 

- $GSGT_UTIL_PATH/lists/ 
- $GSGT_UTIL_PATH /logs/ 
- $GSGT_UTIL_PATH/changes/ 
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- $GSGT_UTIL_PATH/.cmd/ 

11.4.2. Performing Scenario UpLevel Operations 

To perform an uplevel command: 

 
Step 1  

Select one or more scenarios from the 'Scenario' tab on the left side of the GUI 

Scenarios are presented in light green text, while directories are presented in black text. Multiple 
scenarios can be selected simply by clicking on them (i.e., Ctrl-click is not required), and 
scenarios can be de-selected by clicking on them while they are selected. The selection status of 
all scenarios/directories in a given directory may be toggled by clicking on the directory. All 
scenario selections may be cleared by clicking the 'Clear' button in the 'Scenario' tab. The current 
scenario/directory selection(s) can be saved to a text file by clicking the 'Save List' button, and 
the scenario/directory selection can be populated from such a text file by clicking on the 'Load 
List' button and selecting the desired list file. 

Step 2  

Select one or more adaptations from the 'Adaptation' tab on the left side of the GUI 
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Adaptations (i.e., for ERAM local releases whose parent is $DSSC_REL) are presented in light 
green text, and directories (if any) are presented in black text. The first adaptation selected is 
shown with a diamond to the left of the adaptation name, and is considered the 'airspace' 
adaptation. Additional adaptations may be selected by holding down 'Ctrl' and clicking on the 
adaptation item - these additional adaptations are considered 'facility' adaptations. 

Step 3  

Select an UpLevel Option from the 'UpLevel' tab on the right side of the GUI. For more detail 
see section UpLevel Options. 

Step 4  

(Optional) Compose or load specific Changes to be made to scenario source files in the Changes 
File tab on the lower portion of the UpLevel tab. For more detail see section Using an UpLevel 
Changes File. 

Step 5  

(Optional) Use the 'Select Log File' button below the 'UpLevel Log' pane to choose the 
name/location of the uplevel log file. For more detail see section Saving/Managing GUI 
UpLevel/ExportATCoach Files. 

Step 6  

Click the 'Run UpLevel' button 

The GUI will launch the requested uplevel command, echoing output to the 'UpLevel Log' 
display pane. Note that certain uplevel commands may take a significant amount of time, 
especially when multiple scenarios have been selected. While an uplevel command is running, 
no user action is permitted in the GUI. 

11.4.2.1. UpLevel Options 

UpLevel Options are selected from the 'UpLevel' tab on the right side of the GUI: 
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Preview UpLevel  

This option will open each selected scenario using the selected adaptation(s) and display all 
warnings and errors to aid the user in determining what the impact of up-leveling to the selected 
adaptation(s) would be. No scenario files are changed. 

Full UpLevel  

This option will open each selected scenario using the selected adaptation(s), display all 
warnings and errors, and re-save the selected scenarios using the selected adaptation(s). Note that 
scenario files are updated, and any warnings or errors may indicate that targets, messages, etc 
were not able to be created using the new adaptation and are likely to be dropped from the 
scenario. An UpLevel Preview is highly recommended prior to running this option. 

Quick File UpLevel  

This option will NOT open the selected scenarios, rather, it will update the scenario source files 
to reflect the selected adaptation(s). Scenario files are updated and no warnings or errors are 
displayed (although any warnings and errors will be displayed when the resulting scenario is first 
opened). An UpLevel Preview is highly recommended prior to running this option. 

Perform Text Replacement  

Selecting this option causes all search/replace text replacement specified in the Changes File tab 
to be performed in scenario source files prior to opening/upleveling the scenario. If the 'Preview' 
option has been selected a temporary copy of each scenario will be created, modified, and 
opened to preview the effect of the up-level operation without updating the selected scenarios. 

11.4.2.2. UpLevel Changes File 

As adaptation changes it may occasionally be necessary to make certain changes to scenario source files 
prior to opening or upleveling the scenario in order to avoid losing information. For example if the name 
of a heavily used STAR changes it would be necessary to update any targets in a scenario that used that 
STAR in a route (or target message). The UpLevel Changes File is designed to allow the user to make 
very specific changes to scenario source files without having to edit the files directly. 

The 'Compose Change' bar of the 'Changes File' tab allows the user to compose specific scenario 
changes in a simple "search/replace-like" syntax. After supplying "Replace" and "with" values in the 
'Compose Change' bar, clicking the 'Add' button will format the change and insert it into a "Changes" 
file. The syntax used in a "Changes" file is: 

<replace old_text="OLD" element="SCENARIO_ELEMENT" new_text="NEW" /> 
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Changes may be composed for the following scenario elements: 

TARGET_NAMES  

Any occurrence of "old_text" in target name in the scenario is replaced with the value specified 
by the "new_text" attribute. Note that TARGET_NAMES changes are applied only to the target 
name (i.e., Frozen target messages are not altered by a TARGET_NAMES change, although 
derived target messages will be indirectly altered by a TARGET_NAMES change. If target 
names in frozen FP messages need to be updated, then TARGET_MESSAGES change(s) must 
be composed (see below). 

TARGET_ROUTES  

Any route element of any target that exactly matches the value specified by the "old_text" 
attribute of the change is replaced with the value of the "new_text" attribute. Note that 
TARGET_ROUTES changes are applied only to the "target dynamics" route (i.e., the path the 
simulated target will actually fly. Frozen target messages are not altered by a 
TARGET_ROUTES change, although derived target messages will be altered by a 
TARGET_ROUTES change. If route elements in frozen FP messages need to be updated, then 
TARGET_MESSAGES change(s) must be composed (see below). 

TARGET_ICAO_ADDRESS  
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Any occurrence of "old_text" in target ICAO address in the scenario is replaced with the value 
specified by the "new_text" attribute. Note that TARGET_ICAO_ADDRESS changes are 
applied only to the target ICAO address (i.e., Frozen target messages are not altered by a 
TARGET_ICAO_ADDRESS change, although derived target messages will be indirectly altered 
by a TARGET_ICAO_ADDRESS change. If target ICAO address in frozen FP messages need to 
be updated, then TARGET_MESSAGES change(s) must be composed (see below). 

TARGET_TAIL_NUMBER  

Any occurrence of "old_text" in target tail number in the scenario is replaced with the value 
specified by the "new_text" attribute. Note that TARGET_TAIL_NUMBER changes are applied 
only to the target tail number (i.e., Frozen target messages are not altered by a 
TARGET_TAIL_NUMBER change, although derived target messages will be indirectly altered 
by a TARGET_TAIL_NUMBER change. If target tail number in frozen FP messages need to be 
updated, then TARGET_MESSAGES change(s) must be composed (see below). 

TARGET_MESSAGES  

Any occurrence of "old_text" in any frozen target message in the scenario is replaced with the 
value specified by the "new_text" attribute. 

TARGET_ICAO_DATA  

Any occurrence of "old_text" in any ICAO data element in the scenario is replaced with the 
value specified by the "new_text" attribute. 

EVENT_POSITIONS  

Replaces any "Position" trigger value exactly matching "old_text" attribute of the change with 
the "new_text" attribute value in target events. For example, a "Change Altitude" target event 
can be triggered at a particular position on the target's route of flight. 

AIRCRAFT_TYPES  

Any target with a "target dynamics achar" type exactly matching the "old_text" attribute value of 
the change will be replaced by the "new_text" attribute value. Note that the "target dynamics 
achar" type is the type of aircraft the simulated target will behave like, not necessarily the aircraft 
type specified in any frozen FP message for the target. 

AIRCRAFT_TRANSPONDERS  

Any target with a transponder type exactly matching the "old_text" attribute value of the change 
will be replaced by the "new_text" attribute value. Note that target may have several transponder 
types separated by comma and that the attribute values must match the entire attribute, not the 
individual transponder types. Also note that some transponder types use lower case letters and 
that values as case sentitive. 
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EQUIP_QUALIFIERS  

Any target with "NAV Equipment" value (as specified on the Main tab of the GSGT Target 
Editor Dialog) that exactly matches the "old_text" attribute value of the change will be replaced 
by the "new_text" attribute value. Note that the equipment suffix in any frozen target FP message 
is not affected by an EQUIP_QUALIFIER change. To perform that change use 
TARGET_MESSAGE. 

ADSB_EQUIP_QUALIFIERS (deprecated)  

Any target with "ADSB Equipment" value (as specified on the Main tab of the GSGT Target 
Editor Dialog) that exactly matches the "old_text" attribute value of the change will be replaced 
by the "new_text" attribute value. Note that the ADSB equipment code in any frozen target 
FP/FPL message is not affected by an ADSB_EQUIP_QUALIFIER change. To perform that 
change use TARGET_MESSAGE. Note that ADSB_EQUIP_QUALIFIER is deprecated and 
will only work with scenarios created with GSGT versions earlier than 7.5.6.0. 

FP_OVERRIDES  

Replaces any part of FP Override value exactly matching "old_text" attribute of the change with 
the "new_text" attribute value in target's FP Overrides.  

MESSAGE_DEVICES  

Replaces any "Device" name value exactly matching "old_text" attribute of the change with the 
"new_text" attribute value in system command and frozen target messages. For example, all 
message injections from device "E1" can be changed to "E2". The change does not modify the 
facility owning the given device. Also this process does not validate that the device exists and if 
it's valid for any specific injection. 

SYSTEM_CMD_MESSAGES  

Any occurrence of "old_text" in any system command message in the scenario is replaced with 
the value specified by the "new_text" attribute. 

PRE_PROGRAMMED_EVENTS  

Any occurrence of "old_text" in any pre programmed event in the scenario is replaced with the 
value specified by the "new_text" attribute. 

Change items displayed in the lower pane of the 'Changes File' tab may be edited by selecting them, 
editing the contents of the change in the 'Compose Change' bar, and selecting the 'Update' button. Also 
Change items may be deleted by right-clicking on the item and selecting delete. 

The contents of the lower pane of the 'Changes File' tab may be saved to a file by clicking the 'Save 
Changes File' button, and populated by clicking 'Load Changes File' button and selecting a specific file. 
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11.4.3. Performing Export ATCoach Operations 

To perform an exportatcoach command: 

 
Step 1  

Select one or more scenarios from the 'Scenario' tab on the left side of the GUI 

Scenarios are presented in light green text, while directories are presented in black text. Multiple 
scenarios can be selected simply by clicking on them (i.e., Ctrl-click is not required), and 
scenarios can be de-selected by clicking on them while they are selected. The selection status of 
all scenarios/directories in a given directory may be toggled by clicking on the directory. All 
scenario selections may be cleared by clicking the 'Clear' button in the 'Scenario' tab. The current 
scenario/directory selection(s) can be saved to a text file by clicking the 'Save List' button, and 
the scenario/directory selection can be populated from such a text file by clicking on the 'Load 
List' button and selecting the desired list file. 

Step 2  

Select Export ATCoach tab on the right side of the GUI. For a brief explanation of exportatcoach 
command-line options see section 17.1.2. 
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Step 3  

(Optional) Use the 'Select Log File' button below the 'Export Log' pane to choose the 
name/location of the exportatcoach log file. For more detail see section 17.4.5 Saving/Managing 
GUI UpLevel/ExportATCoach Files. 

Step 4  

Click the 'Export Selected Scenarios' button 

The GUI will launch the requested exportatcoach command, echoing output to the 'Export Log' 
display pane. Note that exportatcoach commands may take a significant amount of time, 
especially when multiple scenarios have been selected. While an exportatcoach command is 
running no user action is permitted in the GUI. 

 

Note 

selecting an adaptation from the 'Adaptation' tab is not required for an exportatcoach 
operation, since scenarios will be exported on the local release specified in scenario source 
files. 

11.4.4. Saving/Managing guplex log Files  

When uplevel or export is performed the log output is displayed in the Uplevel Log or Export Log 
section of the tab accordingly to the performed action. The log output is also written to the default files 
and files are overwritten every time uplevel/export is performed. 

The default location/name of the uplevel and exportatcoach logs are: 

$GSGT_UTIL_PATH/logs/uplevel.log 

$GSGT_UTIL_PATH/logs/exportatcoach.log 

The Log pane section allows simple management of log files: 

Open  

Opens standard 'File Dialog' allowing the user to select any previously save log file to display in 
the Log pane.  

Print  

Opens standard 'Print Dialog' to select one of available printers to print the log that is currently 
displayed in the Log pane. 
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Clear  

Clears the any log output from the Log pane. This action does not delete log file that is displayed 
in the Log pane. 

Save  

Opens standard 'File Dialog' allowing the user to select location and file name to save the 
contents of the log that is currently displayed in the Log pane. 

11.4.5. Saving/Managing guplex Files  

When the user selects 'Save List' from the Scenario Tree and accepts the default filename, guplex will 
save the selected scenarios and/or directories (text file where each line contains the full path of the 
scenario or directory) to the file: 

$GSGT_UTIL_PATH/lists/scenlist.txt 

When the user selects 'Save Changes File' from the Changes File pane, a standard 'File Dialog' is 
presented allowing the user to select the location and name for the Changes file. The default 
location/name of the Changes file is: 

$GSGT_UTIL_PATH/changes/Changes.xml 

Any of the above standard 'File Dialogs' may be used to manage (i.e., rename, or delete) guplex output 
files by right-clicking on the desired file(s). 

When the user issues an uplevel or exportatcoach command from the GUI, guplex will create the 
following files as needed (files are overwritten for each command): 

$GSGT_UTIL_PATH/.cmd/scenlist.cmd 

$GSGT_UTIL_PATH/.cmd/Changes.cmd 

When the command-line uplevel utility is invoked (either from the command line or by guplex), and the 
user has specified that text replacement 'Changes' are to be performed but the source scenario is NOT to 
be saved, then the uplevel utility will: 

- examine $GSGT_UTIL_PATH and if set but $GSGT_UTIL_PATH directory does not exist, attempt 
to create it 
- if $GSGT_UTIL_PATH directory does not exist, cannot be created, or GSGT_UTIL_PATH is not set, 
attempt to create: $HOME/.gsgtutil and use that as the value of GSGT_UTIL_PATH 
- look for and remove $GSGT_UTIL_PATH/.tmp directory 
- create $GSGT_UTIL_PATH/.tmp directory 
- for each scenario provided as input: 
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* remove any previous copy of the scenario in $GSGT_UTIL_PATH/.tmp directory 
* copy the specified source scenario to $GSGT_UTIL_PATH/.tmp directory 
* perform changes on the copy of the scenario 
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12. Error Messages by Function 
12.1. Import NAS SIM / DYSIM Errors 

Message: ***Invalid equip ([device]) at [time]: ([text]) 
Description: The specified equipment is unknown/invalid. 
Resolution: Correct equipment reference in the import scenario, if desired. 
    
Message: [aircraft] is read only 
Description: Aircraft characteristic data is read only. 
Resolution: Check user authority and scenario directory/file-permissions. 
    
Message: Change equip failed: [equip name] not found. 
Description: Specified equipment cannot be located. 
Resolution: Correct inconsistency in import data. 
    
Message: Change position failed: [position name] not found. 
Description: Import caused a change to be attempted to a non-existent position. 
Resolution: Correct inconsistency in import data. 
    
Message: Console type [position indicator] specified on invalid sector [sector]. Ignoring. 
Description: Console cannot be assigned to sector position.  
Resolution: Correct console assignment or sector definition in import scenario. 
    
Message: DNREC: invalid radar [radar]. Ignoring. 
Description: The specified radar is invalid. It will be ignored. 
Resolution: Correct invalid radar reference in import data if desired. 
    
Message: Duplicate achar name [aircraft] not allowed. 
Description: An aircraft characteristic with the same name already exists. Cannot create duplicate 

aircraft. 
Resolution: Delete the aircraft record from scenario, or from import file. 
    
Message: Duplicate equip [equip name] in [adaptation name] 
Description: Equipment with the same name already exists. 
Resolution: Modify/remove duplicate item in import or working scenario. 
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Message: Duplicate equip [equip name] in sector [ID] 
Description: Equipment with the same name already exists in the sector. 
Resolution: Modify/remove duplicate item in import or working scenario. 
    
Message: Duplicate radar name [radar name] in [adaptation name] 
Description: A radar with the same name already exists. 
Resolution: Modify/remove duplicate item in import or working scenario. 
    
Message: Duplicate rsi description [RSI description] 
Description: (Warning) more than one RSI found with the same description in input data. 
Resolution: Modify RSI description(s) as desired in either import or working scenario. 
    
Message: Duplicate rsi value [value] 
Description: (Warning) duplicate RSI value found in input data. 
Resolution: Correct in the import scenario, if desired. 
    
Message: Error adding PLANE target [target]: [error(s)] 
Description: One or more errors have occurred while adding the specified target. 
Resolution: Correct errors for specified target in import scenario. 
    
Message: Error opening [filename]: [OS error description] 
Description: An error occurred opening the input file (OS error description is given). 
Resolution: Check user authority and scenario directory/file-permissions. 
    
Message: ImportNASSIM: R Position with no sectorPosition!! 
Description: Import referenced an R-position that is not assigned a sector. 
Resolution: Correct inconsistency in import data. 
    
Message: Invalid console type [position indicator] specified on equip card [name]. Ignoring. 
Description: Import scenario contains a reference to an invalid equipment type. 
Resolution: Correct equipment type in the import scenario. 
    
Message: Invalid equip card [card name]: Invalid position type [position type]. Ignoring. 
Description: Import data contains a reference to an invalid position type. 
Resolution: Correct position type in import scenario. 
    



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 245   

Message: Invalid equip card [card name]: Invalid range setting [setting]. Ignoring. 
Description: Import scenario specifies invalid range for position. 
Resolution: Correct in import scenario. 
    
Message: Invalid maneuver time [time] for [target]. Ignoring. 
Description: The specified maneuver time is invalid. Maneuver will be ignored. 
Resolution: Correct invalid time for maneuver in import scenario if desired. 
    
Message: Invalid nadin equip card [card name]: No custom header, yet equip name is < 3 chars. 

Ignoring. 
Description: Import scenario contains a reference to NADIN equipment with an invalid format. 
Resolution: Correct in import scenario. 
    
Message: Invalid name 
Description: Import data contains a reference to an invalid or null target name. 
Resolution: Correct errors in import data. 
    
Message: Invalid route 
Description: Target has an invalid route. 
Resolution: Correct route errors in import data or in working scenario. 
    
Message: Invalid rte [route name] while processing ([message text]) 
Description: (Warning) Invalid route specified in import scenario. 
Resolution: Correct error(s) in import scenario. 
    
Message: MESAG: invalid radar [radar]. Ignoring. 
Description: The specified radar is invalid. Message/command will be ignored. 
Resolution: Correct invalid radar reference in import data if desired. 
    
Message: No aircraft characteristics set 
Description: Import caused a target to be imported without aircraft characteristics being set. 
Resolution: Investigate import scenario. 
    
Message: No RADAR, NRADR, or MERGE card found. Aborting. 
Description: Import scenario does not contain required data. 
Resolution: Correct errors in import scenario or specify a different source. 
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Message: No starttime found for [target] 
Description: Start-time for the specified target cannot be determined from import data. 
Resolution: Investigate/correct errors in import scenario, or ignore/delete target. 
    
Message: Radar from nonRadar error ([message text]): Invalid field 4 
Description: Invalid beacon code in import data. 
Resolution: Correct errors in import data. 
    
Message: Radar from nonRadar error ([message text]): Invalid field 5 
Description: Invalid speed in import data. 
Resolution: Correct errors in import data. 
    
Message: Radar from nonRadar error ([message text]): Invalid route [route]: [CREATE ROUTE 

error] 
Description: A target to be imported contained an invalid route. 
Resolution: Correct errors in import data. 
    
Message: Radar from nonRadar error while processing ([message text]): AM Invalid field 2 ([aircraft 

ID value]) 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Could not determine msg 

type 
Description: (Warning) Message text does not match predetermined message type. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): DM Invalid field 2 ([aircraft 

ID value]) 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid Field 10 [route 

value] 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 2 ([aircraft 
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ID value]) 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 3 ([aircraft 

type value]) 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 5 [speed 

value] 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 6 

([coordination fix value]) 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 7 ([time 

value]) 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): FP Invalid field 8/9 

([altitude value]) 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid acid for JA 

command ([message text]) 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid ACID: JR command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
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Message: Radar from nonRadar error while processing ([message text]): Invalid altitude for JA 
command ([message text]) 

Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid Climb/Descent Rate 

for JR command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid Field1 of JO 

command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid Field1 of JS 

command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid HDG 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JA command 

[message text] 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JB command: NO 

SFID 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JC command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
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Message: Radar from nonRadar error while processing ([message text]): Invalid JE command: 
missing SFID 

Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JE command: 

unknown SFID format 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JR command: 

missing SFID 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JR command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid JS command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid SFID for JO 

command 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Invalid target reliability 

value [reliability value] ([message text]) 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): JH command Missing SFID 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): No Acid Found 
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Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Short DEP msg 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]): Short msg 
Description: (Warning) Import data contains a flight plan with invalid format or content.  
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar error while processing ([message text]):  
Description: (Warning) The specified message in import data has an invalid format. 
Resolution: Correct errors in import scenario. 
    
Message: Radar from nonRadar FPL error on ([message text]): Invalid AID [aircraft ID value] 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar FPL error on ([message text]): Invalid field [number] [field value] 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar FPL error on ([message text]): No adapted FIRB found for incoming 

ICAO flight 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar FPL error on ([message text]): No FIRB found for incoming ICAO 

flight 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar FPL error on ([message text]): Short FPL/CPL msg 
Description: (Warning) Import data contains a message with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
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Message: Radar from nonRadar FPL error on ([message text]): SPP could not be found on inbound 
ICAO flight 

Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar FPL error on ([message text]): VFR flevel. 
Description: (Warning) Import data contains a flight plan with invalid format or content. 
Resolution: Investigate/correct errors in import scenario, if desired. 
    
Message: Radar from nonRadar warning ([target]): AChar [aircraft name] not found, added to 

scenario. 
Description: (Warning) Import scenario contains aircraft type not already known to scenario. 
Resolution: n/a 
    
Message: Rsi [RSI identifier] does not have a description 
Description: (Warning) RSI found with no description in input data. 
Resolution: If desired, add RSI description in import or working scenario. 
    
Message: Rsi not populated 
Description: Import scenario has an RSI with an invalid format. 
Resolution: Ignore, or correct entry in import scenario. 
    
Message: Rsi value [value] out of range 
Description: (Warning) Import scenario has an RSI with an invalid format. 
Resolution: Correct in the import scenario, if desired. 

12.2. Import TGF Errors 
Message: [filename] not found ! 
Description: Specified filename does not exist or is not an appropriate file type 
Resolution: Check filename, path, file-permissions, and file format. 
    
Message: Couldn't determine device for FP message 
Description: A device could not be found in adaptation to enter the flight plan. 
Resolution: Investigate/correct errors in import data or scenario adaptation. 
    
Message: Empty Flight entry 
Description: TGF data has unexpected/invalid format. 
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Resolution: Investigate/correct errors in import data, or choose another TGF file to import. 
    
Message: Error adding event : Tgtevent time [time value] is earlier than target starttime 
Description: Import file specified a target event with a time earlier than the target start-time - target will 

be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Failed to add speed change event : Tgtevent time [time value] is earlier than target 

starttime 
Description: TGF data specifies a speed change with an invalid time for the target. 
Resolution: Investigate/correct errors in import data. 
    
Message: Ignored [target] 
Description: Informational message during import - this message should be preceded by a more specific 

error message. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Ignoring tag : [tag value] 
Description: (Warning) Import file contains an unknown element that will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid ACID : [ACID value] 
Description: An invalid aircraft ID was found in import file - target will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Invalid aircraft type : [aircraft type value] 
Description: An invalid aircraft type value was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Invalid arrival runway : [runway value] 
Description: An invalid runway value was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid beacon : [beacon code value] 
Description: An invalid beacon code was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
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Message: Invalid complexity : [complexity value] 
Description: An invalid complexity level was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Invalid departure runway : [runway value] 
Description: An invalid runway value was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid frequency : [frequency value] 
Description: An invalid frequency was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid interim altitude : [altitude value] 
Description: An invalid altitude was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid nav equip type : [navigation equipment type] 
Description: An invalid navigation equipment type was specified in the import file - target will be 

ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid nav type : [navigation type] 
Description: An invalid navigation type was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid start altitude : [altitude value] 
Description: An invalid altitude was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid start speed : [speed value] 
Description: An invalid speed was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid start type : [start type value] 
Description: An invalid start type was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
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Message: Invalid target altitude : [altitude value] 
Description: An invalid altitude was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid target speed : [speed value] 
Description: An invalid speed was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Invalid time : [time value] 
Description: An invalid time value was found in import file - target will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Multiple Flights tags encountered. 
Description: TGF data has unexpected/invalid format. 
Resolution: Investigate/correct errors in import data, or choose another TGF file to import. 
    
Message: No Flights tag found. 
Description: Import file does not appear to contain any flights. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : [CREATE ROUTE error] 
Description: An error was encountered attempting to create the route specified in the import file - target 

will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Different runways specified in route and ArrivalRunway element 
Description: (Warning) Import file specifies two different runways for this target - runway value within 

route will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Route error : Different runways specified in route and DepartureRunway element 
Description: (Warning) Import file specifies two different runways for this target - runway value within 

route will be ignored. 
Resolution: Investigate/correct errors in import data, if desired. 
    
Message: Route error : Ignoring bracket logic : [route element] 
Description: (Warning) Bracket logic that was neither a speed nor altitude adjustment was found - target 
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will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Invalid bracket logic : [bracket logic] 
Description: Bracket logic was found with incorrect syntax - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Invalid flight level in bracket logic : [route element] 
Description: An invalid altitude was specified in route bracket logic - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Invalid route format ([route element]) 
Description: A route element within the route was determined to have an incorrect format - target will 

be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Invalid runway format : "[runway value]" 
Description: An invalid runway was specified within a route - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Invalid speed in bracket logic : [route element] 
Description: An invalid speed was specified in route bracket logic - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Route error : Runway specified with non-end fix 
Description: Route specifies a runway for other than the first or last fix - this target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Unsupported nav equip : [navigation equipment type] defaulting to A 
Description: (Warning) An unsupported navigation equipment type was specified in the import file - 

default value used instead. 
Resolution: Investigate/correct errors in import data. 
    
Message: Unsupported nav type : [navigation type] defaulting to P 
Description: (Warning) An unsupported navigation type was specified in the import file - default value 

used instead. 
Resolution: Investigate/correct errors in import data or in working scenario, if desired. 
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Message: Unsupported start type : [start type value] 
Description: An unsupported start type was specified in the import file - target will be ignored. 
Resolution: Investigate/correct errors in import data. 
    
Message: Unsupported type : [aircraft type value] 
Description: An aircraft type was specified in the import file that does not exist in adaptation for the 

scenario - target will be ignored. 
Resolution: Investigate/correct errors in import data or scenario adaptation. 

12.3. Import SAR Errors 
Message: ([timestamp]) error setting route on [target]: [CREATE ROUTE error] 
Description: Import file contains a target with an invalid route. 
Resolution: Investigate/correct errors in import data. 
    
Message: [time]: error creating tgt from ([message text]): Invalid field 4 
Description: Invalid beacon code specified in import data. 
Resolution: Investigate/correct errors in import data. 
    
Message: [time]: error creating tgt from ([message text]): Invalid field 5 
Description: Invalid speed specified in import data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [time]: error creating tgt from ([message text]): Invalid route [text]: [CREATE ROUTE 
error] 

Description: Import file contained a target with an invalid route. 
Resolution: Investigate/correct errors in import data. 
    
Message: [time]: unrecognized nadin device ([device name]). Ignoring msg. 
Description: Import data references an unknown NADIN device. 
Resolution: Investigate/correct errors in import data. 
    

Message: [time]: warning creating tgt from ([message text]): AChar [aircraft] not found, added to 
scenario. 

Description: (Warning)  
Resolution: n/a 
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Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid Field 10 [route value] 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 2 ([aircraft ID value]) 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 3 ([aircraft type value]) 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 5 [speed value] 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 6 ([coordination fix 
value]) ([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 7 ([time value]) 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ FP Invalid field 8/9 ([altitude value]) 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ Invalid AID [aircraft ID value] 
([message text]) 

Description: Import file contains invalid flight plan data. 
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Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ Invalid field [number] [field value] 
([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ No adapted FIRB found for incoming 
ICAO flight ([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ No FIRB found for incoming ICAO 
flight ([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    
Message: [timestamp]: -----REFORMAT FPL ERROR------ Short FPL/CPL msg ([message text]) 
Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    
Message: [timestamp]: -----REFORMAT FPL ERROR------ Short msg ([message text]) 
Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    

Message: [timestamp]: -----REFORMAT FPL ERROR------ SPP could not be found on inbound 
ICAO flight ([message text]) 

Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    
Message: [timestamp]: -----REFORMAT FPL ERROR------ VFR flevel. ([message text]) 
Description: Import file contains invalid flight plan data. 
Resolution: Investigate/correct errors in import data. 
    
Message: Couldn't find (at least one of) NA, IN, SW, SY, AN, or SC 
Description: At least one required table was not found on SAR tape. 
Resolution: Investigate/correct errors in import data. 
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Message: dummy read returned [status], expected 0!!! 
Description: An fatal error occurred while reading the tape header. 
Resolution: Repeat using another tape drive or tape, if feasible. 
    
Message: Duplicate equip name [name] in [adaptation] 

Description: (Warning) Import data contains duplicate equipment, or equipment already in scenario 
adaptation. 

Resolution: Modify/remove duplicate item in import data or working scenario, if desired. 
    
Message: Error creating TK route for [target] 
Description: Import data contains invalid route information. 
Resolution: Investigate/correct errors in import data. 
    
Message: Error opening [filename]: [OS error description] 
Description: An error occurred opening the specified file. 

Resolution: Check user, directory, and file permissions. See OS documentation for explanation of OS 
error. 

    
Message: Error reading label. 
Description: An error occurred while attempting to read the tape label. 
Resolution: Repeat using another tape drive or tape, if feasible. 
    
Message: Failed to run: [failure details] 
Description: SAR data could not be imported from the requested Job Shop source. 
Resolution: Check connectivity with job shop. 
    
Message: Library label empty. 
Description: A library label must be specified when importing SAR from tape. 
Resolution: Specify a valid library label and retry. 
    
Message: NO ETX!!! 
Description: Invalid import data. 
Resolution: Investigate/correct errors in import data. 
    
Message: No files have been selected. 
Description: No SAR files have been selected for import. 
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Resolution: Select a file and try again. 
    
Message: No setting for jobshop executable 
Description: Location of jobshop executable is not properly specified in the resource file. 
Resolution: Re-install or configure application; contact support if problem persists. 
    
Message: NO STX!!! 
Description: Invalid import data. 
Resolution: Investigate/correct errors in import data. 
    
Message: Password field empty. 
Description: A valid user ID and password must be specified to connect to the Job Shop. 
Resolution: Specify valid user ID and password and retry. 
    
Message: Tape label empty. 
Description: A tape label must be specified when importing SAR from tape. 
Resolution: Specify a valid tape label and retry. 
    
Message: Unknown segcode 0x[segcode] at offset 0x[physical buffer address] 
Description: An error occurred while reading a record from tape. 
Resolution: Repeat using another tape drive or tape, if feasible. 
    
Message: User ID field empty. 
Description: A valid user ID and password must be specified to connect to the Job Shop. 
Resolution: Specify valid user ID and password and retry. 
    
Message: Warning! Empty EQUIP 
Description: Import data contains invalid equipment information. 
Resolution: Investigate/correct errors in import data. 

12.4. Import RTF SIM Errors 
Message: [target]: Error creating route: [CREATE ROUTE error] 
Description: (Warning) Invalid route found for target in import file. 
Resolution: Investigate/correct errors in import data. 
    
Message: Error - Invalid Acid: [aircraft ID] 
Description: Import file contains a target with an invalid aircraft ID. 
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Resolution: Investigate/correct errors in import data. 
    
Message: File [filename] not found. 
Description: Import file could not be found or was not a regular file. 
Resolution: Check file selection; verify user and file-permissions; check file format. 
    
Message: Warning AChar [aircraft type] for [target] does not exist 
Description: (Warning) Import file contains an unknown aircraft type. 
Resolution: Investigate/correct errors in import data. 
    
Message: Warning Target: [target] has invalid Altitude: [altitude] 
Description: (Warning) Import file contains a target with an invalid altitude. 
Resolution: Investigate/correct errors in import data. 
    
Message: Warning Target: [target] has invalid BCN: [beacon code] 
Description: (Warning) Import file contains a target with an invalid beacon code. 
Resolution: Investigate/correct errors in import data. 
    
Message: Warning Target: [target] has invalid CTime: [time] 
Description: (Warning) Import file contains a target with an invalid coordination time. 
Resolution: Investigate/correct errors in import data. 
    
Message: Warning Target: [target] has invalid Speed: [speed] 
Description: (Warning) Import file contains a target with an invalid speed. 
Resolution: Investigate/correct errors in import data. 

12.5. Scenario Edit Errors 
Message: "[item]" could not be found. 
Description: (Warning) The specified item could not be found in adaptation. 
Resolution: n/a 
    
Message: ([radar name]) something's seriously wrong in changeRadarList! 
Description: Unexpected program error. 
Resolution: Note circumstances; contact support. 
    
Message: [aircraft] is read only 
Description: (Warning) Cannot modify a read-only aircraft. 
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Resolution: n/a 
    
Message: [CREATE ROUTE error] 
Description: (Warning) An error occurred attempting to create the route. 
Resolution: See resolution for specific error message in CREATE ROUTE error table. 
    
Message: [target name] is read only 
Description: (Warning) Cannot modify a target that is read-only. 
Resolution: n/a 
    
Message: Adapted achars may not be deleted. 
Description: self-explanatory 
Resolution: Remove from adaptation if item must be deleted. 
    
Message: Adapted equipment may not be deleted. 
Description: self-explanatory 
Resolution: Remove from adaptation if item must be deleted. 
    
Message: Adapted radar may not be deleted. 
Description: self-explanatory 
Resolution: Remove from adaptation if item must be deleted. 
    
Message: Adapted radar msg may not be deleted. 
Description: An adapted radar message may not be deleted. 
Resolution: Remove from adaptation if item must be deleted. 
    
Message: Cannot add AChar [aircraft type] 
Description: (Warning) A problem occurred while attempting to add the specified aircraft. 

Resolution: Ensure aircraft characteristics are valid and completely filled in; ensure aircraft is not a 
duplicate of aircraft already known to scenario adaptation. 

    
Message: Cannot add Equip '[name]' 
Description: A problem occurred attemtping to add the specified equipment to adaptation. 
Resolution: Ensure name and LDN values are not a duplicates of existing equipment. 
    
Message: Cannot add Radar '[radar]': Duplicate radar name [radar] in [adaptation] 
Description: self-explanatory 
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Resolution: Choose a different radar name. 
    
Message: Cannot add RSI '[description]' 
Description: (Warning) A problem occurred adding the specified RSI. 
Resolution: Ensure value and description are valid and are not duplicates of existing RSI. 
    

Message: Cannot have multiple time intervals without a Stop time. [linebreak] ([start time] - None) 
already exists. 

Description: (Warning) Only one 'open-ended' radar message interval is allowed and new intervals may 
not overlap any existing interval. 

Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: Change equip failed: [equip name] not found. 
Description: Specified equipment cannot be located. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Change position failed: [position name] not found. 
Description: Cannot change a non-existent position. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Change Site Definition failed: [site] not found. 
Description: (Warning) Site cannot be found. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Change Site Definition failed: [site]'s Adaptation [name] not found. 
Description: (Warning) Adaptation for the new site is not found. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Duplicate achar name [aircraft] not allowed. 
Description: (Warning) Cannot add a duplicate aircraft. 
Resolution: n/a 
    
Message: Duplicate equip [name] in [adaptation] 
Description: (Warning) Equipment name must be unique within a given adpatation. 
Resolution: n/a 
    
Message: Duplicate equip [position name] in sector position [sector ID] 
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Description: Cannot add a position with the same name to the same sector. 
Resolution: Choose a different name. 
    
Message: Duplicate equip name [position] in sector position [sector ID] 
Description: Cannot add a position with the same name to the same sector. 
Resolution: Choose a different name. 
    
Message: Duplicate Rsi description not allowed. [RSI description] already exists. 
Description: (Warning) Cannot modify RSI description to a value that already exists. 
Resolution: Use a different description. 
    
Message: Duplicate Rsi not allowed. [RSI value] already exists. 
Description: (Warning) Cannot modify RSI value to a value that already exists. 
Resolution: Use a different value. 
    
Message: Duplicate sector id [value] in [adaptation] 
Description: Cannot add duplicate sector IDs to a single adaptation. 
Resolution: Choose a different sector ID and re-attempt. 
    
Message: Empty achar name 
Description: Aircraft name may not be blank. 
Resolution: Use a non-blank aircraft name. 
    
Message: Error deleting [system command] 
Description: An error occurred while attempting to delete a system command. 

Resolution: Note the scenario and system command value; reattempt; contact support if problem 
persists. 

    
Message: Error processing [pre-programmed event] 
Description: (Warning) Cannot locate pre-programmed event to be modified. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Error processing [prompt] 
Description: (Warning) Prompt to be modified cannot be located. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    
Message: Error processing [system command] 
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Description: (Warning) Cannot locate the specified system command. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
    

Message: New interval ([start time] - [stop time]) overlaps another interval ([start time] - [stop 
time]). 

Description: (Warning) New radar message intervals may not overlap existing intervals. 
Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: Only the last interval can be without a Stop time. 

Description: (Warning) A radar message time interval with 'none' for a stop time must start after all 
other existing intervals end. 

Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: PreProgEvent is read-only 
Description: (Warning) Cannot modify a read-only pre-programmed event. 
Resolution: n/a 
    
Message: Profile Already Exists 

Description: (Warning) An identical aircraft behavior profile already exists - new profile will not be 
added. 

Resolution: n/a 
    
Message: Prompt is read-only 
Description: (Warning) Cannot modify a read-only prompt. 
Resolution: n/a 
    
Message: RadarDialog::& - invalid Type index [index] 
Description: Unknown type of radar specified during edit. 
Resolution: Choose a radar type from the dropdown box and re-attempt. 
    
Message: RadarDialog::syncRadarState - invalid Type index [index] 
Description: Unknown type of radar specified during edit. 
Resolution: Choose a radar type from the dropdown box and re-attempt. 
    
Message: RdrMsgDialog::setMsgType - error converting word 0 
Description: Unexpected value for word 0 of radar message. 
Resolution: Ensure value for word 0 is between 0 and FFF hex. 
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Message: RdrMsgDialog>> - error converting word [index] 
Description: Unexpected value for a data word of a radar message. 
Resolution: Ensure value for word 0 is between 0 and FFF hex. 
    
Message: RdrStsDialog& - error setting PSRState - unknown state: [state] 
Description: Unexpected error - unknown state specified in dialog. 
Resolution: Re-attempt using value from dropdown selector. 
    
Message: RdrStsDialog& - error setting SSRState - unknown state: [state] 
Description: Unexpected error - unknown state specified in dialog. 
Resolution: Re-attempt using value from dropdown selector. 
    
Message: Start time ([time]) occurs during another interval ([start time] - [stop time]). 
Description: (Warning) New radar message intervals may not overlap existing intervals. 
Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: Start time ([time]) occurs during another interval without a Stop time ([start time] - None). 
Description: (Warning) New radar message intervals may not overlap existing intervals. 
Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: Stop time ([time]) occurs during another interval ([start time] - [stop time]). 
Description: (Warning) New radar message intervals may not overlap existing intervals. 
Resolution: Ensure new interval does not overlap existing intervals and re-attempt. 
    
Message: System cmd is read-only 
Description: (Warning) Cannot modify a read-only system command. 
Resolution: n/a 
    
Message: System cmd is read-only 
Description: Can't remove a read-only system command. 
Resolution: n/a 
    
Message: Target [name] does not exist 
Description: (Warning) Cannot delete/modify a target that doesn't exist. 
Resolution: Input inconsistency - reattempt; note circumstances and contact support if problem persists. 
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12.6. Scenario Save Errors 
Message: [OS error description] 
Description: (Warning) The OS could not perform the requested directory/file operation. 
Resolution: Consult OS documentation for resolution of the OS error. 
    
Message: Error Saving display [viewer name]: Error opening [weather file] 
Description: The specified weather file cannot be written to. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Error Saving display [viewer name]: Saving has been disabled. 
Description: This application does not support saving display values. 
Resolution: Contact support. 
    
Message: Failed to create [filename]: [OS error description] 
Description: The specified filename could not be written. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create achar.xml: [OS error description] 
Description: I/O error attempting to write the aircraft characteristics file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create pilotPositions.xml: [OS error description] 
Description: I/O error attempting to write the pilot postions file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create prefs.xml: [OS error description] 
Description: I/O error attempting to write the scenario preferences file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create prompts.xml: [OS error description] 
Description: I/O error attempting to write the prompts file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 
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Message: Failed to create rsi.xml: [OS error description] 
Description: I/O error attempting to write the RSI file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create scenario.xml: [OS error description] 
Description: I/O error attempting to write the scenario file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create syscmds.xml: [OS error description] 
Description: I/O error attempting to write the system commands file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to create tgts.xml: [OS error description] 
Description: I/O error attempting to write the targets file. 

Resolution: Check user, directory, and file permissions; check disk capacity; consult OS 
documentation. 

    
Message: Failed to eject 
Description: CD could not be ejected. 
Resolution: Manually eject the CD.  
    
Message: Permission Denied. 
Description: User does not have permission to create the new directory that was requested. 
Resolution: Check user, directory, and file permissions. 
    
Message: Process Failed: [OS error description] 
Description: An error occurred attempting to launch a separate process to perform the requested action. 

Resolution: Check system health, memory, paging, etc. Consult OS documentation for details on the 
specific OS error. Reboot processor. Contact support if problem persists. 

    
Message: QRadar::save - invalid Type value [radar type] 
Description: A radar with an invalid type cannot be saved. 

Resolution: Examine radar type using scenario editor, select new type from dropdown selector if 
necessary, and re-save. 
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12.7. Scenario Open Errors 
Message: [filename] does not exist 
Description: Display file specified in scenario config does not exist. 

Resolution: Determine whether the specified file has been moved or deleted. Restore from backup if 
possible. 

    
Message: Config file [filename] not found. 
Description: The specified config file does not exist or is not accessible. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: Error decoding tangent pt [point] 
Description: The specified tangent pt could not be resolved to lat/long coordinates. 
Resolution: Config file may be damaged or corrupt. Restore from backup if possible. 
    
Message: Error parseing config file: [error message] 
Description: Invalid XML detected in scenario config file. 
Resolution: Examine scenario.xml file and correct errors, or create new scenario. 
    
Message: No display file specified in config file. 
Description: Display file could not be determined while processing the scenario config file. 
Resolution: Check whether latest version of the application is being run. 
    
Message: No file specified in achar config line 
Description: Scenario config file does not reference a valid aircraft characteristics file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No file specified in adaptation config line 
Description: Scenario config file does not reference a valid adaptation file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Adaptation may not be installed 
properly. 

    
Message: No file specified in pilotPositions config line 
Description: Scenario config file does not reference a valid pilot positions file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 
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Message: No file specified in prefs config line 
Description: Scenario config file does not reference a valid scenario preferences file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No file specified in prompts config line 
Description: Scenario config file does not reference a valid prompts file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No file specified in rsi config line 
Description: Scenario config file does not reference a valid RSI file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No file specified in syscmds config line 
Description: Scenario config file does not reference a valid system commands file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No file specified in tgts config line 
Description: Scenario config file does not reference a valid targets file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: No processor group info found for sector [sector id] 
Description: A sector is defined without a processor group (equipment) assigned to it. 
Resolution: Edit the adaptation files. 
    
Message: No tangent specified for display 
Description: Scenario config file does not specify a value for display tangent. 
Resolution: Config file may be damaged or corrupt. Restore from backup if possible. 
    
Message: parseDisplay error: invalid llgrid parameters 
Description: Scenario config file contains invalid or incomplete lat/long grid parameters. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 
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Message: parseDisplay error: no adaptation name specified 
Description: Scenario config file does not specify the adaptation name. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: parseDisplay error: no binmap file specified 
Description: Scenario config file contains incomplete binary map file information. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: parseDisplay error: no dbmap file specified 
Description: Scenario config file contains incomplete DB map file information. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: parseDisplay error: no map file specified 
Description: Scenario config file contains incomplete map file information. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: parseDisplay error: no noaamap file specified 
Description: Scenario config file contains incomplete NOAA map file information. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: parseDisplay error: no wx file specified 

Description: Scenario config file contains partial weather information but does not specify a weather 
file. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: Scenario open error: couldn't change directory to [directory] 
Description: The specified directory does not exist or is not accessible. 
Resolution: Check user, directory, and file-permissions.  
    
Message: Scenario open error: couldn't find valid scenario config file 

Description: The scenario cannot be opened because the necessary config file(s) do not exist or are not 
accessible. 
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Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

    
Message: wx: no directory specified 
Description: Scenario config file does not reference a valid directory for weather. 

Resolution: Scenario data may be invalid, out-of-date, or corrupt. Create new scenario or restore 
scenario from backup if possible. 

12.8. Scenario Manager Errors 
Message: [new scenario directory] [OS error description] 
Description: An error occurred attempting to create the specified scenario directory. 

Resolution: Check disk capacity, user, file, and directory permissions. See OS documentation for OS 
error details. 

    
Message: [OS error description] 
Description: An error was returned by the OS when attempting a file operation (copy, rename, delete). 
Resolution: See OS documentation. 
    
Message: Cannot Move files to CDROM 
Description: Scenario(s) should only be copied to CDROM, moving them to CDROM is not allowed. 
Resolution: Copy instead of move. 
    
Message: Deletion Failed 
Description: Scenario could not be deleted by the scenario manager. 
Resolution: Check user, directory, and file-permissions. 
    
Message: Failed to copy scenario ! 

Description: An error occurred attempting to copy or move the scenario. Details may be available by 
clicking the 'Details' button. 

Resolution: Examine details for the nature of the error. Copy manually. 
    
Message: Failed to create process 
Description: An error occurred attempting to launch a process to archive the scenario to USB device. 
Resolution: Check that USB device is attatched and functioning properly. Check processor health. 
    
Message: Failed to set permissions on "[new scenario directory]" 

Description: New scenario directory could not be assigned the appropriate file-permissions after it was 
created. 
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Resolution: Ensure user running application has sufficient authority for this action. 
    
Message: Failed to start cd recording process. 
Description: A problem occurred attempting to access the CD drive for recording. 
Resolution: Ensure CD drive is functioning properly; re-attempt. Ensure valid CD is present in drive.  
    
Message: Failed to start copy process 
Description: An error occurred attempting to launch a process to copy the scenario. 

Resolution: Check processor health (memory, CPU, users, paging). Restart application or reboot 
processor as necessary. 

    
Message: Permission Denied 

Description: User attempted to copy/move/delete a scenario from/to a directory where user process does 
not have write permission. 

Resolution: Check and correct user, file, and directory permissions. 
    

Message: Process one : [error details for input process] Process two : [error details for output 
process] 

Description: Details may be available for input/output processes for certain scenario manager errors. 
Resolution: Record details for advanced troubleshooting/problem resolution. 
    
Message: This scenario is too large to fit on a CD. 
Description: self-explanatory 

Resolution: Copy to fixed or network disk instead. Manually compress/tar scenario files to one or more 
CDs. 

12.9. Import GSGT Scenario Errors 
Message: [aircraft characteristic] is read only 
Description: Aircraft characteristic data is read only. 
Resolution: Adapted aircraft cannot be modified by an import. 
    
Message: [target name] Failed: achar [aircraft name] does not exist in scenario 
Description: The specified aircraft characteristics record was not found in the scenario. 
Resolution: Correct error in import scenario. 
    
Message: [target name] Failed: pilot position [position name] does not exist in scenario 
Description: An unknown pilot position was specified in the import file. 
Resolution: Correct error in import scenario. 
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Message: [target name]'s achar [aircraft name] failed to import 

Description: The specified aircraft characteristics record was not found in scenario and could not be 
added. 

Resolution: Add record manually, or correct in import scenario. 
    
Message: [target name]'s pilot position [position name] failed to import 

Description: An unknown pilot position was specified in the import file, but could not be added to the 
scenario. 

Resolution: Correct error in import scenario. 
    
Message: Adaptation ([name]) invalid. Msg Failed: [message text] 

Description: Adaptation for a system command being imported was invalid - system message will not 
be imported. 

Resolution: Correct error in import scenario or add message manually. 
    
Message: Adaptation ([name]) invalid: Msg: ([text]) ignored 

Description: (Warning) The import scenario contained a target message that referenced an invalid 
adaptation. 

Resolution: Correct error(s) in import scenario. 
    
Message: Duplicate achar name [achar name] not allowed. 

Description: An aircraft characteristic with the same name already exists. Cannot create duplicate 
achars. 

Resolution: Ignore the error (since the aircraft exists), or modify/remove the duplicate aircraft from 
import or working scenario. 

    
Message: Duplicate AChar name [aircraft] 
Description: (Warning) An attempt was made to add a duplicate aircraft while importing a scenario. 
Resolution: Ignore warning, or remove/modify the duplicate entry from import or working scenario. 
    
Message: Duplicate rsi description [description text] 

Description: (Warning) An attempt was made to add an RSI with the same description as an existing 
RSI during scenario import. 

Resolution: Resolve RSI duplicates in import and working scenarios and re-attempt. 
    
Message: Duplicate rsi value [ID] 
Description: (Warning) An attempt to add an RSI with the same numeric ID as an existing RSI during 
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scenario import. 
Resolution: Resolve RSI duplicates in import and working scenarios and re-attempt. 
    
Message: Equipment ([name]) invalid. Msg Failed: [message text] 
Description: A system command being imported referenced unknown equipment for this scenario. 
Resolution: Correct error(s) in import scenario. 
    
Message: Equipment ([name]) invalid: Msg: ([text]) ignored 

Description: (Warning) The scenario being imported contains a message that references an invalid 
equipment name. 

Resolution: Correct error(s) in import scenario. 
    
Message: Error adding RSI [tag description] 

Description: An RSI with the specified description text could not be added while importing the GSGT 
scenario. 

Resolution: Attempt to open import scenario directly, correct errors, retry the import. 
    
Message: Error creating route for [target]: [CREATE ROUTE error]. Setting route to 0.... 

Description: (Warning) An error occurred attempting to add the route for the specified target during 
scenario import. 

Resolution: Correct error(s) in import scenario. 
    
Message: Rsi [identifier] does not have a description 

Description: (Warning) An attempt was made to add an RSI with no description to the scenario during 
import. 

Resolution: Ignore warning, or manually correct the error in the import or working scenario. 
    
Message: Rsi not populated 
Description: An attempt was made to add a null RSI to the scenario during import. 

Resolution: Import scenario data may be invalid or corrupt. Examine and correct errors in import 
scenario. 

    
Message: Rsi value [ID] out of range 

Description: (Warning) An attempt was made to add an RSI with an out of range numeric ID during 
scenario import. 

Resolution: Import scenario data may be invalid or corrupt. Examine and correct errors in import 
scenario. 
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Message: Setting sector [ID] to LIVE mode (for PilotPosition [position name]) 

Description: (Warning) A sector that was not LIVE in the current scenario is being set to LIVE by the 
import. 

Resolution: Reset mode in working scenario if desired. 
    
Message: Tried to add null Aircraft Characteristic 
Description: Importing the scenario caused an attempt to add a null aircraft to the scenario. 

Resolution: Import scenario data may be invalid or corrupt. Examine and correct errors in import 
scenario. 

12.10. Scenario New / Open Errors 
Message: [OS error description] 
Description: (Warning) The OS could not perform the requested directory/file operation. 
Resolution: Consult OS documentation for details on the specific error. 
    

Message: [target name] error adding [event]: Can't add heading change events to [target name]: target 
has a route 

Description: Invalid saved scenario data - heading change events cannot be added for a target with a 
route. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: [target name] error adding [event]: No condition specified 
Description: Saved scenario data specifies a target event with no condition. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: [target name] error adding [event]: Tgtevent position [name] not found in target route 
Description: Invalid saved scenario data - the specified position cannot be found in the target route. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    

Message: [target name] error adding [event]: Tgtevent position [name] specified on target with no 
route 

Description: Invalid saved scenario data - an event for a specific position cannot be added for a target 
with no route. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 
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Message: [target name] error adding [event]: Tgtevent time [time] is earlier than target starttime 

Description: An invalid time was specified for a target event in saved scenario data - target event cannot 
be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: [target name] error adding [event]: Unknown tgt event type "[value]" 
Description: Saved scenario data specifies an unknown target event. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: [target name] flevel changed from [altitude] to [altitude] 
Description: (Warning) Altitude was adjusted for the target as indicated. 
Resolution: Saved scenario contained invalid data: save, re-open, and note whether problem persists. 
    
Message: [target name]: unrecognized line [tag name] 
Description: A line in the targets file was not recognized. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: AChar [aircraft name] not found, added to scenario. 
Description: (Warning) Aircraft characteristics record for the specified aircraft was added. 
Resolution: n/a 
    
Message: Adaptation and Aces hostname mismatch: adaptation is [host name], aces is [host name] 
Description: Adaptation XML and ACES files specify different values for host name. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: ALTSTR table not found. 
Description: ACES file does not contain an ALTSTR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Block [number] error. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Couldn't change working directory to [scenario directory]: [OS error description] 
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Description: (Warning) An error occurred attempting to change to the specified scenario directory. 
Resolution: Check user, directory, and file-permissions. Consult OS documentation. 
    
Message: Couldn't create scenario [directory]: [OS error description] 
Description: (Warning) An error occurred attempting to create a new scenario directory. 
Resolution: Check disk capacity, user, directory, and file-permissions. Consult OS documentation. 
    
Message: Couldn't determine tangent info from file. 
Description: Tangent information not specified in ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Directory [name] does not exist. 
Description: The adaptation directory does not exist or cannot be accessed. 
Resolution: Ensure directory exists, and that user, directory, and file-permissions are appropriate. 
    
Message: Duplicate AChar name [aircraft] 
Description: (Warning) duplicate aircraft record cannot be added. 

Resolution: Saved scenario data may have contained duplicate aircraft records. Save and re-open 
scenario. 

    
Message: Duplicate Pilot Position name [position] 
Description: (Warning) duplicate pilot positions will not be added to scenario. 
Resolution: n/a - warning only 
    
Message: Duplicate rsi description [description] 
Description: (Warning) Scenario import data specifies more than one RSI with the same description. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Duplicate rsi value [identifier] 
Description: (Warning) Scenario import data specifies more than one RSI with the same identifier. 
Resolution: Duplicates are not imported: save and re-open scenario, if problem persists contact support. 
    
Message: EOF reading bds. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 
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Message: EOF reading block [number] 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: EOF reading bms. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: EOF reading es. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: EOF reading gds. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: EOF reading pds. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding msg ([message content]) to target [name]: Invalid host/device [host]/[device] 

Description: An unknown device was specified for a message in saved scenario data - message cannot 
be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error adding msg ([message content]) to target [name]: Invalid msg time 

Description: An invalid time was specified for a message in saved scenario data - message cannot be 
added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 
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Message: Error adding msg ([message content]) to target [name]: No device specified 
Description: No device was specified for a message in saved scenario data - message cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error adding msg ([message content]) to target [name]: No time specified 
Description: No time was specified for a message in saved scenario data - message cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error adding msg ([message content]) to target [name]: Unknown adaptation [host name] 

Description: An unknown host name was specified for a message in saved scenario data - message 
cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error adding pilot position: No name specified 
Description: Pilot position data specifies a position with a null name. 
Resolution: Saved scenario may be corrupted: restore from backup or create new scenario. 
    
Message: Error adding pre programmed event ([event]): Invalid preprogevent time 
Description: Saved scenario data contains a preprogrammed event with an invalid time. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding pre programmed event ([event]): No time specified 
Description: Saved scenario data contains a preprogrammed event with no time. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding prompt ([prompt]): Invalid prompt time 
Description: Scenario prompts input file contains prompt with an invalid time. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding prompt ([prompt]): No address specified 
Description: Scenario prompts input file contains a prompt with no address. 
Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
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scenario. 
    
Message: Error adding prompt ([prompt]): No time specified 
Description: Scenario prompts input file contains prompt where no time is specified. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding site definition ([site name]): Adaptation [name] does not exist in scenario 
Description: Scenario file contains a site definition that specifies an unknown adaptation. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding site definition ([site name]): No Adaptation specified 
Description: Scenario file contains a partial site definition but no adaptation is specified. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding static message for [radar name] 
Description: Static message could not be added for the specified radar. 

Resolution: Check for missing messages for specified radar, make additions/corrections, save/re-save 
scenario. 

    
Message: Error adding syscmd ([command]): Invalid host/device [host]/[device] 
Description: Saved scenario data contains a system command that references an unknown device. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding syscmd ([command]): Invalid msg time 
Description: Saved scenario data contains a system command with an invalid time. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding syscmd ([command]): No device specified 
Description: Saved scenario data contains a system command where no device is specified. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding syscmd ([command]): No time specified 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 282   

Description: Saved scenario data contains a system command with no time specified. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding syscmd ([command]): Unknown adaptation [name] 
Description: Saved scenario data contains a system command that references an unknown adaptation. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error adding target [name]: [error message] 
Description: A problem occurred while attempting to 'load' the specified target into the scenario. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    

Message: Error adding time interval to static message for radar [name] : Cannot have multiple time 
intervals without a Stop time. ([start time] - None) already exists. 

Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - no errors should occur. 

    

Message: Error adding time interval to static message for radar [name] : New interval ([start time] - 
[stop time]) overlaps another interval ([start time] - [stop time]). 

Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - error should not recur. 

    

Message: Error adding time interval to static message for radar [name] : Only the last interval can be 
without a Stop time. 

Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - error should not recur. 

    

Message: Error adding time interval to static message for radar [name] : Start time ([time]) occurs 
during another interval ([start time] - [stop time]). 

Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - error should not recur. 

    
Message: Error adding time interval to static message for radar [name] : Start time ([time]) occurs 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 283   

during another interval without a Stop time ([time] - None). 
Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - error should not recur. 

    

Message: Error adding time interval to static message for radar [name] : Stop time ([time]) occurs 
during another interval ([start time] - [stop time]). 

Description: Scenario data contains overlapping static message time intervals. 

Resolution: Check scenario for missing static radar messages or missing intervals, add as necessary, 
and save/re-save scenario. Re-open scenario - error should not recur. 

    
Message: Error creating target [name]: [CREATE ROUTE error] 
Description: An invalid route was specified for a target in saved scenario data - target cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error creating target [name]: [target] flevel adjusted from [altitude] to [altitude] 

Description: (Warning) An aircraft type was specified for a target in saved scenario data - target cannot 
be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error creating target [name]: Invalid achar [aircraft type] 
Description: An aircraft type was specified for a target in saved scenario data - target cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error creating target [name]: Invalid start time 

Description: An invalid start time was specified for a target in saved scenario data - target cannot be 
added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error creating target [name]: No target name specified 
Description: No name was specified for a target in saved scenario data - target cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error creating target [name]: No time specified 
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Description: No time was specified for a target in saved scenario data - target cannot be added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error decoding position [position] 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error decoding tangent [tangent value] 
Description: Specified tangent value is invalid in ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Error finding static message [radar name] for [radar name] 
Description: Error locating static message by adapted index. 

Resolution: Check for missing messages for specified radar, make additions/corrections, save/re-save 
scenario. 

    
Message: Error initializing static message [radar name] for [radar name] 
Description: Static message could not be initialized for the specified radar. 

Resolution: Check for missing messages for specified radar, make additions/corrections, save/re-save 
scenario. 

    
Message: Error opening [filename]: [error message] 
Description: An error occurred opening the specified file. 
Resolution: Ensure specified file exists and user (application) has sufficient permission to access. 
    
Message: Error opening grib file [filename]: [error message] 
Description: The specified file could not be opened. 
Resolution: Ensure specified file exists; check user, directory, and file-permissions. 
    
Message: Error parsing [filename]. 
Description: An error was encountered while parsing the specified adaptation file. 
Resolution: EADP data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Error parsing [filename]: Unknown FIX_RECORD field [name] 
Description: An unknown element was encountered within a fix record. 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 285   

Resolution: EADP data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Error parsing [filename]: Unknown FixType [type] record, Fix [name]. 
Description: EADP product contains an unknown fix type for the specified fix. 
Resolution: EADP data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Error parsing achar file [filename]. 
Description: An error occurred while parsing the specified aircraft characteristics file. 
Resolution: Scenario or adaptation data may be corrupted: restore from backup or create new scenario. 
    
Message: Error parsing adaptation file [filename]. 
Description: An error occurred while parsing adaptation - the scenario cannot be opened/created. 

Resolution: Check user, directory, and file-permissions for adaptation data. Make sure specified file 
exists. 

    
Message: Error parsing pilot position file [filename] 
Description: An error occurred while parsing the specified pilot positions file. 
Resolution: Saved scenario may be corrupted: overwrite, restore from backup or create new scenario. 
    

Message: Error parsing precip file [filename], pass 2: Error determining parameters for [filename]. 
ignoring. 

Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error parsing preferences file [filename]. 
Description: An error occurred while parsing the specified preferences file. 
Resolution: Saved scenario may be corrupted: overwrite, restore from backup or create new scenario. 
    
Message: Error parsing prompt file [filename]. 
Description: An error occurred while processing the specified scenario input file. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error parsing ruc file [filename], ignoring. 
Description: RUC file contains improperly formed XML. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 
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Message: Error parsing site definition file [filename]. 
Description: An error occurred while processing the specified scenario input file. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error parsing syscmds file [filename] 
Description: System commands scenario file could was not processed successfully. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error parsing target file [filename]. 
Description: An error occurred while parsing the specified scenario file. 
Resolution: Saved scenario may be corrupted: overwrite, restore from backup or create new scenario. 
    
Message: Error parsing target file [filename]. 
Description: Saved scenario data contains invalid target data. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error parsing wx file [filename]: [error message]. (line [number], col [number]) 
Description: Weather file contains improperly formed XML. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error processing [target name] route ([route]): [CREATE ROUTE error] 
Description: Saved scenario data contains a target with an invalid route. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Error processing [target] dynamics: unknown achar [aircraft type] 

Description: Invalid dynamics were specified for a target in saved scenario data - target cannot be 
added. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    

Message: Error reading bds (tried to read [decimal value] ([hex value]) bytes, read [decimal value] 
bytes 
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Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error reading bms. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error reading es. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error reading gds. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error reading is: GRIB identifier invalid. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Error reading pds. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: ERROR: [path] directory does not exist! Do you want to create it? 
Description: (Warning) self-explanatory 
Resolution: Allow application to create directory or cancel and specify new location. 
    
Message: Failed to eject 
Description: CD could not be ejected. 
Resolution: Manually eject CD. 
    
Message: FPA [FPA ID], unknown fix [fix] 
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Description: FPA table of ACES file referenced an unknown fix as part of an FPA definition. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: FPA [FPA ID], unknown major away [airway] 
Description: FPA table of ACES file referenced an unknown major airway as part of an FPA definition. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal achr option [option] ([token]). 
Description: An illegal option was specified in the ACHR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal adjcp option [option] ([token]). 
Description: An illegal option was specified in the ADJCP table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal adjfr option [option] ([token]) 
Description: An illegal option was specified in the ADJFR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal arpt option [option] ([token]), arpt [airport]. 
Description: An illegal option was specified in the ARPT table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal away option [option] ([token]), away [airway]. 
Description: An illegal option was specified in the AWAY table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal away state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the AWAY table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal crte option [option] ([token]), crte [route name] 
Description: An illegal option was specified in the CRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal crte state [state], while processing arg [token]. 
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Description: An illegal state was encountered while processing the CRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal dirte option [option] ([token]), dirte [direct route]. 
Description: An illegal option was specified in the DIRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal dirte state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the DIRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal fix option [option] ([token]). 
Description: An illegal option was specified in the FIX table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal fpa option [option] ([token]), while processing fpa [FPA ID]. 
Description: An illegal option was specified in the FPA table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmlmap option [option] ([token]), away [airway]. 
Description: An illegal option was specified in the GMLMAP table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmlmap state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the GMLMAP table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmlsda option [option] ([token]). 
Description: An illegal option was specified in the GMLSDA table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmlsda state [option], while processing arg [token]. 
Description: An illegal state was encountered while processing the GMLSDA table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmssda option [option] ([token]). 
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Description: An illegal option was specified in the GMSSDA table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal gmssda state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the GMSSDA table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal imer option [option] ([token]). 
Description: An illegal option was specified in the IMER table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal lciot option [option] ([token]). 
Description: An illegal option was specified in the LCIOT table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal ldn option [option] ([token]). 
Description: An illegal option was specified in the LDN table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal node option [option] ([token]). 
Description: An illegal option was specified in the NODE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal node state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the NODE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal par option [option] ([token]), par [route name] 
Description: An illegal option was specified in the PAR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal par state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the PAR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal parts option [option] ([token]). 
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Description: An illegal option was specified in the PARTS table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal pdar option [option] ([token]), pdar [route name]. 
Description: An illegal option was specified in the PDAR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal pdar state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the PDAR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal pdr option [option] ([token]), pdr [route name]. 
Description: An illegal option was specified in the PDR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal pdr state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the PDR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal pram option [option] ([token]). 
Description: An illegal option was specified in the PRAM table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal rsb option [option] ([token]). 
Description: An illegal option was specified in the RSB table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal rsite option [option] ([token]). 
Description: An illegal option was specified in the RSITE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal secr option [option] ([token]). 
Description: An illegal option was specified in the SECR table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal sidrte option [option] ([token]), sid [SID name]. 
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Description: An illegal option was specified in the SIDRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal sidrte state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the SIDRTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal splan option [option] ([token]). 
Description: An illegal option was specified in the SPLAN table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal starte option [option] ([token]), star [STAR name]. 
Description: An illegal option was specified in the STARTE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal starte state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the STARTE table of the ACES file 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal stereog option [option] [token] 
Description: An illegal option was specified in the STEREOG table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal subfx option [option] ([token]). 
Description: An illegal option was specified in the SUBFX table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal subfx state [state], while processing arg [token]. 
Description: An illegal state was encountered while processing the SUBFX table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Illegal tline option [option] ([token]). 
Description: An illegal option was specified in the TLINE table of the ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Invalid aces file pathname [path/filename] 
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Description: The specified path and filename cannot be resolved to locate a valid ACES file. 
Resolution: Ensure specified file exists and user (application) has sufficient permission to access. 
    
Message: Invalid achar file [filename] 
Description: The specified aircraft characteristics file does not exist or cannot be accessed. 
Resolution: Scenario data may be corrupted: restore from backup or create new scenario. 
    
Message: Invalid adaptation file [filename] 
Description: Adaptation file specified in the request to open/create a scenario does not exist. 
Resolution: Ensure adaptation data is in the expected location; check file-permissions. 
    
Message: Invalid projection type [projection type] 
Description: ACES file specified an invalid projection type. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Layer [number] error. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Local host not found. 
Description: Local host facility identification was not specified in ACES file. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: No achar files specified 
Description: Scenario configuration files do not include the location of ACHAR data. 
Resolution: Scenario configuration may be corrupted: restore from backup or create new scenario. 
    
Message: No adaptation files specified 
Description: No adaptation file specified in the request to open/create a scenario. 
Resolution: Specify an adaptation and re-attempt. 
    
Message: No Strata found. 
Description: ACES ALTSTR table does not contain any altitude strata. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Permission Denied. 
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Description: User does not have permission to create the new directory that was requested. 
Resolution: Create scenario in location where user does have permission or modify user permission. 
    
Message: Process Failed: [OS error description] 
Description: An error occurred attempting to launch a separate process to perform the requested action. 

Resolution: Check system health, memory, paging, etc. Reboot processor. Consult OS documentation 
for details on the specific OS error. Contact support if problem persists. 

    
Message: Radar [site name] not found. 
Description: ACES RSITE table specifies an unknown radar site. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Rsi [identifier] does not have a description 
Description: (Warning) Scenario import data specifies an RSI with no description. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Rsi not populated 
Description: Scenario import files specify null RSI. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Rsi value [value] out of range  
Description: (Warning) Scenario import data specifies an out of range value for an RSI. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Table ACHR not found. 
Description: ACES file does not contain ACHR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table ADJFR not found. 
Description: ACES file does not contain ADJFR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table ARPT not found. 
Description: ACES file does not contain an ARPT table. 
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Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table AWAY not found. 
Description: ACES file does not contain an AWAY table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table CRTE not found. 
Description: ACES file does not contain a CRTE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table DIRTE not found. 
Description: ACES file does not contain a DIRTE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table FIX not found. 
Description: ACES file does not contain a FIX table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table FPA not found. 
Description: ACES file does not contain an FPA table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table GMLMAP not found. 
Description: ACES file does not contain GMLMAP table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table GMLSDA not found. 
Description: ACES file does not contain GMLSDA table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table GMSSDA not found. 
Description: ACES file does not contain GMSSDA table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table IMER not found. 
Description: ACES file does not contain IMER table. 
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Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table LCIOT not found. 
Description: ACES file does not contain LCIOT table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table LDN not found. 
Description: ACES file does not contain LDN table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table NODE not found. 
Description: ACES file does not contain a NODE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table PAR not found. 
Description: ACES file does not contain a PAR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table PARTS not found. 
Description: ACES file does not contain PARTS table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table PDAR not found. 
Description: ACES file does not contain a PDAR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table PDR not found. 
Description: ACES file does not contain a PDR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table PRAM not found. 
Description: ACES file does not contain PRAM table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table RSB not found. 
Description: ACES file does not contain an RSB table. 
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Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table RSITE not found. 
Description: ACES file does not contain RSITE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table SECR not found. 
Description: ACES file does not contain SECR table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table SIDRTE not found. 
Description: ACES table does not contain a SIDRTE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table SPLAN not found. 
Description: ACES file does not contain SPLAN table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table STARTE not found. 
Description: ACES file does not contain a STARTE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table STEREOG not found. 
Description: ACES file does not include a STEREOG table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table SUBFX not found. 
Description: ACES file does not contain a SUBFX table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Table TLINE not found. 
Description: ACES file does not contain a TLINE table. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Target [name]: Invalid pilot frequency [frequency] 

Description: (Warning) Saved scenario data specifies an invalid frequency - pilot frequency will be set 
for the target. 
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Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Target [name]: No name specified for pilot position 

Description: (Warning) Saved scenario data specifies a pilot position with no name - pilot position will 
not be set for the target. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    
Message: Target [name]: Unknown pilot position [name] specified. 

Description: (Warning) Saved scenario data specifies an unknown pilot position name - pilot position 
will not be set for the target. 

Resolution: Saved scenario contains invalid data: overwrite, restore from backup or create new 
scenario. 

    

Message: The selected scenario was created by GSGT version [number]. GSGT will convert the 
scenario to version [number]. 

Description: (Information) self-explanatory 
Resolution: n/a 
    

Message: The selected scenario was created by GSGT version [number]. Loading scenarios newer 
than the current GSGT version ([number]) may produce unexpected results. 

Description: (Warning) self-explanatory 
Resolution: Exit and re-run newer version of application. 
    
Message: Tried to add null Aircraft Characteristic 
Description: ACHAR data processing resulted in null aircraft characteristic item. 

Resolution: Saved scenario or adaptation data may be corrupted: restore from backup or create new 
scenario. 

    
Message: Tried to add null Pilot Position 

Description: Attempted to add a null pilot position - this condition is normally caught when parsing the 
null data. 

Resolution: Saved scenario may be corrupted: overwrite, restore from backup or create new scenario. 
    
Message: Unknown gridName [name] 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 
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Message: Unknown Map type: [type] 
Description: Scenario config specified that a map of an unknown type be loaded. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Unknown pref route [token] specified in tline [name]. 
Description: TLINE definition specified an unknown preferred routing. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Unknown transition fix [token] specified in tline [name]. 
Description: TLINE definition specified an unknown transition fix. 
Resolution: ACES data is incomplete, invalid or corrupt. Restore from source or backup if possible. 
    
Message: Wx file: nexrad line has no file attribute. Ignoring. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Wx file: precip line missing required attribute(s). Ignoring. 
Description: A problem occurred importing weather. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

    
Message: Wx file: ruc line has no file attribute. Ignoring. 
Description: Saved scenario data does not specify location of RUC weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
scenario. 

12.11. Export SDRR - Write SIM Tape Errors 
Message: bad device [device] 
Description: Invalid device specified in export request. 
Resolution: Check device - respecify a valid export device. 
    
Message: Error creating "[directory]" : [OS error description] 
Description: An error occurred creating the specified directory for the SDRR scenario. 
Resolution: Check disk capacity and user permissions. 
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Message: error opening [filename] : [OS error description] 
Description: An error occurred creating the specified filename for the SDRR scenario. 
Resolution: Check user, directory and file permissions. 
    
Message: Error opening [filename] : [OS error description] 
Description: Could not open the specified SDRR file. 
Resolution: Ensure file exists at the specified location. Check user, directory and file permissions. 
    
Message: Error opening [filename] 
Description: Could not open the specified SDRR file. 
Resolution: Ensure file exists at the specified location. Check user, directory and file permissions. 
    
Message: Error opening [tape device] : [OS error description] 
Description: An error occurred attempting to open tape device during SDRR export. 
Resolution: Ensure tape is present, mounted and has valid label. Re-attempt on different tape device. 
    
Message: Error parsing sdrr.xml 
Description: An error occurred while parsing one of the SDRR scenario files created during export. 
Resolution: Intermediate product of export invalid or corrupt: check disk integrity, reattempt. 
    
Message: Error removing "[directory]" : [OS error description] 
Description: An error occurred removing the previous SDRR scenario directory. 
Resolution: Check file permissions and make sure directory is not in use. 
    
Message: no valid input found: no sdrr.xml in current directory, and no -d option. 
Description: Cannot create non-radar merge tape without exported SDRR scenario files. 

Resolution: Save scenario, exit application, restart and load scenario and re-attempt export. Contact 
support if problem persists. 

    
Message: OPERATION ABORTED. 
Description: User cancelled the generation of an export before it was finished. 
Resolution: n/a 

12.12. Write (Export NAS) SIM Tape Errors 
Message: Failed to run : [job and error information] 
Description: The requested job did not run successfully - job details/progress are listed. 
Resolution: Correct errors and re-attempt. 
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Message: No setting for jobshop exectuable 
Description: The setting that specifies the location of the 'Job Shop' executable is blank. 
Resolution: Re-install or configure application; contact support if problem persists. 
    
Message: Password field empty. 
Description: Must specify password to connect to the job shop. 
Resolution: Specify valid user ID and password. 
    
Message: Reference field empty. 
Description: The reference field is needed to identify this job on the host, and cannot be empty. 
Resolution: Specify reference and re-attempt. 
    
Message: User ID field empty. 
Description: User ID must be specified to connect to the job shop. 
Resolution: Specify valid user ID and password. 

12.13. Export SIME Errors 
Message: ACModel file [filename] exists. overwriting... 
Description: (Warning) Overwriting the specified file. 
Resolution: n/a 
    
Message: Could not determine release name 
Description: Adaptation release (chart date) must be provided to perform an SIME export. 
Resolution: Ensure adaptation is installed properly. 
    
Message: Error assigning equipment: [linebreak] error assigning [equipment name]: [reason] ... 

Description: (Warning) A problem occurred attempting to make the equipment assignments specified in 
the SIME export dialog. 

Resolution: Check equipment assignments in export dialog and re-attempt. 
    
Message: Error creating directory "[directory]". Aborting. 
Description: Could not create the specified directory during SIME export. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Error creating export structure in directory "[directory]". Aborting. 
Description: Could not create the specified directory under which SIME export files will be stored. 
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Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Error creating wx scenario file. 
Description: An error occurred attempting to create the weather scenario file during SIME export. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Error Opening [control filename]: [OS error description] 
Description: (Warning) The specified SIME control file could not be created/opened. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: error opening [filename]: [OS error description] 
Description: Could not create the specified file during SIME export. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Error opening ATCoach ruc file [filename] 
Description: Could not create the specified file during SIME export. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Error setting permissions for directory "[directory]". Aborting. 
Description: Could not modify file permission for the specified directory during SIME export. 
Resolution: Check user and directory permissions. 
    
Message: exportATCoach, error opening outfile: [OS error description] 
Description: Could not create the specified file during SIME export. 
Resolution: Check user and directory permissions. Check disk capacity. 
    
Message: Invalid exercise number 
Description: (Warning) SIME export attempted to use an invalid exercise number. 
Resolution: Specify valid exercise number (1-16) and re-attempt. 
    
Message: Only one real position can be assigned per console 
Description: User attempted to assign more than one real position to a console during SIME export. 
Resolution: Re-assign position(s) and re-attempt. 
    
Message: OPERATION ABORTED. 
Description: User cancelled the generation of an export before it was finished. 
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Resolution: n/a 
    
Message: Pilot Machine [name] does not exist. Any associated pilot positions will not be assigned 
Description: (Warning) Pilot positions cannot be assigned to a non-existent pilot machine. 
Resolution: Correct assignments in export dialog and re-attempt. 
    
Message: Slot has not been assigned 

Description: (Warning) During SIME export setup, an attempt was made to alter the Ops Configuration 
without specifying a valid slot. 

Resolution: Check Ops Configuration settings and re-attempt the export. 

12.14. Export FIRS Errors 
Message: OPERATION ABORTED. 
Description: User cancelled the generation of an export before it was finished. 
Resolution: n/a 

12.15. Export TGF Errors 
Message: error writing to [filename]: [OS error description] 
Description: An error occurred while attempting to write to the specified file during TGF export. 
Resolution: Check user, directory, and file permissions. Check disk capacity. 
    
Message: OPERATION ABORTED. 
Description: User cancelled the generation of an export before it was finished. 
Resolution: n/a 

12.16. Preview Errors 
Message: [target name] is read only 
Description: An error occurred attempting to delete a dropped target. 
Resolution: Exit application, restart, load scenario and re-attempt. Contact support if problem persists. 
    
Message: CFAFThread exception caught 
Description: An error occurred during preview processing. 
Resolution: Record error. Restart application. Reboot. Contact support if problem persists. 
    

Message: Error assigning output device to RSS radar [name]: [radar] error opening [surveillance 
device]: [OS error description] 

Description: An error occurred during preview processing. 
Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
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Restart application. Reboot. Contact support if problem persists. 
    

Message: Error assigning output device to RSS radar [name]: Error opening [file/dev name]: [OS 
error description] 

Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    
Message: Error assigning output device to RSS radar [name]: Illegal output format [value]. 
Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    

Message: Error creating new route [route] for [aircraft]: [CREATE ROUTE error]. Aborting 
snapshot of this target. 

Description: An error occurred attempting to delete a dropped target. 

Resolution: Examine target, correct any errors, and re-attempt. Save scenario, exit, and reload 
application. Contact support if problem persists. 

    
Message: Error creating RSS radar [name]: [radar handler name]: EOF reached on wx file 
Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    
Message: Error creating RSS radar [name]: can't determine radar type. please specify. 
Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    
Message: Error creating RSS radar [name]: Error opening [filename]: [OS error description] 
Description: Could not open the specified file. 

Resolution: 
Record error. Check user, directory, and file-permissions for the specified file. Ensure 
application is properly installed. Restart application. Reboot. Contact support if problem 
persists. 

    
Message: Error creating RSS radar [name]: Invalid input format [value]. 
Description: Surveillance radar file contains data with an invalid format. 
Resolution: Record error. Restart application. Reboot. Contact support if problem persists. 
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Message: Error creating RSS radar [name]: wx file specified on non-SRR radar 
Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    
Message: Error creating RSS radar [name]: wx file specified with RT srv device 
Description: An error occurred during preview processing. 

Resolution: Record error. Attemp preview on another scenario. Ensure application is properly installed. 
Restart application. Reboot. Contact support if problem persists. 

    
Message: Error deleting [target] 
Description: An error occurred attempting to delete a dropped target. 

Resolution: Examine target, correct any errors, and re-attempt. Save scenario, exit, and reload 
application. Contact support if problem persists. 

    
Message: Error processing [message text] 
Description: An error occurred while attempting to change the start time of the specified message. 
Resolution: Check messages for valid times, and re-attempt. Contact support if problem persists. 
    
Message: HostThread exception caught 
Description: An error occurred during preview processing. 
Resolution: Record error. Restart application. Reboot. Contact support if problem persists. 
    
Message: Received msg with error code 0x[hex value] 
Description: Informational message. 
Resolution: If message is unexpected, verify scenario content. 
    
Message: System cmd is read-only 
Description: An error occurred while attempting to change the start time of a system message. 
Resolution: Exit application, restart, load scenario and re-attempt. Contact support if problem persists. 

12.17. Reports Errors 
Message: [OS error description] 
Description: An error occurred attempting to write to a file during the generation of the report. 
Resolution: Check disk capacity. Check user and directory permissions. Consult OS documentation. 
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Message: Could not Generate Target State for [target name] 
Description: (Warning) Report may not include data for specified target. 
Resolution: Check specified target characteristics for validity, correct any errors. Re-attempt. 
    
Message: Couldn't open file for writing 
Description: (Warning) Operation could not be completed because the target file could not be opened. 
Resolution: Check disk capacity. Check user and directory permissions. 
    
Message: OPERATION ABORTED. 
Description: User cancelled the generation of a report before it was finished. 
Resolution: n/a 

12.18. Print Errors 
Message: *** 
  *** XML PARSE ERROR 
  *** line == [line] column == [column] 
  *** publicID == [ID] systemID == [ID] 
  *** message == [message] 
  *** 
Description: Print data or file contains unexpected or invalid format. 
Resolution: Regenerate data to be printed and re-attempt. 
    
Message: *** 
  *** XML PARSE FATAL ERROR 
  *** line == [line] column == [column] 
  *** publicID == [ID] systemID == [ID] 
  *** message == [message] 
  *** 
Description: Print data or file contains unexpected or invalid format. 
Resolution: Regenerate data to be printed and re-attempt. 
    
Message: *** 
  *** XML PARSE WARNING 
  *** line == [line] column == [column] 
  *** publicID == [ID] systemID == [ID] 
  *** message == [message] 
  *** 
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Description: Print data or file contains unexpected or invalid format. 
Resolution: Regenerate data to be printed and re-attempt. 
    
Message: [OS error description] 
Description: The OS encountered a file or print error - OS error description is displayed. 
Resolution: Consult OS documentation. 
    
Message: Couldn't open file for writing 
Description: (Warning) The requested file could not be opened for writing. 

Resolution: Check disk capacity/usage. Check user and directory permissions. Specify another 
location. 

    
Message: Error printing 
Description: An error occurred attempting to start the process that controls printing. 

Resolution: Ensure printer is properly configured, powered-on, and ready print. Check system health, 
reboot processor if necessary, and re-attempt. 

    
Message: ERROR: [path] directory does not exist! Do you want to create it? 
Description: (Warning) While attempting to print or display a log, the requested directory did not exist. 
Resolution: Allow application to create directory or specify new location. 

12.19. Software Update Errors 
Message: Could not determine available GSGT software update(s). 
Description: Unable to determine what GSGT software updates are available on server. 
Resolution: Check connectivity. 
    
Message: Failed to acquire version information. 
Description: Unable to determine what GSGT software updates are available on server. 
Resolution: Check connectivity. 
    
Message: Failed to determine installed version(s). 

Description: GSGT is not installed, is not installed in the expected location, or installation details cannot 
be determined. 

Resolution: Install application properly then re-attempt. 
    
Message: Installation failed : [error data] 
Description: An error occurred during installation - error detail is provided. 
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Resolution: Reboot processor, re-attempt installation, contact support if problem persists. 
    
Message: Installation failed : Unknown error 
Description: An unknown error occurred during installation. 
Resolution: Reboot processor, re-attempt installation, contact support if problem persists. 
    
Message: No installed versions of GSGT have been found. 

Description: An attempt was made to update the GSGT software without having first installed it 
properly. 

Resolution: Install application properly then re-attempt. 

12.20. Update Database Errors 
Message: An error occurred. Please read the README file in the sqltable dir for more information. 
Description: An SQL error occurred attempting to access the scenario database. 
Resolution: Consult README file for resolution. 
    
Message: Your username or password was invalid 

Description: (Warning) Invalid username or password were provided while attempting to update the 
scenario database. 

Resolution: Specify valid username and password. 

12.21. WX Open / New Errors 
Message: ** Error opening [filename]: [OS error description] 
Description: An error occurred opening the specified Nexrad weather file. 
Resolution: Ensure file exists. Check user, directory, and file permissions.  
    
Message: [number] pts. 
Description: Informational message only 
Resolution: n/a 
    
Message: Block [number] error. 
Description: Invalid format within weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Config file [filename] not found 
Description: The specified file could not be found. 
Resolution: Check user, directory, and file permissions. WX config data may be corrupt; overwrite, 
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restore or create new scenario. 
    
Message: EOF reading bds. 
Description: Gridded binary weather data has invalid binary data section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: EOF reading block [number] 
Description: Invalid format within weather data file. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: EOF reading bms. 
Description: Gridded binary weather data has invalid bitmap section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: EOF reading es. 
Description: Gridded binary weather data has invalid end section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: EOF reading gds. 
Description: Gridded binary weather data has invalid grid description section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: EOF reading pds. 
Description: Gridded binary weather data has invalid product description section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error decoding position [position] 
Description: An problem was encountered attempting to convert the given position to lat/long. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error decoding tangent pt [tangent value] 
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Description: Invalid format within weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error determining parameters for [filename] 
Description: Invalid format within weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error opening grib file [filename]: [OS error description] 
Description: An error occurred attempting to open the specified gridded binary weather file. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    

Message: Error parsing precip file [filename], pass 2: Error determining parameters for [filename]. 
ignoring. 

Description: Invalid weather file. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error parsing wx file [filename]: [error message]. (line [number], col [number]) 
Description: Weather file contains improperly formed XML. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error reading bds (tried to read [decimal] ([hex]) bytes, read [decimal] bytes). 
Description: An attempt to read a specific number of bytes returned a different number of bytes. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error reading bms. 
Description: Gridded binary weather data has invalid bitmap section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error reading es. 
Description: Gridded binary weather data has invalid end section. 
Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
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WX data. 
    
Message: Error reading gds. 
Description: Gridded binary weather data has invalid grid description section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error reading is: GRIB identifier invalid. 
Description: Gridded binary weather data has invalid format. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Error reading pds. 
Description: Gridded binary weather data has invalid product description section. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: getGridParameters found only [number] blocks. aborting. 
Description: Weather product does not contain the expected number of blocks of data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: getGridParameters requires product(36,37,38, or 81), found [value] 
Description: An attempt was made to access an unknown weather product. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: getGridParamters, error opening [filename]: [OS error description] 
Description: The specified file could not be opened. 
Resolution: Check user, directory, file-permissions. Consult OS documentation. 
    
Message: Layer [nexrad layer] error. 
Description: Nexrad weather data has invalid layer format. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: load, error opening [filename]: [OS error description] 
Description: The specified file could not be opened to read precipitation data. 
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Resolution: Check user, directory, file-permissions. Consult OS documentation. 
    
Message: NexContour only works on raster product(37) 
Description: Invalid Nexrad weather data product. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: No pd!! 
Description: Nexrad weather data contains no product description. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Prod desc error. 
Description: Nexrad weather data contains invalid product description. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: RUC file [filename] does not exist. 
Description: Config file points to a RUC weather file that does not exist. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: save, error opening [filename]: [OS error description] 
Description: The specified file could not be created/opened to write precipitation data. 
Resolution: Check disk capacity. Check user, directory, file-permissions. Consult OS documentation. 
    
Message: Unknown gridName [grid name] 
Description: An attempt was made to access an unknown grid of binary weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Wx file: nexrad line has no file attribute. Ignoring. 
Description: Invalid weather config file, nexrad weather will be ignored. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Wx file: precip line missing required attribute(s). Ignoring. 
Description: Invalid weather config file, precipitation weather will be ignored. 
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Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

    
Message: Wx file: ruc line has no file attribute. Ignoring. 
Description: Config data does not specify location of RUC weather data. 

Resolution: Saved data contains incomplete, invalid, or corrupt data; overwrite, restore or create new 
WX data. 

12.22. WX Save Errors 
Message: Error opening [filename]: [OS error description] 
Description: An error occurred attempting to write weather data to the specified file. 
Resolution: Check disk capacity, and user and directory permissions. Consult OS documentation. 
    
Message: Error Saving display [viewer name]: Error opening [weather file] 
Description: The specified weather file cannot be written to. 
Resolution: Check disk capacity, and user and directory permissions. Consult OS documentation. 

12.23. General Errors 
Message: ADAPTATION_PATH environment variable not set 

Description: The ADAPTATION_PATH environment variables specifies the location of available 
adaptation collections. 

Resolution: Ensure application installation and setup has been completed properly. 
    
Message: Application corruption. 
Description: Application corruption detected - GSGT will not be launched. 
Resolution: Re-install application. Obtain new source media if problem persists. 
    
Message: GSGT environment variable not set 

Description: The GSGT variable specifies the location/version of GSGT to be executed and must be set 
prior to running a GSGT session. 

Resolution: Ensure application installation and setup has been completed properly. 
    
Message: GSGT has not been installed properly. Check your GSGTDIR environment variable. 
Description: Installation error. 
Resolution: Re-install application. 
    
Message: Ignoring extraneous filename 
Description: (Warning) GSGT was launched with a parameter (assumed to be a filename) that will be 
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ignored. 
Resolution: n/a 
    
Message: License error : [reason] 
Description: A problem occurred attempting to verify license. 
Resolution: Re-install or contact support for valid license. 
    
Message: Sorry, the DISPLAY environment variable is not set. 
Description: DISPLAY must be exported prior to launching GSGT. 
Resolution: Export DISPLAY variable to desired display. 
    
Message: The GSGT license file can no longer be accessed. All license features have been disabled. 
Description: Licensing or installation error. 
Resolution: Re-install or contact support for valid license. 
    
Message: Unable to load /usr/local/lib/libkdexecutor.so.1.0.0 Record Mode not available 
Description: Informational only, not a required module. 
Resolution: n/a 
    
Message: Unable to load KDExecutor symbols Record Mode not available 
Description: Informational only, not a required module. 
Resolution: n/a 
    
Message: Warning : Ignoring extraneous filename. 

Description: (Warning) GSGT was launched with a parameter (assumed to be a filename) that will be 
ignored. 

Resolution: n/a 

12.24. Display / Drawing Errors 
Message: ATCoachMap> error opening [filename]: [OS error description] 
Description: An error occurred attempting to open the specified map file. 
Resolution: Installation product may be missing or inaccessible. Check file permissions. Re-install. 
    
Message: BinMap> error opening [filename]: [OS error description] 
Description: An error occurred attempting to open the specified map file. 

Resolution: Adaptation product may be missing or inaccessible. Check file permissions. Re-install or 
obtain valid adaptation data. 
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Message: DBMap> error opening [filename]: [OS error description] 
Description: An error occurred attempting to open the specified map file. 

Resolution: Adaptation product may be missing or inaccessible. Check file permissions. Re-install or 
obtain valid adaptation data. 

    
Message: Error: dashed_value == [number] 
Description: Adaptation map data is invalid. 
Resolution: Re-install or obtain valid adaptation data. 
    
Message: Noaamap> error opening [filename]: [OS error description] 
Description: An error occurred attempting to open the specified map file. 

Resolution: Adaptation product may be missing or inaccessible. Check file permissions. Re-install or 
obtain valid adaptation data. 

    
Message: SHPFile> error opening [filename]: [OS error description] 
Description: An error occurred attempting to open the specified map file. 

Resolution: Adaptation product may be missing or inaccessible. Check file permissions. Re-install or 
obtain valid adaptation data. 

    
Message: Unknown Map type: [value] 
Description: Unknown map types cannot be displayed. 

Resolution: Installation product may be corrupt, missing or inaccessible. Re-install, contact support if 
problem persists. 

12.25. Help Errors 
Message: Could Not Start Help Window 
Description: Help runs as a separate application which the system is unable to launch. 
Resolution: Check system health. Reboot. Verify or re-accomplish application installation.  

12.26. CREATE ROUTE Errors 
Message: [adaptation]:[route post] is not an arrival arpt for STAR [adaptation]:[STAR] 
Description: self-explanatory 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: [fix name] is not a departure arpt for pdar [name] 
Description: self-explanatory 
Resolution: Modify route. 
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Message: [fix name] is not a departure arpt for sid [name] 
Description: self-explanatory 
Resolution: Modify route. 
    
Message: [fix name] is not a transition fix for star [name] 
Description: self-explanatory 
Resolution: Modify route. 
    
Message: [fix name] is not a transition fix on pdr [name] 
Description: self-explanatory 
Resolution: Modify route. 
    
Message: [route type] [route name] does not intersect [route type] [route name] 

Description: Named routings must intersect if they are specified consecutively in a route with no 
intervening fixes or airways. 

Resolution: Modify route. 
    
Message: Arpt [adaptation]:[route post] is not an arrival airport for PDAR [adaptation]:[PDAR] 
Description: self-explanatory 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: At least 2 fixes must be known in originating adaptation on a direct route. 
Description: A valid route must contain at least two fixes known in the adaptation. 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: Attempt to add departure route ([route type] [route name]) to non-departure fix 
Description: self-explanatory 
Resolution: Modify route. 
    
Message: Can't add identical [route type] [route name] 
Description: A route may not contain the same 'named' routing more than once. 
Resolution: Modify route. 
    
Message: Dangling away 
Description: A valid route cannot end with an airway. 
Resolution: Modify route. 
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Message: Direction fix [adaptation]:[route post] not on away [adaptation]:[airway] 
Description: The specified fix is not on the specified airway. 
Resolution: Modify route. 
    
Message: Empty airroute. 
Description: An empty route is not valid. 
Resolution: Modify route. 
    
Message: Empty route text. 
Description: Route must contain at least two known fixes. 
Resolution: Modify route. 
    
Message: Fix [adaptation]:[route post] does not lie on coded route [adaptation]:[coded route] 
Description: Fixes bracketing a coded route must be on the coded route. 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: Fix [adaptation]:[route post] doesn't lie on away [adaptation]:[airway] 
Description: self-explanatory 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: Fix [adaptation]:[route post] is not a transition fix for SID [adaptation]:[SID] 
Description: self-explanatory 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: Fix [name] not on away [name] 
Description: Any use of an airway in a route must be followed by a fix on the airway. 
Resolution: Modify route. 
    
Message: Fix [name] not on coded route [name] 
Description: Any use of a 'named' routing must be followed by a fix on the 'named' routing. 
Resolution: Modify route. 
    

Message: Fixes [adaptation]:[route post] and [adaptation]:[route post] junction at same point on 
[adaptation]:[airway] 

Description: A route may not contain two consecutive items at the same location. 
Resolution: Modify route - ensure correct adaptation is being used. 
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Message: Fixes [route post] and [route post] lie on different segments of [airway] 

Description: A route with 'fix.airway.fix' is invalid if both fixes are not on the same contiguous airway 
segment. 

Resolution: Modify route. 
    
Message: Invalid route format -- fix must be first 
Description: A valid route cannot begin with an airway or radial. 
Resolution: Modify route. 
    
Message: No fixes found 
Description: A valid route must contain at least two fixes. 
Resolution: Modify route. 
    
Message: Short route: only 1 fix 
Description: A valid route must contain at least two fixes. 
Resolution: Modify route. 
    
Message: Unknown airroute [name] 
Description: The specified 'named' routing is not known in the adaptation. 
Resolution: Modify route - ensure correct adaptation is being used. 
    
Message: Unknown fix [fix name] 
Description: The specified fix was not found in adaptation. 
Resolution: Modify route - ensure correct adaptation is being used. 
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13. Data Dictionary 
 

GUI Format Chapter # Section 
Acceleration L 8 GSGT AChar Attributes Editor 

AChar D 7 GSGT Target Attributes Editor 

Adaptation D 6 GSGT System Command Editor 

Adaptation D 7 FP Message Editor, Generic 
Message Editor 

Adaptation D 16 GSGT Active/Inactive Report, 
GSGT FAV Listing, GSGT Track 
Count Report 

Add Time E 17 Weather Scenario Times 

Address L 11 Pilot Prompts Editor 

AID L 7 FP Message Editor 

Aircraft Model Dir L 14 SIME Control File - Main 

Aircraft Route L 7 FP Message Editor 

Aircraft Speed L 7 FP Message Editor 

Aircraft type D 7 FP Message Editor 

Apply pref routing C 7 Target Route Editor 

Arrival C 7 Target Route Editor 

Auto-derive msgs C 7 Target Message Editor 

Base - Altitude E 9 Non-Radar Area Dialog 

Bcn L 7 GSGT Target Attributes Editor 

Beacon L 7 FP Message Editor 

Ceiling - Altitude E 9 Non-Radar Area Dialog 

Channel D 6 GSGT System Command Editor 

Channel D 7 Generic Message Editor 

Channel D 14 SIME Opsim Configuration 
Dialog 

Command L 7 Target Events Dialog 

Command F 11 Pilot Prompts Editor 

Comments F 6 GSGT System Command Editor 
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GUI Format Chapter # Section 
Comments F 7 GSGT Target Attributes Editor, 

Generic Message Editor, Target 
Events Dialog 

Comments F 9 Static Radar Message Dialog 

Controller Symbol L 7 Target Pilot Info Editor 

Coordination Fix L 7 FP Message Editor 

Coordination Time D/L 7 FP Message Editor 

Deceleration L 8 GSGT AChar Attributes Editor 

Delay Overflowed 
Radar Messages 
 

C 14 NAS SIM Export Function 

Delta AID E 7 GSGT Target Attributes Editor 

Delta beacon E 7 GSGT Target Attributes Editor 

Delta time E 7 GSGT Target Attributes Editor 

Departure C 7 Target Route Editor 

Description F 5 RSIs 

Device D 6 GSGT System Command Editor 

Device D 7 FP Message Editor, Generic 
Message Editor 

Do Fav Counts C 16 GSGT FAV Listing 

Do Sector Counts C 16 GSGT FAV Listing 

Emulate ECG C 14 SIME Control File - Facilities 

End - Azimuth L 9 Non-Radar Area Dialog 

End - Range E 9 Non-Radar Area Dialog 

Entire Scenario C 16 GSGT Ghost Pilot Script Report 

Equip Qualifier D 7 FP Message Editor 

Event Type D 7 Target Events Dialog 

Event Type D 9 Radar Events Dialog 

Exercise E 14 SIME Control File - Main 

Expected Results F 6 GSGT System Command Editor 

Expected results F 7 Generic Message Editor 
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GUI Format Chapter # Section 
File name L 13 NAS SIM Import Function, 

DYSIM Import Function, NAS 
SAR Import Function, ERAM 
SAR Import Function, RTF 
Import Function, TGF Import 
Function 

File name L 16 GSGT SAR Plot (HCS version 
only) 

File Type D 13 NAS SIM Import Function, 
DYSIM Import Function, NAS 
SAR Import Function, ERAM 
SAR Import Function, RTF 
Import Function, TGF Import 
Function 

File type D 16 GSGT SAR Plot (HCS version 
only) 

Filter Name L 16 Filter Options 

Filters D 16 GSGT Flight Log Report, Filter 
Options 

Find What F 16 Find Text Dialog 

Flevel L 7 GSGT Target Attributes Editor, 
Target Route Editor 

FP Lead Time E 5 Preferences 

Freeze Replications C 7 GSGT Target Attributes Editor 

Generate Non-Radar 
Tape 
 

C 14 SDRR Export Functions 

Generate 
Parrots/RTQCs 
 

C 14 SDRR Export Functions 

Goal L 16 GSGT Target Count Report (HCS 
version only) 

Heading L 7 Target Route Editor 

HO Accept Delta E 5 Preferences 

Injection mode D 6 GSGT System Command Editor 

Injection mode D 7 Generic Message Editor 

Injection Time E 7 FP Message Editor 

Inter. Msg. Time L 10 Equipment Editor, DSR Attributes 
Editor 

Intercenter L 7 FP Message Editor 



SGET User Guide: Volume 2  March 13, 2015 
Final Revision Version 7.5.10.0  Page 322   

GUI Format Chapter # Section 
Interval E 16 GSGT Active/Inactive Report, 

GSGT FAV Listing, GSGT Load 
Duration Report, GSGT Message 
Count Report, GSGT Target 
Analysis Report, GSGT Track 
Count Report 

Intracenter L 7 FP Message Editor 

Join Fix D 7 Target Route Editor 

Latitude E 7 Target Route Editor 

Length E 16 GSGT Target Analysis Report 

List by Equipment C 16 GSGT Message Count Report 

List Messages C 16 GSGT Message Count Report 

Literal mode C 6 GSGT System Command Editor 

Literal mode C 7 Generic Message Editor 

Live C 10 DSR Sector Position Editor 

Load L 16 GSGT Load Duration Report 

Longitude E 7 Target Route Editor 

Look in D 13 NAS SIM Import Function, 
DYSIM Import Function, NAS 
SAR Import Function, ERAM 
SAR Import Function, RTF 
Import Function, TGF Import 
Function 

Look in L 16 GSGT SAR Plot (HCS version 
only) 

Magnetic Deviation E/C 9 GSGT Radar Editor 

Max Alt. E 8 GSGT AChar Attributes Editor 

Max Climb Factor L 8 GSGT AChar Attributes Editor 

Max Descent Factor  L 8 GSGT AChar Attributes Editor 

Max Turn Factor L 8 GSGT AChar Attributes Editor 

Max Turn Factor L 8 Descent Profile Dialog 

Max. Msg. Length L 10 Equipment Editor, DSR Attributes 
Editor 

Min Sector Control 
Time (secs) 
 

L 5 Preferences 
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Mode D 14 SIME Opsim Configuration 

Dialog 
Model L 8 GSGT AChar Attributes Editor 

Name L 7 GSGT Target Attributes Editor 

Need confirm C 7 Generic Message Editor 

Needs confirm C 6 GSGT System Command Editor 

Ops Mode C 14 SIME Control File - Facilities 

Opsim D 14 SIME Opsim Configuration 
Dialog 

Options C/E 16 GSGT Printer Dialog 

Output Path C/L 14 SDRR Export Functions 

Paper format C 16 GSGT Printer Dialog 

Position C/D 7 Target Events Dialog 

Postabmle L 10 NOTAM Equipment Editor 

Preabmle L 10 NOTAM Equipment Editor 

Precipitation L 17 Precipitation Editor 

Pressure L 17 Pressure Editor 

Pressure Alt. E 8 Climb Profile Dialog, Descent 
Profile Dialog, Max Speed Profile 
Dialog, Min Speed Profile Dialog 

Primary - Radar 
Antenna 
 

C 9 Radar Events Dialog 

Print destination C/L 16 GSGT Printer Dialog 

Printer Settings C 16 GSGT Printer Dialog 

Process Inactive 
Aircraft 
 

C 16 GSGT Load Duration Report 

Pseudo Pilot D 7 Target Pilot Info Editor 

QN Lead Time E 5 Preferences 

Radar State D 9 Radar Events Dialog 

Radar Type 
Excluded 
 

D 9 Non-Radar Area Dialog 

Range E 10 DSR Settings Dialog (HCS 
version only) 
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Rate  L 8 Climb Profile Dialog, Descent 

Profile Dialog, Turn Rate Profile 
Dialog 

Replications E 7 GSGT Target Attributes Editor 

Route L 7 Target Route Editor 

RSI Specifications D 14 SIME Control File - Main 

RSI Tags D 6 GSGT System Command Editor 

RSI Tags D 7 GSGT Target Attributes Editor, 
Generic Message Editor 

RSI Tags D 9 Static Radar Message Dialog 

RSI Tags D 11 Pilot Prompts Editor, 
Preprogrammed Events Editor 

Run Time E 5 Preferences 

Run Time E 16 GSGT Active/Inactive Report, 
GSGT FAV Listing, GSGT 
Message Count Report, GSGT 
Track Count Report 

Sample Interval E 16 GSGT Target Count Report (HCS 
version only) 

Scenario Name L 3 General New Scenario Wizard 
Buttons 

Scenario Name L 14 SIME Control File - Main 

SDRR Sim Name L 14 SDRR Export Functions 

Secondary - Radar 
Antenna 
 

C 9 Radar Events Dialog 

Show only LIV 
entry messages 
 

C 16 GSGT Flight Log Report, Filter 
Options 

Show This Message 
Again 
 

C 7 Target Conflict Message 

Simulation Driver L 14 SIME Control File - Main 

Site Definition F 11 Site Definitions Editor 

Site File L 14 SIME Control File - Main 

Special indicator D 7 FP Message Editor 

Speed L 7 GSGT Target Attributes Editor, 
Target Route Editor 
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Speed L 8 Turn Rate Profile Dialog, Max 

Speed Profile Dialog, Min Speed 
Profile Dialog 

Speed + Heading C 17 Wind Editor 

Start E 14 SIME Control File - Main 

Start - Azimuth L 9 Non-Radar Area Dialog 

Start - Range E 9 Non-Radar Area Dialog 

Start Time E 5 Preferences 

Start Time E 9 Time Interval Dialog 

Start Time E 16 GSGT Active/Inactive Report, 
GSGT FAV Listing, GSGT 
Message Count Report, GSGT 
Track Count Report 

Starttime E 7 GSGT Target Attributes Editor 

Starttime E 12 Preview Starttime Dialog (HCS 
version only) 

Stop Time C/E 9 Time Interval Dialog 

Strata D 17 Wind Editor, Temperature Editor 

System setup msg C 6 GSGT System Command Editor 

System setup msg C 7 Generic Message Editor 

System Setup Time E 5 Preferences 

Tape Label L 14 NAS SIM Export Function 

Tape Output Device L 14 NAS SIM Export Function 

Tape Type C 14 NAS SIM Export Function 

Tas L 8 Climb Profile Dialog 

Temperature E 8 Climb Profile Dialog, Descent 
Profile Dialog 

Temperature L 17 Temperature Editor 

Text F 6 GSGT System Command Editor 

Text F 7 Generic Message Editor 

Text F 11 Pilot Prompts Editor, 
Preprogrammed Events Editor 

Text F 16 GSGT Flight Log Report, Filter 
Options 
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Tgt. Minimum Inter 
Msg Time 
 

E 5 Preferences 

TI Lead Time E 5 Preferences 

Time E 6 GSGT System Command Editor 

Time E 7 Generic Message Editor 

Time C/E 7 Target Events Dialog 

Time E 9 Radar Events Dialog 

Time E 10 DSR Settings Dialog (HCS 
version only) 

Time E 11 Pilot Prompts Editor, 
Preprogrammed Events Editor 

Time Span E 16 GSGT Flight Log Report, Filter 
Options 

Track Start Offset E 5 Preferences 

True North C 17 Wind Editor 

U Value L 17 Wind Editor 

Use Initial Position C 7 Target Route Editor 

Use internal start 
track mode 
 

C 5 Preferences 

Use relative 
coordination time 
format 
 

C 5 Preferences 

V Value L 17 Wind Editor 

Value E 5 RSIs 

Word 0 - Value L 9 Static Radar Message Dialog 

Word 1 - Value L 9 Static Radar Message Dialog 

Word 2 - Value L 9 Static Radar Message Dialog 

Word 3 - Value L 9 Static Radar Message Dialog 

Word 4 - Value L 9 Static Radar Message Dialog 

Word 5 - Value L 9 Static Radar Message Dialog 

Word 6 - Value L 9 Static Radar Message Dialog 

X L 10 DSR Settings Dialog (HCS 
version only) 
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Y L 10 DSR Settings Dialog (HCS 

version only) 
    

    

    

Format Symbol Description of Format 
Free Format Text 
Area F Can insert anything - no limitations 

Expected Input E 
Designated place holders for expected input - 
up/down arrows available for assistance 

Few Limitations L Limitations present but no designated place holders  

List Selection D Drop down list of available choices for selection 
Check-Box 
Selection C Check-box available for selection(s) 

 
 
 
 
 


